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Cisco is bringing a new standard to desk phones with a portfolio built for working in modern office environments.
The Desk Phone 9800 Series was designed with IT and facilities in mind to deliver 4 new phone models. Included
on each phone is the newly released PhoneOS software that simplifies the user experience and compliments our
video portfolios RoomOS devices to give a seamless experience from desk spaces to meeting rooms. With
expanded functionality — the 9800 Series combines secure enterprise calling, meetings, desk reservations,
sustainability, emergency alerts and calling all in one device. You don’t need to buy a dedicated device for each
feature — all the features are built into each phone.

The Desk Phone 9800 Series reduces the complexity of purchasing, deploying, managing, and training. To further
simplify, you can use one device for Cisco Unified Communications Manager (CUCM), Webex Calling,
Broadworks, or other 3rd party cloud calling platforms. Alongside our extensive portfolio of desk devices, the 9800
series is uniquely positioned in the market to help transform the workplace by bridging the gap between hybrid
work, calling, and meetings — and is the most cost-effective solution for workstations at scale.

This guide provides information and guidance to help the network administrator deploy the 9800 Series into a
wireless LAN environment.
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Cisco Desk Phone 9800 Series Overview

Cisco’s implementation of 802.11 permits time sensitive applications such as call and voice to operate efficiently across
campus wide over wireless LAN (WLAN) deployments. These extensions provide fast roaming capabilities and almost
seamless flow of multimedia traffic, whilst maintaining security as the end user roams between access points.

WLAN uses unlicensed spectrum, and as a result it may experience interference from other devices using the unlicensed
spectrum. The proliferation of devices in the 2.4 GHz spectrum, such as Bluetooth headsets, Microwave ovens, cordless
consumer phones, means that the 2.4 GHz spectrum may contain more congestion than other spectrums. The 5 GHz spectrum
has far fewer devices operating in this spectrum and is the preferred spectrum to operate the Cisco Desk Phone 9800 Series to
take advantage of the 802.11a/n data rates available.

Despite the optimizations that Cisco has implemented in the Cisco Desk Phone Series, the use of unlicensed spectrum means
that uninterrupted communication cannot be guaranteed, and there may be the possibility of voice gaps of up to several
seconds during conversations. Adherence to these deployment guidelines will reduce the likelihood of these voice gaps being
present, but there is always this possibility.

Using unlicensed spectrum, and the inability to guarantee the delivery of messages to a WLAN device, the Cisco Desk Phone
9800 Series is not intended to be used as a medical device and should not be used to make clinical decisions.

Models

The following table shows available Espresso models with WLAN capability.

Below outlines the peak antenna gain and frequency ranges/channels supported by each model.

Part Number Description Peak Antenna Gain Frequency Ranges | Available Channel Set
Channels

DP-9871-K9= Cisco Desk 2.400-2.483GHz: 3.22 dBi 2.412-2.472 GHz 13 1-13

DP-9871-L-K9= Phone 9871 .

DP-9871-K9++= 5.150-5.250GHz: 3.60 dBi 5.180 - 5.240 GHz 4 36,40,44,48

DP-9871-K9--= 5.250-5.350GHz: 3.62 dBi 5.260 - 5.320 GHz 4 52,56,60,64
5.470-5.725GHz: 4.23 dBi 5.500 - 5.700 GHz 11 100-144
5.725-5.850GHz: 4.13 dBi 5.745 - 5.825 GHz 5 149,153,157,161,165

DP-9861-K9= Cisco Desk 2.400-2.483GHz: 3.06 dBi 2.412-2.472 GHz 13 1-13

DP-9861-L-K9= Phone 9861 .

DP-9861-K9++= 5.150-5.250GHz: 3.98 dBi 5.180 - 5.240 GHz 4 36,40,44,48

DP-9861-K9--= 5.250-5.350GHz: 4.07 dBi 5.260 - 5.320 GHz 4 52,56,60,64
5.470-5.725GHz: 4.11 dBi 5.500 - 5.700 GHz 11 100-144
5.725-5.850GHz: 3.76 dBi 5.745 - 5.825 GHz 5 149,153,157,161,165

Requirements

The Cisco Desk Phone 9800 Series units are IEEE 802.11a/b/g/n/ac collaboration device that provide voice and data
communications. The wireless LAN must be validated to ensure it meets the requirements to deploy the Cisco Desk Phone
Series.

Site Requirement

Before deploying the Cisco Desk Phone 9800 Series into a production environment, a site survey must be completed by a
Cisco certified partner with the advanced wireless LAN specialization. During the site survey, the RF spectrum can be
analyzed to determine which channels are unable in the desired band (SGHz or 2.4GHz). Typically, there is less interference
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in the SGHz band as well as more non-overlapping channels, so 5GHz is the preferred band for operation and even more

highly recommended when the Cisco Desk Phone 9800 Series units are to be used in a mission critical environment. The site

survey will include heatmaps showing the intended coverage plan for the location. The site survey will also determine which
access point platform type, antenna type, access point configuration (channel and transmit power) to use at the location. It is

recommended to select an access point with integrated antennas for non-rugged environments (e.g. office, healthcare,

education, hospitality) and an access point platform requiring external antennas for rugged environments (e.g. manufacturing,

warehouse, retail).

The wireless LAN must be validated to ensure it meets the requirements to deploy the Cisco Desk Phone 9800 Series.

Signal

The cell edge should be designed to -67 dBm where there is a 20-30% overlap of adjacent access point at that signal
level.

This ensures that the Cisco Desk Phone 9800 Series always has adequate signal and can hold a signal long enough to
roam seamlessly where signal-based triggers are utilized vs. packet loss triggers.

Also need to ensure that the upstream signal from the Espresso meets the access point's receiver sensitivity for the
transmitted data rate. Rule of thumb is to ensure that the received signal at the access point is -67 dBm or higher.

It is recommended to design the cell size to ensure that the Espresso can hold a signal for at least 5s.

Channel Utilization

Channel Utilization levels should be kept under 40%.
Noise

Noise levels should not exceed -92 dBm, which allows for a Signal to Noise Ratio (SNR) of 25 dB where a -67 dBm
signal should be maintained.

Also need to ensure that the upstream signal from the Cisco Desk Phone 9800 Series meets the access point’s signal to
noise ratio for the transmitted data rate.

Packet Loss / Delay

Per voice guidelines, packet loss should not exceed 1% packet loss. Otherwise, voice quality can be degraded
significantly.

Jitter should be kept at a minimal (< 100 ms).
Retries
802.11 retransmissions should be less than 20%.

Multipath

Multipath should be kept to a minimal as this can create nulls and reduce signal levels.

Call Control

The Cisco Desk Phone 9800 Series is supported on the following call control platforms.

Cisco Webex Calling

Cisco Unified Communications Manager (CUCM) (12.5 or above)
Webex Dedicated Instance (DI)

Cisco BroadWorks

Note: Cisco Unified Communications Manager requires a device package to be installed or service release update in order

to enable Cisco Desk Phone 9800 Series device support.

Device packages for Cisco Desk Phone 9800 Series are available at the following location.
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https://software.cisco.com/download/home/286322286/type/282074299/release/12.5(1.19210)
https://software.cisco.com/download/home/286328117/type/282074299/release/14.0(1.14056)
https://software.cisco.com/download/home/286331940/type/282074299/release/15.0(1.12004)

Wireless LAN

The Cisco Desk Phone 9800 Series is supported on the following Cisco Wireless LAN solutions.

e Cisco AireOS Wireless LAN Controller and Cisco Lightweight Access Points
o Minimum = 8.10.185.0
o Recommended = 8.10.190.0, 8.10.196.0
e Cisco IOS Wireless LAN Controller and Cisco Lightweight Access Points
o Minimum =17.3.5
o Recommended =17.9.5, 17.6.6, 17.12.1
e Cisco Mobility Express and Cisco Lightweight Access Points
o Minimum = 8.10.105.0
o Recommended = 8.10.105.0, 8.10.130.0, 8.10.142.0, 8.10.196.0
e Cisco Autonomous Access Points
o Minimum = 15.3(3)JPK2
o Recommended = 15.3(3)JPK2, 15.3(3)JPK3, 15.3(3)JPK4, 15.3(3)JPK6
e Cisco Meraki Access Points
o Minimum = MR 27.X, MX 13.33
o Recommended = MR 30.6, MX 18.211.2

Access Points
See the following table for the Cisco access points that are supported.

Controller AP Models

Model

AireOS 1700, 1810, 1810w, 1815, 1830, 1840, 1850, 2700, 2800, 3700, 3800, 4800, 9105, 9115, 9117, 9120,
9130

10S XE 1700, 1810, 1810w, 1815, 1830, 1840, 1850, 2700, 2800, 3700, 3800, 4800, 9105, 9115, 9117, 9120,
9130, 9136, 9162, 9164, 9166

Mobility 1815 (not 1815t), 1830, 1840, 1850, 2800, 3800, 4800

Express

Autonomous 1700, 2700, 3700

Meraki 9162, 9164, 9166, MR20, MR28, MR30H, MR32, MR33, MR34, MR36, MR36H, MR42, MR44, MR45,
MR46, MR52, MR53, MR55, MR56, MR57, MX64W, MX65W, MX67W, MX68W, Z3
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Antenna System

Some Cisco access points require or allow external antennas.

Please refer to the following URL for the list of supported antennas for Cisco Aironet access points and how the external
antennas should be mounted.

https://www.cisco.com/c/en/us/products/collateral/wireless/aironet-antennasaccessories/

product_data_sheet09186a008008883b.htmi

Note: Cisco access points with integrated internal antennas (other than models intended to be wall mounted) are to be mounted

on the ceiling as they have omni-directional antennas and are not designed to be wall mounted.

Protocols

Supported wireless LAN protocols include the following:

e 802.11a,b,d,e,g,h,i,n,ac
e Wi-Fi MultiMedia (WMM)
e Session Initiation Protocol (SIP)

e Real Time Protocol (RTP)

e Opus, G.722,G.711, G.722.1, G.729

e Dynamic Host Configuration Protocol (DHCP)

e Trivial File Transfer Protocol (TFTP)

e HyperText Transfer Protocol (HTTP)

Wi-Fi

Cisco Desk Phone 9800 Series can work with 2.4GHz (HT20) or SGHz (HT20/HT40/VHT20/VHT40/VHT80) mode. To
achieve 802.11n/ac connectivity, it is recommended that the Cisco Desk Phone 9800 Series be within 30 feet of the access

point.

5 GHz Specifications

5 GHz - 802.11a Data Rate Spatial Streams Modulation
Max Tx Power=18 dBm 6 Mbps 1 OFDM-BPSK
(Depends on region) 9 Mbps 1 OFDM-BPSK
12 Mbps 1 OFDM-QPSK
18 Mbps 1 OFDM-QPSK
24 Mbps 1 OFDM-16QAM
36 Mbps 1 OFDM-16QAM
48 Mbps 1 OFDM-64QAM
54 Mbps 1 OFDM-64QAM
5 GHz-802.11n (HT20) Date Rate Spatial Streams Modulation
Max Tx Power=18 dBm 7 Mbps (MCS 0) 1 OFDM-BPSK
(Depends on region) 14 Mbps (MCS 1) 1 OFDM-QPSK
21 Mbps (MCS 2) 1 OFDM-QPSK
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29 Mbps (MCS 3)
43 Mbps (MCS 4)
58 Mbps (MCS 5)
65 Mbps (MCS 6)
72 Mbps (MCS 7)

OFDM-16QAM
OFDM-16QAM
OFDM-64QAM
OFDM-64QAM
OFDM-64QAM

5 GHz-802.11n (HT40)

Date Rate

Spatial Streams

Modulation

Max Tx Power=17 dBm

(Depends on region)

15 Mbps (MCS 0)
30 Mbps (MCS 1)
45 Mbps (MCS 2)
60 Mbps (MCS 3)
90 Mbps (MCS 4)

120 Mbps (MCS 5)
135 Mbps (MCS 6)
150 Mbps (MCS 7)

1
1
1

OFDM-BPSK
OFDM-QPSK

OFDM-QPSK

OFDM-16QAM
OFDM-16QAM
OFDM-64QAM
OFDM-64QAM
OFDM-64QAM

5 GHz-802.11ac (VHT20)

Date Rate

Spatial Streams

Modulation

Max Tx Power=18 dBm

(Depends on region)

7 Mbps (MCS 0)

14 Mbps (MCS 1)
21 Mbps (MCS 2)
29 Mbps (MCS 3)
43 Mbps (MCS 4)
58 Mbps (MCS 5)
65 Mbps (MCS 6)
72 Mbps (MCS 7)
87 Mbps (MCS 8)

1
1
1

OFDM-BPSK
OFDM-QPSK
OFDM-QPSK
OFDM-16QAM
OFDM-16QAM
OFDM-64QAM
OFDM-64QAM
OFDM-64QAM
OFDM-256QAM

5 GHz-802.11ac (VHT40) Date Rate Spatial Streams Modulation

Max Tx Power=17 dBm 15 Mbps (MCS 0) 1 OFDM-BPSK

(Depends on region) 30 Mbps (MCS 1) 1 OFDM-QPSK
45 Mbps (MCS 2) 1 OFDM-QPSK
60 Mbps (MCS 3) 1 OFDM-16QAM
90 Mbps (MCS 4) 1 OFDM-16QAM
120 Mbps (MCS 5) 1 OFDM-64QAM
135 Mbps (MCS 6) 1 OFDM-64QAM
150 Mbps (MCS 7) 1 OFDM-64QAM

180 Mbps (MCS 8)
200 Mbps (MCS 9)

OFDM-256QAM
OFDM-256QAM

5 GHz-802.11ac (VHTS80)

Date Rate

Spatial Streams

Modulation

Max Tx Power=15 dBm

33 Mbps (MCS 0)

1

OFDM-BPSK

Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide




(Depends on region)

65 Mbps (MCS 1)

98 Mbps (MCS 2)

130 Mbps (MCS 3)
195 Mbps (MCS 4)
260 Mbps (MCS 5)
293 Mbps (MCS 6)
325 Mbps (MCS 7)
390 Mbps (MCS 8)
433 Mbps (MCS 9)

OFDM-QPSK
OFDM-QPSK
OFDM-16QAM
OFDM-16QAM
OFDM-64QAM
OFDM-64QAM
OFDM-64QAM
OFDM-256QAM
OFDM-256QAM

2.4 GHz Specifications

2.4 GHz - 802.11b Data Rate Spatial Streams Modulation
Max Tx Power=18 dBm 1 Mbps 1 DSSS-BPSK
(Depends on region) 2 Mbps 1 DSSS-QPSK
5.5 Mbps 1 DSSS-CCK
11 Mbps 1 DSSS-CCK
2.4 GHz - 802.11¢g Data Rate Spatial Streams Modulation
Max Tx Power=18 dBm 6 Mbps 1 OFDM-BPSK
(Depends on region) 9 Mbps 1 OFDM-BPSK
12 Mbps 1 OFDM-QPSK
18 Mbps 1 OFDM-QPSK
24 Mbps 1 OFDM-16QAM
36 Mbps 1 OFDM-16QAM
48 Mbps 1 OFDM-64QAM
54 Mbps 1 OFDM-64QAM
2.4 GHz - 802.11n (HT20) Data Rate Spatial Streams Modulation
Max Tx Power=16 dBm 7 Mbps 1 OFDM-BPSK
(Depends on region) 14 Mbps 1 OFDM-BPSK
21 Mbps 1 OFDM-QPSK
29 Mbps 1 OFDM-QPSK
43 Mbps 1 OFDM-16QAM
58 Mbps 1 OFDM-16QAM
65 Mbps 1 OFDM-64QAM
72 Mbps 1 OFDM-64QAM

Note: Tx power includes antenna gain.
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Regulatory

World Mode (802.11d) allows a client to be used in different regions, where the client can adapt to using the channels and
transmit powers advertised by the access point in the local environment.

The Cisco Desk Phone 9800 Series operates best with an access point that has 802.11d enabled, where it can determine the
channels and transmit powers to use per the local region.

Enable World Mode (802.11d) for the corresponding country where the access point is located.

Some 5 GHz channels are also used by radar technology, which requires that the 802.11 client and access point to be 802.11h
compliant to utilize those radar frequencies (DFS channels). 802.11h requires 802.11d to be enabled.

The Cisco Desk Phone 9800 Series will passively scan DFS channels first before engaging in active scans for those channels.

If 802.11d is not enabled, then the Cisco Desk Phone 9800 Series will attempt to connect to the access point using reduced
transmit power.

Cisco Desk Phone 9800 Series supports county codes which follow WFA definition.
Bluetooth®

The Cisco Desk Phone 9800 Series supports Bluetooth® technology allowing for wireless headset communications.
Bluetooth enables low bandwidth wireless connections within a range of 30 feet. However, it is recommended to keep the
Bluetooth device within 10 feet of the Cisco Desk Phone 9800 Series.

The Bluetooth device does not need to be within direct line-of-sight of the phone, but barriers such as walls, doors, etc. can
potentially impact the quality.

Bluetooth operates on the 2.4 GHz frequency, similar to 802.11b/g/n and various other devices (e.g., microwave ovens,
cordless phones, etc.). Therefore, Bluetooth quality may be affected by potential interference from other devices using this
unlicensed frequency.

Bluetooth Profiles

The Cisco Desk Phone 9800 Series supports the following Bluetooth profiles.
*  Advanced Audio Distribution Profile (A2DP)
* Audio/Video Remote Control Profile (AVRCP)
*  Generic Access Profile (GAP)
*  Generic Audio/Video Distribution Profile (GAVDP)
* Hands-Free Profile (HFP)

Coexistence (802.11b/g/n + Bluetooth)

If using Coexistence where 802.11b/g/n and Bluetooth are used simultaneously, it is important to consider the
following limitations and deployment requirements because they both utilize the 2.4 GHz frequency range.
Capacity
When using Coexistence (802.11b/g/n + Bluetooth), call capacity is reduced due to the utilization of CTS to
protect the 802.11g/n and Bluetooth transmissions.
Multicast Audio
Multicast audio from Push to Talk (PTT), Music on Hold (MMOH), and other applications are not supported
when using Coexistence.
Voice Quality
Depending on the current data rate configuration, CTS may be sent to protect the Bluetooth transmissions
when using Coexistence.
In some environments, 6 Mbps may need to be enabled.
Note: Tt is recommended to use 802.11a/n/ac when using Bluetooth, not only because both 802.11b/g/n and Bluetooth utilize
the 2.4 GHz frequency, but also due to the limitations mentioned above.
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Device Care

To clean the Cisco Desk Phone 9800 Series, use a soft, moist cloth to wipe the device.

Do not apply liquids or powders directly to the device as it can damage the device.

Do not use bleach or other caustic products to clean the device.

Do not use compressed air to clean the device as it can damage the device.

For more information, refer to the Cisco Desk Phone 9800 Series User Guide at https://cisco.com/go/dp9800help

Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide

14


https://cisco.com/go/dp9800help

Wireless LAN Design

The following network design guidelines must be followed to ensure adequate coverage, call capacity and seamless roaming
for the Cisco Desk Phone 9800 Series.

802.11 Network

Use the following guidelines to plan channel usage for these wireless environments.

5 GHz (802.11a/n/ac)

5 GHz is the recommended frequency band for operating the Cisco Desk Phone 9800 Series.

Generally, it is recommended for access points to use automatic channel selection instead of manually assigning channels.

If there is intermittent interference, it may be necessary to statically assign channels to the access point or access points
serving that area.

The Cisco Desk Phone 9800 Series supports Dynamic Frequency Selection (DFS) and Transmit Power Control (TPC) as per
802.11h, required for channels operating at 5.260 - 5.720 GHz, which encompass 16 out of the 25 possible channels.

To ensure seamless roaming in a 802.11a/n/ac environment, it’s crucial to have at least 20 percent overlap with adjacent
channels. For critical areas, increasing the overlap to 30% or more is recommended to to ensure that there can be at least 2
access points available with a signal of -67 dBm or higher. Additionally, the Cisco Desk Phone 9800 Series complies with the
access point’s receiver sensitivity (required signal level for the current data rate).

Dynamic Frequency Selection (DFS)

DFS dynamically instructs a transmitter to switch to another channel whenever radar signal is detected. If the access point
detects radar, the radio on the access point will pause for at least 60 seconds while the access point passively scans for another
usable channel.

TPC allows the client and access point to exchange information, so that the client can dynamically adjust the transmit power.
The client uses only enough energy to maintain association to the access point at a given data rate. As a result, the client
contributes less to adjacent cell interference, which allows for more densely deployed, high-performance wireless LANs.

If the access point detects repeated radar events, whether genuine or false alarms, it first determines if the radar signals are
affecting a single channel (narrowband) or multiple channels (wideband). Then the access point potentially disables the
affected channel or channels in the wireless LAN to mitigate interference.

Having an access point operating on a non-DFS channel can help minimize voice interruptions.

In case of radar activity, it’s recommended to have at least one access point per area that uses a non-DFS channel (UNII-1).
This ensures that a channel remains available when an access point’s radio is in its hold-off period while scanning for a new
usable channel.

A UNII-3 channel (5.745 - 5.825 GHz) can optionally be used if available.

For 5 GHz, 25 channels are available in the Americas, 16 channels in Europe, and 19 channels in Japan.

Where UNII-3 is available, it is recommended to use UNII-1, UNII-2, and UNII-3 only to utilize a 12-channel set.

If planning to use UNII-2 extended channels (channels 100 - 144), it is recommended to disable UNII-2 (channels 52-64) on
the access point to avoid having so many channels enabled.

Having many 5 GHz channels enabled in the wireless LAN can delay discovery of new access points.

Below is a sample 5 GHz wireless LAN deployment
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Minimum 20% Overlap

2.4 GHz (802.11b/g/n)

In general, it is recommended for access points to utilize automatic channel selection instead of manually assigning channels
to access points.

If there is an intermittent interferer, then the access point or access points serving that area may need to have a channel
statically assigned.

In a 2.4 GHz (802.11b/g/n) environment, only non-overlapping channels must be utilized when deploying VoOWLAN.
Nonoverlapping channels have 22 MHz of separation and are at least 5 channels apart.

There are only 3 non-overlapping channels in the 2.4 GHz frequency range (channels 1, 6, 11).

Non-overlapping channels must be used and allow at least 20 percent overlap with adjacent channels when deploying the
Cisco Desk Phone 9800 Series in an 802.11b/g/n environment, which allows for seamless roaming.

Using an overlapping channel set such as 1, 5, 9, 13 is not a supported configuration.

Below is a sample 2.4 GHz wireless LAN deployment.

Minimum 20% Overlap

Signal Strength and Coverage

To ensure acceptable voice quality, the Cisco Desk Phone 9800 Series should always have a signal of -67 dBm or higher when
using SGHz or 2.4 GHz, while the Cisco Desk Phone 9800 Series also meets the access point’s receiver sensitivity required
signal level for the transmitted data rate.

Ensure the Packet Error Rate (PER) is no higher than 1%.

A minimum Signal to Noise Ratio (SNR) of 25 dB =-92 dBm noise level with -67 dBm signal should be maintained.

It is recommended to have at least two access points on non-overlapping channels with at least -67 dBm signal with the 25 dB
SNR to provide redundancy.

To achieve maximum capacity and throughput, the wireless LAN should be designed to 24 Mbps. Higher data rates can
optionally be enabled for other applications other than voice only that can take advantage of these higher data rates.
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It’s recommended to set the minimum data rate to 11 Mbps or 12 Mbps for 2.4 GHz (dependent upon 802.11b client support
policy) and 12 Mbps for 5 GHz, which should also be the only rate configured as a mandatory/basic rate.

In some environments, 6 Mbps may need to be enabled as a mandatory/ basic rate.

Due to the above requirements, a single channel plan should not be deployed.

When designing the placement of access points, be sure that all key areas have adequate coverage (signal).

Typical wireless LAN deployments for data only applications do not provide coverage for some areas where VoWLAN
service is necessary such as elevators, stairways, and outside corridors.

Microwave ovens, 2.4 GHz cordless phones, Bluetooth devices, or other electronic equipment operating in the 2.4 GHz band
will interfere with the Wireless LAN.

Microwave ovens operate on 2450 MHz, which is between channels 8 and 9 of 802.11b/g/n. Some microwaves are more
heavily shielded than others, which reduces the spread of the energy. Microwave emissions can impact channel 11, while some
microwaves can affect the entire 2.4 GHz frequency range (channels 1 through 11). To avoid microwave interference, select
channel 1 when using access points that are located near microwaves.

Most microwave ovens, Bluetooth, and frequency hopping devices do not have the same effect on the 5 GHz frequency. The
802.11a/n/ac technology provides more non-overlapping channels and typically lower initial RF utilization. For voice
deployments, it is suggested to use 802.11a/n/ac for voice and use 802.11b/g/n for data.

However, there are products that also utilize the non-licensed 5 GHz frequency (e.g. 5.8 GHz cordless phones, which can
impact UNII-3 channels).

Data Rates

It is recommended to disable rates below 12 Mbps for 5 GHz deployments and below 12 Mbps for 2.4 GHz deployments
where capacity and range are factored in for best results.

The Cisco Desk Phone 9800 Series is 1x1 with single antenna, therefore they support up to MCS 7 data rates for 802.11n (up
to 72 Mbps). For 802.11ac, the Cisco Desk Phone 9800 Series supports up to VHT80 MCS 9 1SS (up to 433 Mbps).

If 802.11b clients are not allowed in the wireless network, then it is strongly recommended to disable the data rates below 12
Mbps. This will eliminate the need to send CTS frames for 802.11g/n protection as 802.11b clients cannot detect these OFDM
frames.

When 802.11b clients exist in the wireless network, then an 802.11b rate must be enabled and only an 802.11b rate can be
configured as a mandatory/ basic rate.

For a voice only application, data rates higher than 24 Mbps can optionally be enabled or disabled. To preserve high capacity
and throughput, data rates of 24 Mbps and higher should be enabled.

If deploying in an environment where excessive retries may be a concern, then a limited set of the data rates can be used,
where the lowest enabled rate is the mandatory/ basic rate.

For rugged environments or deployments requiring maximum range, it is recommended to enable 6 Mbps as a mandatory/
basic rate.

Note: that capacity and throughput are reduced when lower rates are enabled.

Rugged Environments

When deploying the Cisco Desk Phone 9800 Series in a rugged environment (e.g. manufacturing, warehouse, retail),
additional tuning on top of the standard design recommendations may be necessary.
Below are the key items to focus on when deploying a wireless LAN in a rugged environment.
Access Point and Antenna Selection
For rugged environments, it is recommended to select an access point platform that requires external antennas. It is
also important to ensure an antenna type is selected which can operate well in rugged environments.
Access Point Placement
It is crucial that line of sight to the access point’s antennas is maximized by minimizing any obstructions between the

Cisco Desk Phone 9800 Series and the access point. Ensure that the access point and/or antennas are not mounted
behind any obstruction or on or near a metal or glass surface.

If access points with integrated internal antennas are to be used in some areas, then it is recommended to mount those
access points on the ceiling as they have omni-directional antennas and are not designed to be wall mounted.
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Frequency Band

As always, it is recommended to use 5 GHz. Use of 2.4 GHz, especially when 802.11b rates are enabled, may not
work well.

For the 5 GHz channel set, it is recommended to use a 8 or 12 channel plan only; disable UNII-2 extended channels if
possible.

Data Rates

The standard recommended data rate set may not work well if multipath is present at an elevated level.

Therefore, it is recommended to enable lower data rates (e.g. 6 Mbps) to operate better in such an environment.

If using for voice only, then data rates above 24 Mbps can be disabled to increase first transmission success. If the
same band is also used for data, video or other applications, then it’s suggested to keep the higher data rates enabled.
Transmit Power

Due to the potential of elevated multipath in rugged environments, the transmit power of the access point and Cisco
Desk Phone 9800 Series should also be restricted. This is more important if planning to deploy 2.4 GHz in a rugged
environment. If using auto transmit power, the access point transmit power can be configured to use a specified range
(maximum and

minimum power levels) to prevent the access point from transmitting too hot as well as too weak (e.g. 5 GHz
maximum of 16 dBm and minimum of 11 dBm).

Fast Roaming

It is recommended to utilize 802.111/ Fast Transition (FT) for fast roaming. Enabling 802.11r (FT) also reduces the
number of frames in the handshake when roaming to only two frames. Reducing the number of frames during a roam,
increases the chances of roam success.

When using 802.1x authentication, it is important to use the recommended EAPOL key settings.

Quality of Service (QoS)

Need to ensure that DSCP values are preserved throughout the wired network, so that the WMM UP tag for voice,
video, and call control frames can be set correctly.

Multipath

Multipath occurs when RF signals take multiple paths from a source to a destination.

A part of the signal goes to the destination while another part bounces off an obstruction, then goes on to the destination. As a

result, part of the signal encounters delays and travels a longer path to the destination, which creates signal energy loss.

When the different waveforms combine, they cause distortion and affect the decoding capability of the receiver, as the signal

quality is poor.

Multipath can exist in environments where there are reflective surfaces (e.g. metal, glass, etc.). Avoid mounting access points

on these surfaces.
Below is a list of multipath effects:
Data Corruption
Occurs when multipath is so severe that the receiver is unable to detect the transmitted information.

Signal Nulling
Occurs when the reflected waves arrive exactly out of phase with the main signal and cancel the main signal

completely.
Increased Signal Amplitude

Occurs when the reflected waves arrive in phase with the main signal and add on to the main signal thereby increasing

the signal strength.
Decreased Signal Amplitude

Occurs when the reflected waves arrive out of phase to some extent with the main signal thereby reducing the signal

amplitude.
Use of Orthogonal Frequency Division Multiplexing (OFDM), which is used by 802.11a/n/ac and 802.11g/n, can help to
reduce issues seen in high multipath environments.
If using 802.11b in a high multipath environment, lower data rates should be used in those areas (e.g. 1 and 2 Mbps).
Use of antenna diversity can also help in such environments.
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Security

When deploying a wireless LAN, security is essential. The Cisco Desk Phone 9800 Series supports the following wireless
security features.

WLAN Authentication

*«  WPA2 and WPA (802.1x authentication)

*  WPA2-PSK and WPA-PSK (Pre-Shared key)

*  WPA3-SAE (Simultaneous Authentication of Equals)

+ EAP-FAST (Extensible Authentication Protocol - Flexible Authentication via Secure Tunneling)

* EAP-TLS (Extensible Authentication Protocol - Transport Layer Security)

*  PEAP (Protected Extensible Authentication Protocol - Generic Token Card/ Microsoft Challenge Handshake
Authentication Protocol version 2)

* None

WLAN Encryption
¢ AES (minimum 128-bit Advanced Encryption Standard)
«  TKIP/MIC (Temporal Key Integrity Protocol / Message Integrity Check)
WPAZ3-Enterprise
+ Key derivation and confirmation
Minimum 256-bit Hashed Message Authentication Mode (HMAC) with Secure Hash Algorithm (HMAC-SHA256)
*  Robust management frame

Minimum 128-bit Broadcast/Multicast Integrity Protocol Cipher-based Message Authentication Code (BIP-CMAC-
128)

Note: CCMP256, GCMP128 and GCMP256 encryption ciphers are not supported.

The Cisco Desk Phone 9800 Series also supports the following additional security features.
+ Image authentication
*  Device authentication
*  File authentication
+ Signaling authentication
*  Media encryption (SRTP)
» Signaling encryption (TLS)
»  Certificate authority proxy function (CAPF)
»  Secure profiles
*  Encrypted configuration files

Extensible Authentication Protocol - Flexible Authentication via Secure Tunneling (EAP-
FAST)

Extensible Authentication Protocol - Flexible Authentication via Secure Tunneling (EAP-FAST) encrypts EAP transactions
within a Transport Level Security (TLS) tunnel between the access point and the Remote Authentication Dial-in User Service
(RADIUS) server such as the Cisco Identity Service Engine (ISE).

The TLS tunnel uses Protected Access Credentials (PACs) for authentication between the client (the Cisco Desk Phone 9800
Series) and the RADIUS server. The server sends an Authority ID (AID) to the client, which in turn selects the appropriate
PAC. The client returns a PAC-Opaque to the RADIUS server. The server decrypts the PAC with its primary key. Both
endpoints now have the PAC key, and a TLS tunnel is created. EAP-FAST supports automatic PAC provisioning, but it must
enable on the RADIUS server.

To enable EAP-FAST, a certificate must be installed on to the RADIUS server.
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The Cisco Desk Phone 9800 Series currently supports automatic provisioning of the PAC only. Therefore, enable Allow
anonymous in-band PAC provisioning on the RADIUS server.

Both EAP-GTC and EAP-MSCHAPv2 must be enabled when Allow anonymous in-band PAC provisioning is enabled.
EAP-FAST requires a user account to be created on the authentication server.

If anonymous PAC provisioning is not allowed in the production wireless LAN environment, then a staging RADIUS server
can be set up for initial PAC provisioning of the Cisco Desk Phone 9800 Series.

This requires that the staging RADIUS server are set up as a secondary EAP-FAST server and components are replicated from
the product primary EAP-FAST server, which include user and group database and EAP-FAST primary key and policy info.
Ensure the production primary EAP-FAST RADIUS server is set up to send the EAP-FAST primary keys and policies to the
staging secondary EAP-FAST RADIUS server, which will then allow the Cisco Desk Phone 9800 Series to use the
provisioned PAC in the production environment where Allow anonymous in-band PAC provisioning is disabled.

When it is time to renew the PAC, then authenticated in-band PAC provisioning will be used. Therefore, ensure that Allow
authenticated in-band PAC provisioning is enabled.

Ensure that the Cisco Desk Phone 9800 Series has connected to the network during the grace period to ensure it can use its
existing PAC created either using the active or retired primary key to get issued a new PAC.

Is recommended to only have the staging wireless LAN pointed to the staging RADIUS server and to disable the staging
access point radios when not being used.

Extensible Authentication Protocol - Transport Layer Security (EAP-TLS)

Extensible Authentication Protocol - Transport Layer Security (EAP-TLS) is using the TLS protocol with PKI to secure
communications to the authentication server.

TLS provides a way to use certificates for both user and server authentication and for dynamic session key generation. A
certificate is required to be installed.

EAP-TLS provides excellent security but requires client certificate management.

EAP-TLS may also require a user account to be created on the authentication server matching the common name of the
certificate imported into the Cisco Desk Phone 9800 Series.

It is recommended to use a complex password for this user account and that EAP-TLS is the only EAP type enabled on the
RADIUS server.

Protected Extensible Authentication Protocol (PEAP)

Protected Extensible Authentication Protocol (PEAP) uses server-side public key certificates to authenticate clients by creating
an encrypted SSL/TLS tunnel between the client and the authentication server.

The ensuing exchange of authentication information is then encrypted, and user credentials are safe from eavesdropping.
PEAP-GTC and PEAP-MSCHAPV2 are supported inner authentication protocols.

PEAP requires a user account to be created on the authentication server.

Quality of Service (QoS)

Quality of Service enables queuing to ensure high priority for voice and call traffic.

To enable proper queuing for voice and call control traffic use the following guidelines.
* Ensure that WMM is enabled on the access point.

* Create a QoS policy on the access point giving priority to voice and call control traffic.

Traffic Type DSCP 802.1p WMM UP Port Range
Voice EF (46) 5 7 RTP/RTCP port negotiated with remote peer.
Call Control CS3 (24) 3 4 TCP/UDP port configured by admin

* Be sure that voice and call control packets have the proper QoS markings and other protocols are not using the same QoS
markings.
* Enable Differentiated Services Code Point (DSCP) preservation on the Cisco IOS switch.
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Call Admission Control (CAC)

The Cisco Desk Phone 9800 Series does not support Call Admission Control of voice stream.
If TSPEC is enabled for voice the access point, then the priority of voice frames will be downgraded.

Wired QoS

Configure QoS settings and policies for the necessary network devices.
Configuring Cisco Switch Ports for WLAN Devices
Configure the Cisco Wireless LAN Controller and Cisco Access Point switch ports as well as any uplink switch ports.
If utilizing Cisco I0S Switches, use the following switch port configurations.
Enable COS trust for Cisco Wireless LAN Controller

mls qos
!

interface X
mls qos trust cos
Enable DSCP trust for Cisco Access Points

mls qos
!

interface X

mls qos trust dscp
If utilizing Cisco Meraki MS Switches, refer to the Cisco Meraki MS Switch VoIP Deployment Guide.
https://meraki.cisco.com/lib/pdf/meraki_whitepaper msvoip.pdf
Note: When using the Cisco Wireless LAN Controller, DSCP trust must be implemented or must trust the UDP data ports
used by the Cisco Wireless LAN Controller (CAPWAP = UDP 5246 and 5247) on all interfaces where wireless packets will
traverse to ensure QoS markings are correctly set.
Configuring Cisco Switch Ports for Wired IP Phones
Enable the Cisco wired IP phone switch ports for Cisco phone trust.
Below is a sample switch configuration:

mls qos

!

Interface X

mls qos trust device cisco-phone

mls qos trust dscp

Roaming

The Cisco Desk Phone 9800 Series enables both sets of frequencies, which allows the Cisco Desk Phone 9800 Series to
connect to either 5 GHz or 2.4GHz and enables interband roaming support.

802.1x without 802.11r (FT) can introduce delay during roaming due to its requirement for full re-authentication. WPA,
WPA2 and WPA3 introduce additional transient keys and can lengthen roaming time.

When 802.11r (FT) is utilized, roaming times can be reduced to less than 100 ms, where the transition time from one access
point to another will not be audible to the user.

The Cisco Desk Phone 9800 Series supports 802.11r (FT).

Authentication Roaming Time Table

Authentication Roaming Time
WPA/WPA2/WPA3 Personal 150 ms

WPA2 Enterprise 300 ms

802.11r (FT) <100 ms

The Cisco Desk Phone 9800 Series manages the scanning and roaming events.
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The roaming trigger for most roaming events should meet the required RSSI differential based on the current RSSI. This
ensures seamless roaming without voice interruptions.

Fast Secure Roaming (FSR)

802.11r / Fast Transition (FT) is the recommended deployment model for all environment types where frequent roaming
occurs.
Cisco Centralized Key Management (CCKM) is not supported but requires 802.1x authentication.
802.11r (FT) enables fast secure roaming and limits the off-network time to minimize gaps during calls.
802.1x or PSK without 802.11r (FT) and 802.1x without FT can introduce delay during roaming due to its requirement for full
re-authentication. WPA, WPA2 and WPA3 introduce additional transient keys and can lengthen roaming time.
802.11r (FT) centralizes the key management and reduces the number of key exchanges.
When 802.11r (FT) is utilized, roaming times can be reduced from 400-500 ms to less than 100 ms, where that transition time
from one access point to another will not be audible to the user.
There are two methods of 802.11r (FT) roaming.
Over the Air
The client communicates directly with the target access point using 802.11 authentication with the FT authentication
algorithm.
Over the Distribution
The client communicates with the target access point through the current access point. The communication between

the client and the target access point is carried in FT action frames between the client and the current access point via
the WLAN controller.
802.11r (FT) utilizing the Over the Air method is the recommended fast secure roaming model to deploy.
Since the 802.11r (FT) plus Over the Distribution method requires connectivity to the currently associated access point, this
method may not work well if the phone is not always able to communicate with the current access point as well as the target
access point, which could occur in non-open environments if line of sight to both the current access point and the target access
point cannot be retained when a roaming event occurs.
The Cisco Desk Phone 9800 Series supports 802.11r (FT) with WPA2-PSK, WPA3-SAE or WPA2/WPA3 enterprise.

FSR Type Authentication Key Management Encryption | PMF
802.11r (FT) | PSK WPA-PSK WPA-PSK-SHA256 FT-PSK | AES No
802.11r (FT) | WPA3 SAE FT-SAE AES Yes
802.11r (FT) | EAP-TLS WPA-EAP FT-EAP AES No
802.11r (FT) | EAP-TLS (WPA3) | WPA-EAP-SHA256 FT-EAP AES Yes
802.11r (FT) | EAP-FAST WPA-EAP FT-EAP AES No
802.11r (FT) | EAP-FAST(WPA3) | WPA-EAP-SHA256 FT-EAP AES Yes
802.11r (FT) | EAP-PEAP WPA-EAP FT-EAP AES No
802.11r (FT) | EAP-PEAP(WPA3) | WPA-EAP-SHA256 FT-EAP AES Yes

Note: 1f deploying the Cisco Desk Phone 9800 Series into an environment where other Wi-Fi phone models exist but those
Wi-Fi phone models do not support 802.11r (FT), then should be able to use that same pre-existing SSID for the Cisco Desk
Phone 9800 Series, but is recommended to enable 802.11r (FT) utilizing the Over the Air method on top of the other
preexisting key management types (e.g. 802.1x); assuming the other Wi-Fi phone models can interoperate in an 802.11r (FT)
enabled network while not utilizing 802.11r (FT).

The access point must support AES (CCMP128) as TKIP can only be used as the broadcast/multicast cipher.

Interband Roaming

The Cisco Desk Phone 9800 Series enables both sets of frequencies, which enables interband roaming and currently gives
preference to the strongest signal. Typically, this will give preference to 2.4 GHz over 5 GHz due to 2.4 GHz having a stronger
signal in general assuming the power levels are the same.

At power on, the Cisco Desk Phone 9800 Series will scan all 2.4 and 5 GHz channels, then attempt to associate to an access
point for the configured network if available.

It is recommended to perform a spectrum analysis to ensure that the desired bands can be enabled to perform interband
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roaming.

Power Management

The power supply is required to enable the Cisco Desk Phone 9800 Series for wireless LAN mode, as there is no internal
battery.

Wireless LAN is automatically disabled temporarily when Ethernet is connected to the Cisco Desk Phone 9800 Series but will
be automatically re-enabled once Ethernet is disconnected if Wireless LAN was enabled previously.

The Cisco Desk Phone 9800 Series primarily uses fast sleep mode (no Wi-Fi power save) when in idle or on call.

Null Power Save (PS-NULL) frames are utilized for off-channel scanning.

Delivery Traffic Indicator Message (DTIM)

It is recommended to set the DTIM period to 2 with a beacon period of 100 ms.

Since the Cisco Desk Phone 9800 Series uses fast-sleep mode, the DTIM period will not be used to schedule wake-up periods
to check for broadcast and multicast packets as well as any unicast packets.

Broadcast and multicast traffic will be queued until the DTIM period when there are power-save-enabled clients associated to
the access point, so DTIM will determine how quickly these packets can be delivered to the client. If using multicast
applications, a shorter DTIM period can be used.

When multiple multicast streams exist on the wireless LAN frequently, then it is recommended to set the DTIM period to 1.

Call Capacity

Design the network to accommodate the desired call capacity.

The Cisco Access Point can support up to 27 bi-directional voice streams for both 802.11a/n/ac and 802.11g/n at a data rate of
24 Mbps or higher. To achieve this capacity, there must be minimal wireless LAN background traffic and initial radio
frequency (RF) utilization.

The number of calls may vary depending on the data rate, initial channel utilization, and the environment.

Multicast

When enabling multicast in the wireless LAN, performance and capacity must be considered.

If there is an associated client that is in power save mode, then all multicast packets will be queued until the DTIM period.
The Cisco Desk Phone 9800 Series utilizes fast-sleep mode primarily, but if there is an associated client that is in power save
mode, then all multicast packets will be queued until the DTIM period.

With multicast, there is no guarantee that the packet will be received timely by the client.

The multicast traffic will be sent at the highest mandatory / basic data rate enabled on the access point, so will want to ensure
that only the lowest enabled rate is configured as the only mandatory / basic rate.

The client will send the IGMP join request to receive that multicast stream. The client will send the IGMP leave when the
session is to be ended.

The Cisco Desk Phone 9800 Series supports the IGMP query feature, which can be used to reduce the amount of multicast
traffic on the wireless LAN when not necessary.

Ensure that IGMP snooping is also enabled on all switches.

Note: If using Coexistence where 802.11b/g/n and Bluetooth are being used simultaneously, then multicast voice is not
supported.
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Configuring the Cisco Wireless LAN

Cisco AireOS Wireless LAN Controller and Lightweight Access Points

When configuring the Cisco AireOSWireless LAN Controller and Lightweight Access Points, use the following guidelines:

* Enable 802.11r (FT)

* CCKM is Disabled

*  Set Quality of Service (QoS) to Platinum

* Set the WMM Policy to Required

*  Ensure Session Timeout is enabled and configured correctly

*  Ensure Broadcast Key Interval is enabled and configured correctly

»  Ensure Aironet IE is Disabled

» Disable P2P (Peer to Peer) Blocking Action

*  Ensure Client Exclusion is configured correctly

* Disable DHCP Address Assignment Required

+ Set Protected Management Frame (PMF) to Optional or Required for WPA3
* Set MFP Client Protection to Optional or Required for WPA3

* Set the DTIM Period to 2

» Set Client Load Balancing to Disabled

» Set Client Band Select to Disabled

* Set IGMP Snooping to Enabled

*  Enable Symmetric Mobile Tunneling Mode if Layer 3 mobility is utilized
» Configure the Data Rates as necessary

* Configure Auto RF as necessary

* Set EDCA Profile to Voice Optimized or Voice and Video Optimized

* Set Enable Low Latency MAC to Disabled

*  Ensure that Power Constraint is Disabled

*  Enable Channel Announcement and Channel Quiet Mode

*  Configure the High Throughput Data Rates as necessary

*  Configure the Frame Aggregation settings

* Enable CleanAir if utilizing Cisco access points with CleanAir technology
*  Configure Multicast Direct Feature as necessary

*  Set the 802.1p tag to 5 for the Platinum QoS profile

802.11 Network Settings

It is recommended to operate the Cisco Desk Phone 9800 Series only on the 5 GHz band due to the availability of many
channels and fewer interferers compared to the 2.4 GHz band.

To use 5 GHz frequency, ensure that the 802.11a/n/ac Network Status is Enabled.

Set the Beacon Period to 100 ms.

Maximum Allowed Clients can be configured as necessary.

It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps and higher as supported (optional) rates.
However, some environments may require 6 Mbps to be enabled as a mandatory (basic) rate.
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All APs
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Mesh
¥ AP Group NTP
» ATF
RF Profiles
FlexConnect Groups
¥ FlexConnect ACLs

FlexConnect VLAN
Templates

Network Lists

v B02.11a/n/acfax
Metwork
* RRM
RF Grouping
TPC
DCA

MONITOR  WLANs

802.11a Global Parameters

CONTROLLER

WIRELESS

SECURITY MANAGEMENT

COMMANDS

HELP

FEEDBACK

Disabled

Disabled

Mandatory
Supported
Supported
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General Data Rates**
802.11a Network Status Enabled 6 Mbps
Beacon Period (millisecs) 100 9 Mbps
Fragmentation Threshold
2346 12 Mbps
(bytes)
DTPC Support. Enabled 18 Mbps
Maximum Allawed Clients 100 24 Mbps
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Made Enabled
Mid Band Enabled
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High Band Enabled

TWT Configuration **x*

Target Waketime

Enabled

Broadcast TWT Support Enabled

To use 2.4 GHz, ensure that the 802.11b/g/n Network Status and 802.11g are Enabled.
Set the Beacon Period to 100 ms.

Short Preamble should be Enabled in the 2.4 GHz radio configuration setting on the access point when there’re no legacy
clients requiring a long preamble in the wireless LAN. By using the short preamble instead of long preamble, the wireless

network performance is improved.
Maximum Allowed Clients can be configured as necessary.
It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps and higher as supported (optional) rates assuming

that there will not be any 802.11b only clients that will connect to the wireless LAN; however, some environments may

require 6 Mbps to be enabled as a mandatory (basic) rate.

I£ 802.11D clients exist, then 11 Mbps should be set as the mandatory (basic) rate and 12 Mbps and higher as supported

(optional).

CIsCo

Wireless

¥ Access Points
All APs
* Radios
Global Configuration

» Advanced
Mesh
F AP Group NTP
b ATF
RF Profiles
FlexConnect Groups
» FlexConnect ACLs

FlexConnect VLAN
Templates

Network Lists
» BD2.11a/n/fac/ax

¥ 802.11b/g/nfax
Network
+* RRM
RF Grouping
TPC

MONITOR.  WLANs

CONTROLLER

802.11b/g Global Parameters

General

WIRELESS

SECURITY MAMNAGEMENT

Data Rates**

802.11b/g Network Status
B02.11g Support
Beacon Period (millisecs)

Short Preamble

Fragmentation Threshold
(bytes)
DTPC Support.

Maximum Allowed Clients

RSSI Low Check
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Auto RF (RRM)

When using the Cisco Wireless LAN Controller, it is recommended to enable Auto RF to manage the channel and transmit

power settings.

Configure the access point transmit power level assignment method for either 5 or 2.4 GHz depending on which frequency

band is to be utilized.

If using automatic power level assignment, a maximum and minimum power level can be specified.

MONITOR WLANs CONTROLLER WIRELESS

Wireless

¥ Access Points
All APs
¥ Radios
Global Configuration

¥ Advanced
Mesh
¥ AP Group NTP
» ATF
RF Profiles
FlexConnect Groups
¥ FlexConnect ACLs

FlexConnect VLAN
Templates

Network Lists

¥ B802.11a/n/acfax
Network

802.11a > RRM > Tx Power Control{(TPC)

TPC Version

COMMANDS HELP FEEDBACK

_Interference Optimal Mode (TPCv2)
°Coverage Optimal Mode (TPCwv1)

Tx Power Level Assignment Algorithm

Power Level Assignment Methaod

Maximum Power Level Assignment {-10 to 30 dBm)
Minimum Power Level Assignment (-10 to 30 dBm)
Power Assignment Leader

Last Power Level Assignment

Power Threshold (-80 to -50 dBm)

Channel Aware

Power Neighbor Count

©Automatic Every 600 sect
~'On Demand Invoke Power Update Once I
~Fixed 1 0°

17

11

RTPS-32A-WLC3 (10.81.6.70)
463 secs ago

-65

| Enabled

3

= RRM
RF Grouping
TPC
DCA
Coverage
General

When using 5 GHz, it’s recommended to limit the number of channels (e.g. 12 channels only) to avoid any potential delay in
access point discovery caused by scanning many channels.

The 5 GHz channel width can be configured as 20 MHz or 40 MHz for using Cisco 802.11n Access Points and as 20 MHz,
40MHz or 80 MHz for using Cisco 802.11ac Access Points.

It is recommended to utilize the same channel width for all access points.

CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
Wireless 802.11a > RRM > Dynamic Channel Assignment (DCA)
¥ Access Points
All APs Dynamic Channel Assignment Algorithm
* Radios
Global Configuration Channel Assignment Method °Auturnatic Interval: 10 minutes AnchorTime: 0
» Advanced Freeze Invoke Ck | Update Once |
Mesh OFF
» AP Group NTP Awoid Foreign AP interference Enabled
Awoid Cisco AP load | Enabled
» ATF
Avoid non-802.11a noise Enabled
RF Profiles

Awvoid Persistent Non-WiFi Interference Enabled
FlexConnect Groups

Channel Assignment Leader RTPO-32A-WLC3 (10.81.6.70)
¥ FlexConnect ACLs

Last Auto Channel Assignment 556 secs ago
FlexConnect VLAN
Templatu DCA Channel Sensitivity Medium (15 dB)
Network Lists Channel Width 20 MHz @ 40 MHz (80 MHz (/160 MHz [ 80+80 MHz [ Best
¥ 802.11a/n/acfax Awoid check for non-DFS channel | Enabled
Network
= RRM DCA Channel List
RF Grouping
TPC 36, 40, 44, 48, 52, 56, 60, 64, 100, 153,
DCA 157, 161
BT DCA Channels
General

Client Roaming
Media
EDCA Parameters
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When using 2.4 GHz, only channels 1, 6, and 11 should be enabled in the DCA list.
It is recommended to configure the 2.4 GHz channel as 20 MHz even when using Cisco 802.11n Access Points capable of 40
MHz due to the limited number of channels available in 2.4 GHz.

CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
Wireless 802.11b > RRM > Dynamic Channel Assignment (DCA)
¥ Access Points
All APs Dynamic Channel Assignment Algorithm
} Radios
Global Configuration Channel Assignment Method ©Automatic Interval: 10 minutes AnchorTime: 0
» Advanced Freeze Invoke C Update Once I
Mesh OFF
» AP Group NTP Avoid Foreign AP interference Enabled
Avoid Cisco AP load | Enabled
¥ ATF
Avoid non-802.11b noise Enabled
RF Profiles
Avoid Persistent Non-WiFi Interference | Enabled
FlexConnect Groups
Channel Assignment Leader RTP9-32A-WLC3 (10.81.6.70)
» FlexConnect ACLs
Last Auto Channel Assignment 75 secs ago
FlexConnect VLAN
Templates DCA Channel Sensitivity Medium (10 dB)

[HEaEns s DCA Channel List

-

802.11a/nfac/fax

+ 802.11b/g/n/ax L6 11

Network
» RRM DCA Channels
RF Grouping
TPC
DCA A
Coverage

Individual access points can be configured to override the global setting to use dynamic channel and transmit power
assignment for either 5 or 2.4 GHz depending on which frequency band is to be utilized.

Other access points can be enabled for automatic assignment method and account for the access points that are statically
configured.

This may be necessary if there is an intermittent source of interference in the area.

The 5 GHz channel width can be configured as 20 MHz or 40 MHz when using Cisco 802.11n Access Points and 20 MHz, 40
MHz, or 80 MHz when using Cisco 802.11ac Access Points.

It is recommended to use channel bonding only when using 5 GHz.

It is recommended to utilize the same channel width for all access points.

CciIsco MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
Wireless 802.11a/n/ac/ax Cisco APs > Configure
¥ Access Points
Al APs
o LR General RF Channel Assignment
802.11a/n/ac/ax
802.11b/g/n/ax AP Name rtp9-31a-apl Current Channel (48,44)
e LI L Admin Status Enable Channel Width * 40MHz ©
Global Configuration . i § i
Operational Status e Channel width can be configured only when channel configuration is in custom
» Advanced mode
Slot # 1
Mesh Assignment Method ©Global
» AP Group NTP 11n Parameters Kustom
» ATF Radar Information
11n Supported Yes
RF Profiles
FlexConnect Groups CleanAir Channel Last Heard(Secs)
» FlexConnect ACLs No radar detected channels
SN CleanAir Capable Yes
ext nne .
Templates CleanAir Admin Status Enable Tx Power Level Assignment
e e * CleanAir enable will take effect only if it is enabled on this band.
Current Tx Power Level 1
» 802.11a/n/ac/ax Number of Spectrum Expert
/n/ac/ connections o Assignment Method ©clobal

b 802.11b/g/n/ax “Custom
} Media Stream Antenna Parameters

i Antenna Type Internal

Application Visibility
» Performance Profile

And Control A

Lync Server Antenna 2 View and edit Performance Profile for this AP

) 7
i a Performance Profile
Timers N
Note: Changing any of the parameters causes the Radio to be temporarily disabled

b Netflow and thus may result in loss of connectivity for some clients.
b Qos
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Client Roaming

The Cisco Desk Phone 9800 Series does not utilize the RF parameters in the Client Roaming section of the Cisco Wireless
LAN Controller as scanning and roaming are managed independently by the device itself.

EDCA Parameters

Set the EDCA profile to either Voice Optimized or Voice & Video Optimized and disable Low Latency MAC for either 5
or 2.4 GHz depending on which frequency band is to be utilized.

Low Latency MAC (LLM) reduces the number of retransmissions to 2-3 per packet depending on the access point platform, so
it can cause issues if multiple data rates are enabled.

LLM is not supported on the Cisco 802.11n/ac Access Points.

CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Wireless

¥ Access Points

All APs General
* Radios
Global Configuration EDCA Profile Voice & Video Optimized
» Advanced Enable Low Latency MAC 1 .
Mesh

» AP Group NTP

Low latency Mac feature is not supported for 1140/1250/3500 platforms if more than 3 data rates are enabled.
» ATF

DFS (802.11h)

Power Constraint should be left un-configured or set to 0 dB.
Channel Announcement and Channel Quiet Mode should be Enabled.

CIsSCO MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
Wireless 802.11h Global Parameters
¥ Access Points
All APs Power Constraint
* Radios
Global Configuration Local Power Constraint(0-30) 0 dB
papattvanced Channel Switch Announcement
Mesh
Channel Announcement
¥ AP Group NTP ~
Channel Switch Count 0
b ATF Channel Quiet Mode
RF Profiles

FlexConnect Groups Radar Blacklist

» FlexConnect ACLs Smart DFS

High Throughput (802.11n/ac)

The 802.11n data rates can be configured per radio (2.4 GHz and 5 GHz).

802.11ac data rates are applicable to 5 GHz only.

Ensure that WMM is enabled and WPA2/WPA3(AES) is configured to utilize 802.11n/ac data rates.

The Cisco Desk Phone 9800 Series supports HT MCS 0 — MCS 7 and VHT MCS 0 — MCS 9 1SS data rates only, but higher
MCS rates can optionally be enabled if there are other 802.11n/ac clients utilizing the same band frequency that include
MIMO antenna technology, which can take advantage of those higher data rates.
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MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS

HELP

FEEDBACK

Wireless 802.11n/ac/ax (5 GHz) Throughput
¥ Access Points
All APs General
* Radios
Global Configuration 11n Mode @ Enabled 2
» Advanced 11ac Mode ) Enabled 3
3
Mesh 1lax Mode Enabled 2
b AP Group NTP VHT MCS Rates
» ATF
RF Profiles 5§51
. 4
FlexConnect Groups 0-8 #| Engbled =
. 4
» FlexConnect ACLs 09 8 Enabled ¢
FlexConnect VLAN §S2
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0-8 7 Enabled 4
Network Lists
0-9 Enabled 4
¥ 802.11a/n/facfax
Network
» RRM s53
RF Grouping 0-8 + Enabled £
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¥ 4
- 0-9 Enabled 4
Coverage
General §s4
Client Roaming 0-8 7 Enabled 4
Media 4
EDCA Parameters 0-8 Enabled =
DFS (802.11h)
High Throughput HE MCS Rates
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CleanAi
eanair ss1 ss2
4 5
L I 0-7 + Enabled 0-7 + Enabled
sl team 0-9 7 Enabled 0-9 7 Enabled
FRApESctiong s iy 0-11 B Enabled 0-11 Enabled
And Control
Lync Server S§53 554
Country 0-7 + Enabled 0-7 7 Enabled
Timers 0-9 ¥ Enabled 0-9 + Enabled
P Netflow 0-11 Enabled 0-11 Enabled
¥ QoS
2 5§55 556
0-7 + Enabled 0-7 < Enabled
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[

L - ™. T -~ PR ]

13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31

(7
(14
(21
(29
(43
(58
( 65
(72
(14
(29
(43
(58
(87
(116
(130
( 144
(22
(43
(65
(87
(130
(173
(195
(217
(29
(58
(87
(116
(173
(231
( 260
( 289

Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)
Mbps)

Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported
Supported

Supported

Frame aggregation is a process of packaging multiple MAC Protocol Data Units (MPDUs) or MAC Service Data Units

(MSDUs) together to reduce the overheads where in turn throughput and capacity can be optimized.
Aggregation of MAC Protocol Data Unit (A-MPDU) requires the use of block acknowledgements.

It is required to adjust the A-MPDU and A-MSDU settings to the following to optimize the experience with the Cisco Desk

Phone 9800 Series.
A-MSDU
User Priority 1, 2= Enabled
User Priority 0, 3, 4, 5, 6, 7= Disabled
A-MPDU
User Priority 0, 3, 4, 5 = Enabled
User Priority 1, 2, 6, 7 = Disabled

Use the following commands to configure the A-MPDU and A-MSDU settings according to the Cisco Desk Phone 9800

Series requirements.

To configure the 5 GHz settings, enable the 802.11a network first, then re-enable it after the changes are complete.

config 802.11a 11nSupport a-msdu tx priority 1 enable
config 802.11a 11nSupport a-msdu tx priority 2 enable
config 802.11a 11nSupport a-msdu tx priority 0 disable
config 802.11a 11nSupport a-msdu tx priority 3 disable
config 802.11a 11nSupport a-msdu tx priority 4 disable
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config 802.11a 11nSupport a-msdu tx priority 5 disable
config 802.11a 11nSupport a-msdu tx priority 6 disable
config 802.11a 11nSupport a-msdu tx priority 7 disable

config 802.11a 11nSupport a-mpdu tx priority 0 enable
config 802.11a 11nSupport a-mpdu tx priority 3 enable
config 802.11a 11nSupport a-mpdu tx priority 4 enable
config 802.11a 11nSupport a-mpdu tx priority 5 enable
config 802.11a 11nSupport a-mpdu tx priority 1 disable
config 802.11a 11nSupport a-mpdu tx priority 2 disable
config 802.11a 11nSupport a-mpdu tx priority 6 disable
config 802.11a 11nSupport a-mpdu tx priority 7 disable

To configure the 2.4 GHz settings, enable the 802.11b/g network first, then re-enable it after the
changes are complete.

config 802.11b 11nSupport a-msdu tx priority 1 enable

config 802.11b 11nSupport a-msdu tx priority 2 enable

config 802.11b 11nSupport a-msdu tx priority 0 disable

config 802.11b 11nSupport a-msdu tx priority 3 disable

config 802.11b 11nSupport a-msdu tx priority 4 disable

config 802.11b 11nSupport a-msdu tx priority 5 disable

config 802.11b 11nSupport a-msdu tx priority 6 disable

config 802.11b 11nSupport a-msdu tx priority 7 disable

config 802.11b 11nSupport a-mpdu tx priority 0 enable
config 802.11b 11nSupport a-mpdu tx priority 3 enable
config 802.11b 11nSupport a-mpdu tx priority 4 enable
config 802.11b 11nSupport a-mpdu tx priority 5 enable
config 802.11b 11nSupport a-mpdu tx priority 1 disable
config 802.11b 11nSupport a-mpdu tx priority 2 disable
config 802.11b 11nSupport a-mpdu tx priority 6 disable
config 802.11b 11nSupport a-mpdu tx priority 7 disable

To view the current A-MPDU and A-MSDU configuration, enter either show 802.11a for 5 GHz or show 802.11b for 2.4
GHz.
802.11n Status:

A-MSDU Tx:
Priority O....ccceevvvevenienienen. Disabled
Priority 1....cccvviiiiieiennn, Enabled
Priority 2....cccevvevenieiiennnn Enabled
Priority 3....ccoevieiiieie Disabled
Priority 4.....cccovveveiieienen Disabled
Priority 5....cccvevvevcenienieen Disabled
Priority 6......cceeveveviveniennn. Disabled
Priority 7....cccvevvevceeieeieenn, Disabled

A-MPDU Tx:
Priority O....ccceevvevenieiienen Enabled
Priority 1...ooovevieiiiiiee, Disabled
Priority 2....cccevvevcenieniennnn Disabled
Priority 3...cooovevieiiieie Enabled
Priority 4.....ccoovveveieiee Enabled
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Priority S...coveeieiieieieeeeee Enabled
Priority 6....ccoecveeeeveeieieenene Disabled
Priority 7..cocoveeveeeeeeieeeeenes Disabled

CleanAir

CleanAir should be Enabled when utilizing Cisco access points with CleanAir technology to detect any existing interferers.
alear]

CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Wireless

¥ Access Points
All APs
* Radios

Global Configuration
¥ Advanced

Mesh
¥ AP Group NTP
¥ ATF

RF Profiles
FlexConnect Groups
¥ FlexConnect ACLs

FlexConnect VLAN
Templates

Network Lists

* 802.11a/n/acfax
Network
« RRM
RF Grouping
TPC
DCA
Coverage
General
Client Roaming
Media
EDCA Parameters
DFS (802.11h)
High Throughput
(802.11nfac/ax)
CleanAir

b 802.11b/g/n/ax

» Media Stream
Application Visibility
And Control
Lync Server
Country
Timers

¥ Netflow
¥ Qos

802.11a > CleanAir

CleanAir/Spectrum Intelligence Parameters

CleanAir
Spectrum Intez\l'lgeru:ez
Report Interferersl

Persistent Device Propagation

Interferences to Ignore

Canopy
WiMax Fixed
SI_FHSS

Trap Configurations

@ Enabled
_|Enabled
EEnabled

_|Enabled

Interferences to Detect

TDD Transmitter
Jammer

Continuous Transmitter
DECT-like Phone

Video Camera

Enable AQI{Air Quality Index) Trap

AQI Alarm Threshold {1 to 100)2

Enable trap for Unclassified Interferences
Thresheld for Unclassified category trap (1 to 99)
Enable trap for Classified Interferences
Thresheld for Classified category trap (1 to 99)

Enable Interference For Security Alarm

Do not trap on these types

TDD Transmitter
Continuous Transmitter
DECT-like Phone

Video Camera

SuperAG

Event Driven RRM (change Settings)

@Enabled
35
_|Enabled
20
_|Enabled
0
@Enabled

Trap on these types

Jammer
WiFi Inverted
WiFi Invalid Channel

EDRRM Disabled
Sensitivity Threshold NJA
Rogue Contribution N/A
Rogue Duty-Cycle N/A

(1)Device Security alarms, Event Driven RRM and Persistence Device Avoidance algorithm will not work if Interferers reporting is disabled.

(2)AQI value 100 is best and 1 is worst

(3)Spectrum Intelligence does not send traps to Prime Infrastructure and CMX
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CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Wireless 802.11a/n/ac/ax Cisco APs > Configure
¥ Access Points
All APs
v Bl General RF Channel Assignment
802.11a/n/ac/ax
802.11b/g/n/ax AP Name rtp9-31a-apl Current Channel (48,44)
Dual-Band Radios Admin Status Enable Channel Width * 40MHz
Global Configuration . ) i i
Operational Status e Channel width can be configured only when channel configuration s in custom
¥ Advanced mode
Slot # 1
Mesh Assignment Method OGlcbal
b Custom

AP Group NTP

11n Parameters

» ATF Radar Information
11n Supported Yes

RF Profiles

FlexConnect Groups CleanAir Channel Last Heard(Secs)
¥ FlexConnect ACLs Mo radar detected channels

e Cleanir Capable Yes

exConne .
Templates CleanAir Admin Status Enable Tx Power Level Assignment
Network Lists * CleanAir enable will take effect only if it is enabled on this band.
Current Tx Power Level 1
» BO02.11a/n/ac/ax Number of Spectrum Expert
/niact connections 0 Assignment Method ©Global

-

802.11b/g/n/fax

-

Media Stream

Antenna Parameters

“'Custom

cation Vislbil Antenna Type Internal
Application Visibility
» Performance Profile
And Control A
B . - .
Lync Server Antenna c View and edit Performance Profile for this AP
D v
Country /] Performance Profile
Timers " "
Note: Changing any of the parameters causes the Radio to be temporarily disabled
» Netflow and thus may result in loss of connectivity for some clients.
¥ QoS

Rx Sop Threshold

It is recommended to use the default value for Rx Sop Threshold.

cisCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
Wireless Rx Sop Threshold
1
¥ Access Points
All APs Rx Sop Thresheold 802.11a Default ~|Custom
» i —
- Rx Sop Threshold 802.11b Default 0 Customn

Global Configuration

¥ Advanced
+ RF Management

Flexible Radio
Assignment
Load Balancing
DTLS
Band Select
Rx Sop Threshold
Optimized Roaming
Network Profile

1 Rxsop only supported in Local,Flex, Bridge and Flex+Bridge mode Aps.
iR 1 rted in L I, Flex, Bridi d Fl Brid de A

WLAN Settings

It is recommended to have a separate SSID for the Cisco Desk Phone 9800 Series.

However, you can also use an existing SSID that is configured to support voice capable Cisco Wireless LAN endpoints.

The SSID to be used by the Cisco Desk Phone 9800 Series can be configured to only apply to a certain 802.11 radio type (e.g.
802.11a only).

It is recommended to operate the Cisco Desk Phone 9800 Series on the 5 GHz band only due to availability of many channels
and fewer interferers compared to the 2.4 GHz band.

Ensure that the selected SSID is not utilized by any other wireless LANs as that could lead to failures when powering on or
during roaming, especially when a different security type is utilized.
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CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

WLANs WLANs > New
] Type WLAN
WLANs
Profile Name vaice
¥ Advanced
SSID wvoice
D 6
aleal
CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
WLANSs WLANSs > Edit ‘voice’
T WLANs General | Security | QoS | Policy-Mapping | Advanced |
WLANs
» Advanced Profile Name voice
Type WLAN
SSID vaoice
Status Enabled
Security Policies [WPA2][Auth(FT 802.1X)]
(Modifications done under security tab will appear after applying the changes.)
Radio Policy 802.11a only
Interface/Interface
Group(G) rtp-9 voice
Multicast Vlan Feature | Enabled
Broadcast SSID Enabled
NAS-ID [RTPS-32A-WLC3
Lobby Admin Access ]

To utilize 802.11r (FT) for fast secure roaming, enable Fast Transition.

It is recommended to uncheck Over the DS to utilize the Over the Air method instead of the Over the Distribution System
method.

Protected Management Frame should be set to Optional or Required for WPA3.

Enable WPA2/WPA3 policy with AES encryption then FT 802.1x, FT PSK or FT SAE for authenticated key management
type depending on whether 802.1x or PSK/SAE is to be utilized.

WLANSs > Edit 'Wifi_cisco'

General | Security | Qos | Policy-Mapping | Advanced

WPA2+WPA3 Parameters

Policy FAwpa2 Bwea3
Encryption Cipher MAccvpi2g(aes)  [Jccmpse  [Jeempizs  [Jecmp2se

Fast Transition

Fast Transition

Over the DS

Reassociation Timeout Seconds

Protected Management Frame

PMF Optional v
e
timer(1-10sec)

SA Query
Timeout(100-500msec)

200

Authentication Key Management 12

802.1X-SHA1 [ Enable
802.1X-SHA2 [C] Enable
FT 802.1X Enable

Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide

33



WLANSs > Edit "Wifi_cisco’

Fast Transition

O
Seconds

Protected Management Frame

Fast Transition
Over the DS

Reassociation Timeout

PMF Required v
fimer(1.11
timer(1-10sec)

SA Query

Timeout(100-500msec) 200

Authentication Key Management 12

802.1X-SHA1 ] Enable
802.1X-SHA2 [J Enable
FT 802.1X Enable

General | Security | QoS | Policy-Mapping Advanced
WPA2+WPA3 Parameters
Policy [CJwea2 MweA3
Encryption Cipher Mccmpi2g(aEs)  [ccmpese  [Jecmpizs [Jecmp2ss

802.11x, PSK, or SAE can be enabled to utilize the same SSID for various types of voice clients. Some clients may not

support 802.11r (FT), depending on whether 802.1x, PSK, or SAE is used.

RADIUS Authentication and Account Servers can be configured per SSID to override the global list.
If Enabled or not specified (set to None), then the global list of RADIUS servers defined at Security > AAA > RADIUS will

be utilized.

All EAP parameters, except for EAP-Broadcast Key Interval, can be set per SSID or globally. EAP-Broadcast Key Interval

can only be configured at the global level.

To configure the EAP parameters per SSID, check Enable in the EAP Parameters section and enter the desired values.

COMMANDS HELP FEEDBACK

CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT
WLANSs WLANSs > Edit ‘voice"
— TR p . - P .
General Security Qos Policy-Mapping Advanced
WiANS | Gl | I | | |
» Advanced Layer 2 I Layer 3 I AAA Servers |

RADIUS Servers
RADIUS Server Overwrite interface [ |Enabled

Apply Cisco I1SE Default Settings ~|Enabled

Salect AAA servers below to override use of default servers on this WLAN

Authentication Servers
Enabled

Server 1 | None

Accounting Servers
Enabled

None

Server 2 | None None

Server 3 | None None
Server 4 | None None

Server 5 | None None

oRoL o oRo]

Server 6 | None None

Authorization ACA Server Accounting ACA Server
| Enabled | Enabled

oRolofolofo]

EAP Parameters

Enable
EAPOL Key Timeout(200 to 5000 millisec) 400
EAPOL Key Retries{D to 4) 4

Identity Request Timeout(1 to 120 sec) 30

Identity Request Retries(1 to 20) 2
Request Timeout(1 to 120 sec) 30
Request Retries(1 to 20) 2

The WMM policy should be set to Required only if the Cisco Desk Phone 9800 Series or other WMM-enabled phones will be

using this SSID.

If there are non-WMM clients on the WLAN, it is recommended to put those clients on a separate WLAN.
If non-WMM clients must utilize the same SSID as the Cisco Desk Phone 9800 Series, ensure the WMM policy is set to

Allowed.
Enabling WMM will enable the 802.11e version of QBSS.
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CISCO MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

WLANSs WLANSs > Edit ‘voice’
- Ll | General | Security | QoS | Policy-Mapping | Advanced |
WLANSs
» Advanced Quality of Service (QoS) Platinum (voice)
Application Visibility Enabled
AVC Profile none
Flex AVC Profile none <
Netflow Monitor none
Fastlane Disable

Override Per-User Bandwidth Contracts (kbps) 1

DownStream UpStream

Average Data Rate 0 0
Burst Data Rate V] V]
Average Real-Time Rate 0 0
Burst Real-Time Rate 0 0

Clear

CIsSCO MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
WLANs WLANSs > Edit “voice’
¥ WLANs | General I Security I QoS I Policy-Mapping I Advanced |
A Override Per-SSID Bandwidth Contracts (kbps) 1€
¥ Advanced
DownStream UpStream

Average Data Rate o o

Burst Data Rate 0 0

Average Real-Time Rate o o

Burst Real-Time Rate V] V]

Clear
WMM

WMM Palicy Required

7920 AP CAC Enabled

7920 Client CAC | Enabled

Multicast Direct Enabled
Lync Policy
Audio Silver

Configure Enable Session Timeout as needed. It is recommended to enable the session timeout for 86400 seconds to avoid
potential interruptions during audio calls and periodically re-validate client credentials to ensure that the client is using valid
credentials.

Disable Aironet Extensions (Aironet IE).

Peer to Peer (P2P) Blocking Action should be disabled.

Configure Client Exclusion as needed.

The Maximum Allowed Clients Per AP Radio can be configured as needed.

Off Channel Scanning Defer can be tuned to defer scanning for certain queues as well as the scan defer time.

If using best effort applications frequently or not preserving DSCP values for priority applications (e.g. voice and call control)
to the access point, it is recommended to enable the lower priority queues (0-3) along with the higher priority queues (4-6) to
defer off channel scanning as well as potentially increase the scan defer time.

For deployments with frequent EAP failures, it is recommended to enable priority queue 7 to defer off channel scanning
during EAP exchanges.

DHCP Address Assignment Required should be disabled.

Management Frame Protection should be set to Optional or Required for WPA3.
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Use a DTIM Period of 2 with a beacon period of 100 ms.
Ensure Client Load Balancing and Client Band Select are disabled.

It is recommended to set Re-anchor Roamed Voice Clients to Disabled as this can cause brief interruptions with wireless

LAN connectivity when a call is terminated after performing an inter-controller roaming.
Keep the default settings for 802.11k and 802.11v.

Cisco
WLANs

¥ WLANs
WLANs

» Advanced

Nmm
CIsco

WLANs

¥ WLANs
WLANs

¥ Advanced

MONITOR  WLANs

WLANSs > Edit ‘voice’

CONTROLLER

WIRELESS

SECURITY MANAGEMENT

' General | Security | Qos | Policy-Mapping | Advanced |

MONITOR  WLANSs

Allow AAA Override
Coverage Hole Detection

Enable Session Timeout

Aironet IE

Diagnostic Channel 18
Override Interface ACL
Layer2 Acl

URL ACL

P2P Blocking Action
Client Exclusion 3

Maximum Allowed Clients
8

Static IP Tunneling 11
'Wi-Fi Direct Clients Policy

Maximum Allowed Clients

Dar AD Dadin

WLANSs > Edit ‘voice’

CONTROLLER

| Enabled
Enabled
86400

COMMANDS  HELP

FEEDBACK

Session Timeout (secs)

B Enabled
—|Enabled
IPv4 | None
Mone
MNone
Disabled

—|Enabled
0

—|Enabled

Disabled

200

WIRELESS

SECURITY MANAGEMENT

IPv6  None

(o]

(o]

General | Security | Qos | Policy-Mapping | Advanced |

PEF AP Radio

Clear HotSpot —
Caonfiguration

Client user idle —
timeout(15-100000)

Client user idle threshold
(0-10000000)

i}
Radius NAI-Realm
1lac MU-MIMO
WGE PRP

MBO State

Enabled

Bytes

| Enabled

COMMANDS

DHCP

DHCP Server

DHCP Addr. Assignment

Frame P

MFP Client Protection £

Optional
DTIM Period (in beacon intervals)

802.11a/n (1-255) 2

802.11b/g/n (1 - 255) 2
NAC

NAC State | None

Load Balancing and Band Select

Client Load Balancing

Client Band Select

HELP  FEEDBACK

Passive Client

Passive Client

Voice

Media Session Snooping

Re-anchor Roamed Voice Clients

KTS based CAC Policy

Radius Client Profiling

~| Enabled
~| Enabled

~| Enabled

DHCP Profiling

HTTP Profiling

Off Channel Scanning Defer

Scan Defer Priority

01234567

Local Client Profiling

DHCP Profiling

HTTP Profiling

Switching 2

oooCaaac
Scan Defer Time{msecs) 100
FlexConnect
FlexConnect Local —
Enabled
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CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT

COMMANDS  HELP

FEEDBACK

WLANs WLANSs > Edit ‘voice’
- P > W R —— —,
WL General | Security | QoS | Policy A
WLANSs
PMIP Profile None
» Advanced FlexConnect Local Auth 42 Enabled
- PMIP Realm
Learn Client IP Address 5 < Enabled
Universal AP Admin Support
Vlan based Central i
Switching 12 Enabled Universal AP Admin =
Central DHCP Processing Enabled 11v BSS Transition Support
Override DNS Enabled BSS Transition O
NAT-PAT Enabled Disassociation Imminent O
Central Assoc " | Enabled Disassociation Timer(0 to 3000 TBTT) 200
Lync Optimized Roaming Disassociation Timer(0 to 40 TBTT) 40
Lync Server Disabled BSS Max Idle Service
11k Directed Multicast Service
Meighbor List " Enabled Tunneling
Neighbor List Dual Band | Enabled Tunnel Profile Mone
Assisted Roaming Prediction Optimization | Enabled EOGRE Vlan Override O
B02.11ax BSS Configuration mDNS
Down Link MU-MIMO Enabled mDNS Snooping Enabled

MONITOR  WLANs

CONTROLLER ~ WIRELESS  SECURITY

MANAGEMENT

COMMANDS HELP FEEDBACK

WLANs WLANS > Edit "voice’
P s s > - N
L General | Security | QoS | Policy-Mapping | Advanced
WLANs
B02.11ax BSS Configuration mDNS
¥ Advanced
Down Link MU-MIMO Enabled mDNS Snooping Enabled
Up Link MU-MIMO Enabled TrustSec
Down Link OFDMA Enabled Security Group Tag 0
Up Link OFDMA Enabled Umbrella

AP Groups

Umbrella Mode
Umbrella Profile
Umbrella DHCP Override

Fabric Configuration

Ignore
None

Fabric

Mobility

Enabled

Selective Reanchor

U3 Interface

| Enabled

U3 Interface

U3 Reporting Interval

" Enabled

30

AP Groups can be created to specify which WLANs / SSIDs are to be enabled and which interface they should be mapped to

as well as what RF Profile parameters should be used for the access points assigned to the AP Group.

afveln
cisco MONITOR WLANs (CONTROLLER WIRELESS
WLANs AP Groups
v WLANs
WLANs Add New AP Group

¥ Advanced AP Group Name  rtp

AP Groups Description

_Add |

Cancel
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CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT

COMMANDS HELP FEEDBACK

WLANs Ap Groups > Edit 'rtp’
oo General | WLANs | RFProfile | APs | 802.11u | Location | Ports/Module | Intelligent Capture |
WLANs
¥ Advanced Apply |
AP Groups
AP Group Name rtp

AP Group Description
NAS-ID RTPS-32A-WLC3
Enable Client Traffic QinQ ]

Enable DHCPv4 QinQ 2

QinQ Service Vian Id 12 ]

Fabric ACL Template None
CAPWAP Preferred Mode | Not-Configured
Custom Web Override-Global 13 | Enable

External Web auth URL none

NTP Auth | Enable

NTP Server None

On the WLAN:S tab, select the desired SSIDs and interfaces to map to then select Add.

CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
WLANSs Ap Groups > Edit rtp’
¥ WLANs | General | WLANs | RFProfile | APs | 802.11u | Location | Ports/Module | Intelligent Capture |
WLANs
¥ Advanced Add New
AP Groups
Add New
WLAN SSID voice(6)
Interface
/Interface rtp-9 veice 1
Group(G)
SNMP NAC State |[Enabled
Add I Cancel I

On the RF Profile tab, select the desired 802.11a or 802.11b RF Profile, then select Apply.

If changes are made after access points have joined the AP Group, then those access points will reboot once those changes are
made.

CIsSCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
WLANs Ap Groups > Edit 'rtp’
¥ WLANs | General | WLANs | RFProfile | APs | 802.11u | Location | Ports/Module | Intelligent Capture |
WLANS
¥ Advanced Apply I
AP Groups
802.11a none
802.11b | none

On the APs tab, select the desired access points then select Add APs.

Those access points will then reboot.
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CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

WLANs Ap Groups > Edit 'rtp’
¥ WLANs | General | WLANs | RFProfile | APs | 802.11u | Location | Ports/Module | Intelligent Capture |
WLANS

¥ Advanced

AP Groups APs currently in the Group

Add APs to the Group
| AP Name

Remove APs I Add APs I

| AP Name Ethernet MAC Group Name

" | rtp9-31a-apl4d
| rtp9-32a-ap20

00:B1:c4:96:78:28
00:81:c4:32:b9:b8
00:81:c4:96:74:10

| rtp9-32a-ap23

Controller Settings

Ensure the Cisco Wireless LAN Controller hostname is configured correctly.
Enable Link Aggregation (LAG) when utilizing multiple ports on the Cisco Wireless LAN Controller.
Configure the desired AP multicast mode.

CISCO MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
Controller General
General Name RTP9-32A-WLC3
Ecana 802.3x Flow Control Made Disabled
Inventory LAG Mode on next reboot Enabled
Interfaces Broadcast Forwarding Disabled

Interface Groups AP Multicast Mode L Multicast 239.1.1.9 Multicast Group Address

Multicast AP IPv6 Multicast Mode L Multicast [ ffie::239:100:100:21 IPV6 Multicast Group Address
» Network Routes AP Fallback Enabled
» Fabric Configuration CAPWAP Preferred Made ipva
* Redundancy Fast SSID change Enabled
» Mobility Management  |ink Local Bridging Disabled
Ports Default Mobility Domain Name CTG-VaWLAN2
b NTP RF Group Name RTP9-VoWLANZ
b CDP User Idle Timeout (seconds) 300
¥ PMIPv6 ARP Timeout (seconds) 300
b Tunneling ARP Unicast Made Disabled
. i "
» IPVE Web Radius Authentication PAP
Operating Environment Commercial (10 to 35 C
» mDNs perating ¢ )
Internal Temp Alarm Limits 10to 3B8C
¥ Advanced
‘WebaAuth Proxy Redirection Mode Disabled
Lawful Interception
‘WebaAuth Proxy Redirection Port o
Captive Network Assistant Bypass Disabled
Global IPv6 Config Disabled
Web Color Theme 2 Default
HA SKU secondary unit Disabled

Nas-Id

HTTP Prefiling Port

DNS Server IP(Ipv4/Ipvb)
HTTP-Proxy Ip Address(Ipv4/Ipve)

WGE Vlan Client

1. Muiticast is not supperted with FlexConnect on this platform. Multicast-Unicast mode does not support IGMP/MLD Snooping. Disable Global Multicast first.

RTP9-32A-WLC3
80
171.70.168.183
0.0.0.0

Disabled

2.Changes in Web color Theme will get updated after browser Refresh.
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CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Controller Multicast
General
T Enable Global Multicast Mode
Inventory Enable IGMP Snooping
Interfaces IGMP Timeout (30-7200 seconds) 60
Interface Groups IGMP Query Interval (15-2400 seconds) 20
Multicast Enable MLD Snooping ]

¥ Network Routes MLD Timeout (30-7200 seconds)

¥ Fabric Configuration MLD Query Interval (15-2400 seconds)

» Redundancy

¥ Mobility Management

Ports Foot Notes
P NTP Changing Global Multicast configuration parameters removes configured Multicast VLAN from WLAN.
» CDP

When utilizing layer 3 mobility, Symmetric Mobility Tunneling should be Enabled.
In the recent versions, Symmetric Mobility Tunneling is enabled by default and non-configurable.

CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
Controller Mobility Anchor Config
General Keep Alive Count 3
Icons Keep Alive Interval (1-30 seconds) 10
Inventory Symmetric Mobility Tunneling mede Enabled
Interfaces DSCP Value 0

Interface Groups

Multicast

-

Network Routes

-

Fabric Configuration

-

Redundancy

¥ Mobility Management
Mobility Groups
Mobility Anchor Config
Multicast Messaging

When multiple Cisco Wireless LAN Controllers are part of the same mobility group, ensure to add the IP address and MAC
address of each Cisco Wireless LAN Controller to the Static Mobility Group Members configuration.

alialn
CIsco

MONITOR WILANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Controller Static Mobility Group Members
General
Local Mobility Group CTG-VoWLAN2
Icons
Inventory 1P
Interfaces MAC Address Address(Ipvd/Ipv6) Group Name Multicast IP Status

00:5d:73:1a:c3:49 10.B1.6.70 CTG-VoWLANZ 0.0.0.0 Up
Interface Groups

Multicast

-

Network Routes

-

Fabric Configuration

-

Redundancy

~ Mobility Management
Mability Groups
Maobility Anchor Config
Multicast Messaging

Call Admission Control (CAC)
Admission Control Mandatory for Voice and Video should be disabled.
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802.11a(5 GHz) > Media

Voice | Video | Media |

Call Admission Control (CAC)

Admission Control (ACM) [ Enabled
CAC Method 2 Load Based v
Max RF Bandwidth (5-85)(%) 85

Reserved Roaming Bandwidth (0-25)(%) 5

Expedited bandwidth

SIP CAC Support 2 Enabled

Per-Call SIP Bandwidth 2

SIP Codec G.711 v
SIP Bandwidth (kbps) 64
SIP Voice Sample Interval (msecs) 20 v

Traffic Stream Metrics

Metrics Collection

CISCO MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
Wireless 802.11a(5 GHz) > Media
¥ Access Points 6 I ¥ i
Voice Video Media
All APs 4 I |
¥ Radios
Global Configuration
Call Admission Control (CAC)
¥ Advanced
Admission Control (ACM) | Enabled
Mesh
CAC Method 4 Static ¢
¥ AP Group NTP
Max RF Bandwidth (5-85)(%)
» ATF
Reserved Roaming Bandwidth (0-25)(%)
RF Profiles
SIP CAC Support 2 Enabled
FlexConnect Groups
» FlexConnect ACLs
FlexConnect VLAN
Templates
Network Lists
¥ 802.11a/n/ac/ax
Network
= RRM
RF Grouping
TPC
DCA
Coverage
General
Client Roaming
Media
EDCA Parameters Foot Notes
DFS (802.11h)
High Throughput 1 11a rates(Kbps): 6000,9000,12000,18000,24000,36000,48000,54000
(802.11n/ac/ax) 11n rates(Kbps): 65000,72200,130000,144400,135000,150000,270000,300000
CleanAir 2 5IP CAC should only be used for phones that support status code 17 and do not support TSPEC-based admission control.
3 5IP CAC will be supported only if SIP snooping is enabled.
b 802.11b/g/n/fax 4 Static CAC method is radio based and load-based CAC method is channel based.

In the Media settings, Unicast Video Redirect and Multicast Direct Enable should be enabled.

Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide



MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Wireless 802.11a(5 GHz) > Media
¥ Access Points | Voice | Video | Media |
All APs
* Radios
Global Configuration
General
» Advanced
Unicast Video Redirect
Mesh
» AP Group NTP Multicast Direct Admission Control
b ATF Maximum Media Bandwidth {0-85(%)) 85
RF Profiles Client Minimum Phy Rate 1 6000
FlexConnect Groups Maximum Retry Percent (0-100%) B0

¥ FlexConnect ACLs

FlexConnect VLAN

Templates
P Media Stream - Multicast Direct Parameters
Network Lists
Multicast Direct Enable
* 802.11a/n/fac/fax —
N Max Streams per Radio MNo-limit
= RRM Max Streams per Client MNo-limit
RF Grouping -
TPC Best Effort QoS Admission Enabled
DCA
Coverage
General
Client Roaming
Media
EDCA Parameters Foot Notes
DFS (802.11h)
High Throughput 1 11a rates(Kbps): 6000,9000,12000,18000,24000,36000,48000,54000
(802.11n/ac/ax) 11n rates(Kbps): 65000,72200,130000, 144400, 135000,150000,270000,300000
CleanAir 2 5IP CAC should only be used for phones that support status code 17 and do not suppart TSPEC-based admission control.
3 SIP CAC will be supported only if SIP snooping is enabled.
13 802.11b/g/n/fax 4 Static CAC method is radio based and load-based CAC method is channel based.

RF Profiles

RF Profiles can be created to specify the frequency bands, data rates, RRM settings, etc. that a group of access points should
use.

For the SSID used by the Cisco Desk Phone 9800 Series, it’s recommended to apply it to 5 GHz radios only.

RF Profiles are applied to an AP group once created.

When creating an RF Profile, the RF Profile Name and Radio Policy must be defined.

Select 802.11a or 802.11b/g for the Radio Policy.

CISCO MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Wireless RF Profile > New
¥ Access Points RF Profile Name rtp-5

All APs

- el Radio Palicy 802.11a

Global Configuration Use default RF Profile Template = None
¥ Advanced

Mesh

¥ AP Group NTP
b ATF

RF Profiles

On the 802.11 tab, configure the data rates as desired.

It is recommended to enable 12 Mbps as Mandatory and 18 Mbps and higher as Supported. However, some environments
may require 6 Mbps to be enabled as a mandatory (basic) rate.
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CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Wireless RF Profile > Edit 'rtp-5
LR RO General | 802.11 | RRM | HighDensity | Client Distribution |
All APs
* Radios
Global Configuration 1
Data Rates! MCS Settings
¥ Advanced
Mesh 6 Mbps | Disabled 0 Supported
> AP Group NTP 9 Mbps Disabled 1 Supported
» ATF 12 Mbps | Mandatory 2 Supported
RF Profiles 18 Mbps | Supported 3 Supported
A
FlexConnect Groups 24 Mbps | Supported 4 Supported
} FlexConnect ACLs 36 Mbps = Supported 5 Supported
2
FlexConnect VLAN 48 Mbps | Supported 6 Supported
Templates 54 Mbps | Supported 7 Supported
Network Lists B Supported
b 802.11a/n/ac/ax 9 Supported
b 802.11b/g/n/ax 10 Supported
} Media Stream 11 Supported
Application Vi 120Kt ppnried
And Control 13 Supported
Lync Server 14 Supported
Country 15 Supported
Timers 16 Supported
¥ Netflow —_

} QoS

On the RRM tab, the Maximum Power Level Assignment and Minimum Power Level Assignment settings as well as other
DCA, TPC, and Coverage Hole Detection settings can be configured.

MONITOR ~ WLANs ~ COl LLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
Wireless RF Profile > Edit 'rtp-5'
(S Access Foints General | 802.11 | RRM | High Density | Client Distribution |

All APs

* Radios
Global Canfiguration
TPC Coverage Hole Detection

» Advanced

Mesh Maximum Power Level Assignment (-10 to 30 dBm) 30 Data RSSI(-90 to -60 dBm) -80
¥ AP Group NTP Minimum Power Level Assignment (-10 to 30 dBm) -10 Voice RSSI(-90 to -60 dBm) -80
b ATF Power Threshold v1(-80 to -50 dBm) -70 Coverage Exception(0 to 100 %) 25

RF Profiles Power Threshold v2(-80 to -50 dBm) -67 Coverage Level(1 to 200 Clients) 3

FlexConnect Groups DCA Profile Threshold For Traps

-

FlexConnect ACLs

Avoid Foreign AP interference Enabled Interference (0 to 100%) 10
RISCoRnactVESY Channel Width () 20 MHz @) 40 MHz () 80 MH: 160 MHz () 80+80 MHz () Best Clients (1 to 200, 12
Templates annel Wi iz iz iz iz z () Best ients (1 to 200)
Network Lists Noise (127 to 0 dBm) 70
} 802.11a/n/ac/ax utilization (0 to 100 %) 80
¥ 802.11b/g/n/ax Client Network Preference
} Media Stream ") Connectivity _ Throughput () Automatic
, Application Visibility
And Control Client Aware
Lync Server “Enable  (@Disable
Country High-Speed Roam
Timers HSR mode | Enabled
» Netflow
» QoS
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CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Wireless RF Profile > Edit 'rip-5'
™ Access Points | General | 802.11 | RRM | HighDensity | Client Distribution |
L3 :!;::: Client Aware

Global Configuration “Enable  {@Disable

Advanced High-Speed Roam

Mesh

HSR mode T Enabled
¥ AP Group NTP
Neighbor Timeout Factor

b ATF

RF Profiles DCA Channel List

T 36, 40, 44, 48, 52, 56, 60, 64, 149, 153,
} FlexConnect ACLs 157, 161

FlexConnect VLAN RS

Templates

Network Lists y
» 802.11a/n/ac/ax

Select  Channel
b 802.11b/g/n/ax
/a/n/ 6

b Media Stream 0
) Application Visibility 44

And Control -

Lync Server 52

Country - =

Timers Extended UNIL-2 channels (| Enabled
¥ Netflow
b Qos

On the High Density tab, Maximum Clients, Multicast Data Rates, and Rx Sop Threshold can be configured.
It is recommended to use the default value for Rx Sop Threshold.

CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Wireless RF Profile > Edit 'rtp-5'
¥ Access Points | General | 802.11 T RRM | High Density | Client Distribution |

All APs

* Radios

Global Configuration

High Density Parameters Multicast Parameters

¥ Advanced

Mesh Maximum Clients(1 to 200) 200 Multicast Data RatesZ = auto

» AP Group NTP
Rx Sop Threshold Parameters®

¥ ATF

Rx Sop ~ ]
RF Profiles Threshold Default Custom

FlexConnect Groups
All access points configured for FlexConnect mode need to be added to a FlexConnect Group.

When utilizing 802.11r (FT), seamless roaming can only occur when roaming to access points within the same FlexContext
Group.

CISCO MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Wireless FlexConnect Groups > New

¥ Access Points
All APs
* Radios
Global Configuration

Group Name rip-1

» Advanced
Mesh
» AP Group NTP
b ATF
RF Profiles

FlexConnect Groups
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Cisco

Wireless

¥ Access Points
All APs
¥ Radios
Global Configuration

» Advanced
Mesh
¥ AP Group NTP
b ATF
RF Profiles
FlexConnect Groups
P FlexConnect ACLs

FlexConnect VLAN
Templates

Network Lists
b BO2.11a/n/ac/ax
b B802.11b/g/nfax
} Media Stream
» Application Visibility
And Control
Lync Server
Country
Timers
b Netflow

} Qos

The maximum number of access points allowed per FlexConnect Group is limited, which is WLC model specific.

Cisco

Wireless

¥ Access Points
All APs
* Radios
Global Configuration

¥ Advanced

Mesh

-

AP Group NTP

-

ATF
RF Profiles
FlexConnect Groups

Wireless

¥ Access Points
All APs
¥ Radios
Global Configuration

-

Advanced

Mesh

-

AP Group NTP
» ATF
RF Profiles

FlexConnect Groups

Multicast Direct

MONITOR WLANs CONTROLLER WIRELESS

FlexConnect Groups > Edit ‘rip-1'

SECURITY MANAGEMENT COMMANDS

HELP

EEEDBACK

'|L|:|l:al‘L

>
| Image Upgr

DHCP | WLAN VLAN mapping | WLAN AVC mapping |

Group Name rtp-1

none

Enable AP Local Authentication2 |

WVLAN Template Name

FlexConnect AP

HTTP-Proxy

Ip Address(Ipv4/Ipv6)

Port 0

AAA

Server Ip Address

Server Type Primary
Shared Secret

Confirm Shared Secret

Port Number 1812

_Add |

<)

MONITOR WLANs CONTROLLER WIRELESS SECURITY

FlexConnect Group AP List

MANAGEMENT COMMANDS

HELP

FEEDBACK

Group Name rtp-1
FlexConnect APs
Add AP
Entries 0 - 0 of 0
AP MAC Address AP Name Status AP Mode Type Conflict with PnP

MONITOR  WLANs CONTROLLER  WIRELESS

FlexConnect Group AP List

SECURITY

MANAGEMENT COMMANDS

HELP

EEEDBACK

Group Name rtp-1
FlexConnect APs
Add AP
Select APs from current controller
Ethernet MAC
Add Cancel

In the Media Stream settings, Multicast Direct feature should be enabled.
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Cisco

Wireless

~ Access Points
All APs
* Radios
Global Configuration

¥ Advanced
Mesh
¥ AP Group NTP
» ATF
RF Profiles
FlexConnect Groups
¥ FlexConnect ACLs

FlexConnect VLAN
Templates

Network Lists
b 802.11a/nfac/ax
» B02.11b/g/nfax

¥ Media Stream
General
Streams

Cisco

Wireless

¥ Access Points
All APs
» Radios
Global Configuration

b Advanced
Mesh
» AP Group NTP
b ATF
RF Profiles
FlexConnect Groups
F FlexConnect ACLs

FlexConnect VLAN
Templates

Network Lists
b 802.11a/n/ac/ax
b 802.11b/g/n/fax

¥ Media Stream
General
Streams

MONITOR WLANs CONTROLLER WIRELESS

Media Stream >General

SECURITY

MANAGEMENT

MONITOR  WLANs

Multicast Direct feature Enabled
Session Message Config
Session announcement State ("] Enabled

Session announcement URL
Session announcement Email

Session announcement Phone

Session announcement Note

CONTROLLER WIRELESS  SECURITY

Media Streams

Stream Name

10.195.19.27

MANAGEMENT

Start IP Address(Ipv4/Ipv6) End IP Address(Ipv4/Ipv6) Operation Status

239.1.1.1

COMMANDS

HELP

COMMANDS

FEEDBACK

Entries 1 -1 of 1

239.1.1.1

HELP

FEEDBACK

Multicast Direct

After Multicast Direct feature is enabled, there will be an option to enable Multicast Direct in the QoS menu of the WLAN

configuration.
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Cisco
WLANs

¥ WLANs
WLANs

¥ Advanced

QoS Profiles

MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS  HELP

WLANSs > Edit ‘voice’

| General T Security \| QoS "|r Policy-Mapping T Advanced |

FEEDBACK

Override Per-SSID Bandwidth Contracts (kbps) &

DownStream UpStream

Average Data Rate o o
Burst Data Rate o 1]
Average Real-Time Rate 0 0
Burst Real-Time Rate 0 0
Clear
WMM

WMM Policy Required
7920 AP CAC Enabled

7920 Client CAC | Enabled

Media Stream

Multicast Direct Enabled
Lync Policy
Audio Silver

Configure the four QoS profiles (Platinum, Gold, Silver, Bronze), by selecting 802.1p as the protocol type and set the 8§02.1p

tag for each profile.
e Platinum = 5
* Gold=4
* Silver=2
* Bronze=1

Wireless

* Access Points
All APs
¥ Radios
Global Configuration

-

Advanced

Mesh

-

AP Group NTP
b ATF
RF Profiles

FlexConnect Groups

-

FlexConnect ACLs

FlexConnect VLAN
Templates

Network Lists

-

802.11a/nfac/ax

—

B802.11b/g/n/ax

-

Media Stream

Application Visibility
And Control

-

Lync Server
Country

Timers

-

Netflow

¥ QoS
Profiles
Roles
Qos Map

MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Edit QoS Profile

QoS Profile Name  Platinum

Description For Voice Applications

Per-User Bandwidth Contracts (kbps) *

DownStream  UpStream

Average Data Rate 0 0
Burst Data Rate 0 0
Average Real-Time Rate 0 0
Burst Real-Time Rate 0 0

Per-SSID Bandwidth Contracts (kbps) *

DownStream  UpStream

Average Data Rate 0 0
Burst Data Rate 0 0
Average Real-Time Rate 0 0
Burst Real-Time Rate 0 0

WLAN QoS Parameters
Maximum Priority vaoice

Unicast Default Priority besteffort

Multicast Default Priority besteffort

Wired QoS Protocol
Protocol Type 802.1p

802.1p Tag 5
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Wireless

* Access Points
All APs
¥ Radios
Global Configuration

A4

Advanced

Mesh

-

AP Group NTP
b ATF
RF Profiles

FlexConnect Groups

-

FlexConnect ACLs

FlexConnect VLAN
Templates

Network Lists

v

802.11a/n/ac/ax

v

802.11b/g/n/fax

v

Media Stream

Application Visibility
And Control

A4

Lync Server
Country
Timers

» Netflow

* QoS
Profiles

Roles
Qos Map

cisco

Wireless

¥ Access Points
All APs
* Radios
Global Configuration

-

Advanced

Mesh

-

AP Group NTP
b ATF
RF Profiles

FlexConnect Groups

-

FlexConnect ACLs

FlexConnect VLAN
Templates

Network Lists

-

802.11a/n/fac/ax

-

802.11b/g/n/ax

v

Media Stream

Application Visibility
And Control

-

Lync Server
Country
Timers

Netflow

-

¥ QoS
Profiles
Roles
Qos Map

MONITOR  WLANs CONTROLLER WIRELESS

Edit QoS Profile

QoS Profile Name 994
Description Far Video Applications

Per-User Bandwidth Contracts (kbps) *

SECURITY MANAGEMENT

DownStream UpStream

Average Data Rate 1} 0
Burst Data Rate o 0
Average Real-Time Rate 1] 0
Burst Real-Time Rate 0 0

Per-SSID Bandwidth Contracts (kbps) *

DownStream UpStream

Average Data Rate o 0
Burst Data Rate o 0
Average Real-Time Rate o 0
Burst Real-Time Rate 0 0

WLAN QoS Parameters

Maximum Priority video
Unicast Default Priority video >
Multicast Default Priority video

Wired QoS Protocol

Protocol Type

802.1p

802.1p Tag 4

MONITOR WLANs CONTROLLER WIRELESS

Edit QoS Profile

QoS Profile Name  Sver
Description Far Best Effort

Per-User Bandwidth Contracts (kbps) *

SECURITY MANAGEMENT

DownStream UpStream

Average Data Rate ] i}
Burst Data Rate o o
Average Real-Time Rate v] 1]
Burst Real-Time Rate 0 0

Per-SSID Bandwidth Contracts (kbps) *

DownStream UpStream

Average Data Rate 0 0
Burst Data Rate o o
Average Real-Time Rate 1] 1]
Burst Real-Time Rate ] 0

WLAN QoS Parameters

Maximum Priority besteffort
Unicast Default Priority besteffort
Multicast Default Priority besteffort

Wired QoS Protocol
Protocel Type 802.1p

802.1p Tag 0
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MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Wireless Edit QoS Profile
¥ Access Points
All APs QoS Profile Name  bronze
* Radios
Global Configuration Description For Background

» Advanced
ey Per-User Bandwidth Contracts (kbps) *
es|

DownStream UpStream
¥ AP Group NTP

Average Data Rate 0 0
F ATF
Burst Data Rate o o
RF Profiles
Average Real-Time Rate 1] 1]
FlexConnect Groups
Burst Real-Time Rate o o

» FlexConnect ACLs
FlexConnect VLAN Per-SSID Bandwidth Contracts (kbps) *

Templates DownStream UpStream
Network Lists Average Data Rate 0 0
b B02.11a/n/ac/ax Burst Data Rate 0 0
» B02.11b/g/n/fax Average Real-Time Rate 0 0
¥ Media Stream Burst Real-Time Rate ] 0
» Application Visibility
And Control WLAN QoS Parameters
Lync Server Maximum Priority background
Country Unicast Default Priority background
Timers Multicast Default Priority background
L BT Wired QoS Protocol
¥ Qos Protacol Type 802.1p
Profiles
Roles B802.1p Tag 1
Qos Map

Advanced Settings

Advanced EAP Settings

All EAP parameters, except for the EAP-Broadcast Key Interval, can be configured at the SSID level or at the global level.
EAP-Broadcast Key Interval can only be configured at the global level.
To view or configure the EAP parameters, select Security > Advanced EAP.

alvaln

MONITOR  WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK

Security Advanced EAP
v AAA Identity Request Timeout {in secs) 30
General
» RADIUS Identity request Max Retries 2
¥ TACACS+ Dynamic WEP Key Index (1]
LDAP . .
Local Net Users Request Timeout (in secs) 30
MAC Filtering Request Max Retries 2

w Disabled Clients
User Login Policies

AP Policies EAPOL-Key Timeout {in milliSeconds) 400
Password Policies

Max-Lagin Ignore Identity Response enable

EAPOL-Key Max Retries 4

» Local EAP
EAP-Broadcast Key Interval{in secs) 3600

Advanced EAP

To view the EAP parameters on the Cisco Wireless LAN Controller via command line, enter the following command.

(Cisco Controller) >show advanced eap
EAP-Identity-Request Timeout (seconds)........... 30
EAP-Identity-Request Max Retries................. 2

EAP Key-Index for Dynamic WEP.................... 0

EAP Max-Login Ignore Identity Response........... enable
EAP-Request Timeout (seconds).................... 30
EAP-Request Max Retries.......c.c.ccoueceeuennee 2
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EAPOL-Key Timeout (milliseconds)...................... 400

EAPOL-Key Max Retries..........ccocevveruenenne. 4

EAP-Broadcast Key Interval....................... 3600
When using 802.1x, the EAP-Request Timeout on the Cisco Wireless LAN Controller should be set to at least 20 seconds.
In later versions of Cisco Wireless LAN Controller software, the default EAP-Request Timeout was changed from 2 to 30
seconds.
For deployments with frequent EAP failures, the EAP-Request Timeout should be reduced to below 30 seconds.
To change the EAP-Request Timeout on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter the
following command.

(Cisco Controller) >config advanced eap request-timeout 30

When using PSK, it is recommended to reduce the EAPOL-Key Timeout to 400 milliseconds from the default of 1000
milliseconds and set EAPOL-Key Max Retries to 4 from the default of 2.
When using 802.1x, the default values for EAPOL-Key Timeout and EAPOL-Key Max Retries should work fine, but it’s
still recommended to set those values to 400 and 4 respectively.
The EAPOL-Key Timeout should not exceed 1000 milliseconds (1 second).
To change the EAPOL-Key Timeout on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter the
following command.

(Cisco Controller) >config advanced eap eapol-key-timeout 400

To change the EAPOL-Key Max Retries on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter the
following command.
(Cisco Controller) >config advanced eap eapol-key-retries 4

Ensure EAP-Broadcast Key Interval is set to a minimum of 3600 seconds (1 hour).
To change the EAP-Broadcast Key Interval on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter
the following command.

(Cisco Controller) >config advanced eap bcast-key-interval 3600

Auto-lmmune

The Auto-Immune feature can be enabled optionally for protection against denial of service (DoS) attacks.
However, enabling this feature may introduce interruptions with voice over wireless LAN. Therefore, it is recommended to
disable the Auto-Immune feature on the Cisco Wireless LAN Controller.
To view the Auto-Immune configuration on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter the
following command.

(Cisco Controller) >show wps summary

Auto-Immune

Auto-Immune..........cccoeevvrevieeeneeennnn. Disabled
Client Exclusion Policy
Excessive 802.11-association failures.......... Enabled
Excessive 802.11-authentication failures....... Enabled
Excessive 802.1x-authentication................ Enabled
IP-theft........covieiieiieie Enabled
Excessive Web authentication failure........... Enabled
Signature Policy
Signature Processing..........c.ceevvenneene. Enabled

To disable the Auto-Immune feature on the Cisco Wireless LAN Controller, telnet or SSH to the controller and enter the
following command.
(Cisco Controller) >config wps auto-immune disable
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Rogue Policies

It is recommended to use the default value (Disable) for Rogue Location Discovery Protocol.

Cisco Catalyst IOS XE Wireless LAN Controller and Lightweight Access Points

When configuring the Cisco Wireless LAN Controller and Lightweight Access Points, use the following guidelines:

CISCO MONITOR WLANs CONTROLLER WIRELESS SECURITY MANAGEMENT COMMANDS HELP FEEDBACK
Security Rogue Policies
¥ AAA
General Rogue Detection Security Level Low High Critical
* RADIUS Rogue Location Di Protocol Disabl
e ogue Location Discovery Protocal isable >
LDAP Expiration Timeout for Rogue AP and Rogue Client entries 1200 Seconds
Local Net Users B
MAC Filtering Validate rogue clients against AAA Enabled
¥ Disabled Clients Validate rogue AP against AAA “|Enabled
User Login Policies
AP Policies Polling Interval o Seconds
Passwiard Policies Validate rogue clients against MSE ~|Enabled
¥ Local EAP
Detect and report Ad-Hoc Networks EEnabled
Advanced EAP
Rogue Detection Report Interval (10 to 300 Sec) 10
¥ Priority Order
Rogue Detection Minimum RSSI (-70 to -128) -90
¥ Certificate
Rogue Detection Transient Interval (0, 120 to 1800 Sec) 0
» Access Control Lists
Rogue Client Threshold {0 to disable, 1 ko 256) o
-~ Wireless Protection . -
Policies Rogue containment automatic rate selection Enabled
= Rogue Policies
General Auto Contain
Rogue Rules
Friendly Rogue Auto Containment Level 1
SRR A Auto Containment only for Monitor mode APs _|Enabled
Custom Signatures
Signature Events Auto Containment on FlexConnect Standalone ~|Enabled
Summary -
Client Exclusion Policies Regue on Wire Enabled
CILI TR Using our SSID ~|Enabled
Management Frame
Protection Valid client on Rogue AP “|Enabled
¥ Web Auth AdHoc Rogue AP ~IEnabled
» TrustSec

Local Policies

\d

Umbrella

v

Advanced

Enable 802.11r (FT)
CCKM is Disabled.
Set Quality of Service (QoS) SSID Policy to Platinum
Set the WMM Policy to Required
Ensure Session Timeout is enabled and configured correctly
Ensure Broadcast Key Interval is enabled and configured correctly
Ensure Aironet IE is Disabled

Disable P2P (Peer to Peer) Blocking Action
Ensure Client Exclusion Timeout is configured correctly
Disable DHCP Required

Set Protected Management Frame (PMF) to Optional or Required for WPA3
Set the DTIM Period to 2

Set Load Balance to Disabled

Set Band Select to Disabled

Set IGMP Snooping to Enabled

Configure the Data Rates as necessary

Configure RRM as necessary

Set EDCA Profile to Voice Optimized or Voice and Video Optimized

Ensure that Power Constraint is Disabled

Enable Channel Switch Status and Smart DFS
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¢ Set Channel Switch Announcement Mode to Quiet

*  Configure the High Throughput data rates as necessary
* Enable CleanAir

*  Enable Multicast Direct Enable

802.11 Network Settings

It is recommended to operate the Cisco Desk Phone 9800 Series only on the 5 GHz band due to the availability of many
channels and fewer interferers compared to the 2.4 GHz band.

To use 5 GHz, ensure the 5 GHz Network Status is Enabled.

Set the Beacon Period to 100 ms.

It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps and higher as supported (optional) rates.
However some environments may require 6 Mbps to be enabled as a mandatory (basic) rate.

@ .l Cisco Catalyst 9800-40 Wireless Controller ~ Welcomeapna | # ® B # @ @ T Q =
161225
= Configuration ~ > Radio Configurations~ > Network
ﬂ:ﬁl Dashboard 5 GHz Band 2.4 GHz Band
@ Monitoring General
L Configuration 5 GHz Network Status v
Administration A Please disable 5 GHz Network Status to configure Beacon
Interval, Fragmentation Threshold, DTPC Support
Troubleshooting
Beacon Interval* 100
Fragmentation 2346

Threshold(bytes)*

DTPC Support o

CCX Location Measurement

Mode

Data Rates

A Please disable 5 GHz Network Status to configure Data
Rates

6 Disabled 9 Disabled v12 Mandatory v
Mbps Mbps Mbps

18 Supported 24 Supported +36 Supported -
Mbps Mbps Mbps

A8 Supported 54 Supported v

Mbps Mbps

To use 2.4 GHz, ensure the 2.4 GHz Network Status and 802.11g Network Status are Enabled.

Set the Beacon Period to 100 ms.

Short Preamble should be Enabled in the 2.4 GHz radio configuration setting on the access point when there’s no legacy
clients requiring a long preamble in the wireless LAN. By using the short preamble instead of long preamble, the wireless
network performance is improved.

It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps and higher as supported (optional) rates assuming
that there will not be any 802.11b only clients that will connect to the wireless LAN. However, some environments may
require 6 Mbps to be enabled as a mandatory (basic) rate.

If 802.11b clients exist, then 11 Mbps should be set as the mandatory (basic) rate and 12 Mbps and higher as supported
(optional).
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c[r'scic', Cisco Catalyst 9800-40 Wireless Controller Welcomeaphza | & T B # A @ & Q [C 2
16122

Configuration * > Radio Configurations* > Network
Dashboard 5 GHz Band 2.4 GHz Band

Monitoring 5 General
2.4 GHz Network Status

A Please disable 2.4 GHz Network Status to configure
B02.11g Network Status, Beacon Interval, Short Preamble,
Fragmantation Threshold, DTPC Support.

802.11g Network Status v
Beacon Interval® 100
Short Preamble

Fragmentation 2346
Thresheld{bytes)* i

DTPC Support

CCX Location Measurement

Maode v

Interval® 60

Data Rates

£ Please disable 2.4 GHz Network Status to configure Data

Rates
1 Disabled v |2 Disabled » |55 Disabled
Mbps Mbps Mbps
B Disabled v |9 Disaed w11 Disabled v
Mbps Mbps Mbps
12 Mandatary 4 (18 Supported 4 |24 Supported
Mbps Mbps Mbps
36 Supported 4 | 48 Supported o |54 Supported
Mbps Mbps Mbps

High Throughput (802.11n/ac)

The 802.11n data rates can be configured per radio (2.4 GHz and 5 GHz).

802.11ac data rates are applicable to 5 GHz only.

Ensure that WMM is enabled and WPA2/WPA3(AES) is configured to utilize 802.11n/ac data rates.

The Cisco Desk Phone 9800 Series supports HT MCS 0 —MCS 7 and VHT MCS 0 — MCS 9 1SS data rates only, but higher
MCS rates can be enabled optionally if there are other 802.11n/ac clients utilizing the same band frequency that include
MIMO antenna technology, which can take advantage of those higher data rates.
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il Cisco Catalyst 9800-40 Wireless Controller  Welcome aphs | & % B & ™ @ & Q cd
16.12.2s

Configuration - > Radio Configurations -~ > High Throughput

Dashboard 5 GHz Band 2.4 GHz Band

Z) Menitoring

Configuration v

11n

Administration rabEsnn o SelectAll [

TrOUbIEShQOting MCS/(Data Rate) MCS/{Data Rate) MCS/(Data Rate) MCS/(Data Rate)
0/(7Mbps) Al(14Mbps) J2/(21Mbps) -3/(29Mbps)
~4/(43Mbps) 5/(58Mbps) 6/(65Mbps) J7/(72Mbps)
~8/(14Mbps) 9/(29Mbps) A0/(43Mbps) 11/(58Mbps)
A2/(87Mbps) A3/(116Mbps) A4/(130Mbps) 15/{144Mbps)
16/(22Mbps) A7/(43Mbps) 8/(65Mbps) 19/(87Mbps)
20/(130Mbps) 21/(173Mbps) ~22/(195Mbps) +23/(217Mbps)
24/(29Mbps) 25/(58Mbps) 26/(B7Mbps) 27/(116Mbps)
.28/(173Mbps) .29/(231Mbps) .30/(260Mbps) .31/(289Mbps)

¥ 11ac

A The Data rates are for 20MHz channels and Short Guard
Interval

Enable Itac Select All v

SS/MCS S5/MCS SS/MCS SS/MCS
A/8/(86.7Mbps) | 119/(nfa) | 2/8/(173.3Mbps) | 2/9/(n/a)
3/8/(260.0Mbps) | 3/9/(288.9Mbps) | 4/8/(346.7Mbps) | 4/9/(n/a)
¥ 11ax
Enable 11ax |« Select All v
Multiple Bssid
SS/MCS SS/MCS S8S/MCS

Af7 | 119 v 1111 |27
219 |2/ v |37 v13/9
Am v 417 v | 4[9 v |41
BI7 ~|5/9 |81 | 6/7
6/9 v16/11 Mari v 719
JM |87 ~|BI9 ~8M

Parameters

In the EDCA Parameters section, set the EDCA profile to Optimized-voice or Optimized-video-voice for either 5 or 2.4 GHz
depending on which frequency band is to be utilized.

In the DFS (802.11h) section, Power Constraint should be left un-configured or set to 0 dB.

Channel Switch Status and Smart DFS should be Enabled.

Channel Switch Announcement Mode should be set to Quiet.
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B .l Cisco Catalyst 9800-40 Wireless Controller
122

Dashboard

Monitoring

L, Configuration

'} Administration

Troubleshooting

RRM

Configuration - > Radio Configurations - » Parameters

5 GHz Band 2.4 GHz Band
EDCA Parameters
EDCA Profile optimized-video-v... v

DFS (802.11h)

A DTPC Suppo
MNetwork te

Power Constraint* o
Channel Switch
Status

Channal Switch Quiet v
Announcement

Smart DFS

Welcome alpha

# ©

Bemec

It is recommended to enable automatic assignment method to manage the channel and transmit power settings.
Configure the access point transmit power level assignment method for either 5 or 2.4 GHz depending on which frequency

band is to be utilized.

When using automatic power level assignment, a maximum and minimum power level can be specified.

alaln
CiIsco

Dashboard
Monitoring
Configuration

{0} Administration

Troubleshooting

When using 5 GHz, it’s recommended to limit the number of channels (e.g. 12 channels only) to avoid any potential delay in

Cisco Catalyst 9800-40 Wireless Controller

Configuration= > Radio Configurations - > RRM

5 GHz Band 2.4 GHz Band FRA
General Coverage DCA TPC
Power Assignment Method
© Automatic
On Demand
Fixed

Max Power Leved Assignmes 17

Min Power Level Assignmen 17

Pawer Threshold* -70

access point discovery caused by scanning many channels.

Welcome alpha

RF Grouping

#

* R &meo

Power Assignment
Leader

Transmit Power Update
Interval

Last Run;

Power Naeighbor Count:

(% Q =

RCDMNG=-21A=WLGS (10.201.51.9)

600 second(s)

365 second(s) ago
3

The 5 GHz channel width can be configured as 20 MHz or 40 MHz for using Cisco 802.11n Access Points and as 20 MHz, 40
MHz, or 80 MHz for using Cisco 802.11ac Access Points.
It is recommended to utilize the same channel width for all access points.
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B .l Gisco Catalyst 9800-40 Wireless Controller Welcome aphs | # W B # W @ T
2o

Configuration* > Radio Configurations~ > RRM

5 GHz Band 2.4 GHz Band FRA

Monitoring 5 General Coverage DCA TPC RF Grouping
Configuration
Dynamic Channel Assignment Algorithm
Administration
Channel Assignment Mode © Automatic
Troubleshooting
) Freeze
- off
Interval 10 minutes
Anchortime 0 v
Avoid Foreign AP Interference .

Avoid Cisco AP load

Avoid Non 5 GHz Noise

Avoid Persistent Non-wifi

Interference
Channel Assignment Leader RCDNB-21A-WLCS (10.201.81.8)

Lest Auto Channel Assignment 475 second(s) ago

DCA Channel Sensitivity medium v

Channel Width 20MHz ©40MHz O BOMHz O 160MHz O Best

Auto-RF Channel List

7| [+ 7| [+ s v
36 40 44 48 52 56 60 64 100104 108112116120124 128132136

140144 149 153157 161 165

Event Driven RRM

EDRRM

When using 2.4 GHz, only channels 1, 6, and 11 should be enabled in the channel list.

B .l Cisco Catalyst 9800-40 Wireless Controller Weicomesipha | # B B # 8 @ &
Configuration* > Radio Configurations * > RRM
5 GHz Band 2.4 GHz Band FRA

General Coverage DCA TPC RF Grouping

Configuration
Channel Algorith
Administration
Channel Assignment Mode © Automatic
") Freeze
- Off
Interval 10minutes v |
Anchortime 0 |
Avoid Foreign AP Interference “

Avoid Cisco AP load

Avoid Non 5 GHz Noise

Avoid Persistent Non-wifi

Interference
Channel Assignment Leader RCDNG-21A-WLC5 (10.201.81.8)
Last Auto Channel Assignment 531 second(s) ago

DCA Channel Sensitivity medium -

Auto-RF Channel List

EDRRM
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Individual access points can be configured to override the global setting to use dynamic channel and transmit power
assignment for either 5 or 2.4 GHz depending on which frequency band is to be utilized.
Other access points can be enabled for automatic assignment method and account for the access points that are statically

configured.

This may be necessary if there is an intermittent source of interference in the area.
The 5 GHz channel width can be configured as 20 MHz or 40 MHz when using Cisco 802.11n Access Points and as 20 MHz,
40 MHz, or 80 MHz for using Cisco 802.11ac Access Points.

It is recommended to utilize the same channel width for all access points.

Cisco Catalyst 9800-40 Wireless Controller

afua]n
CISCO 451225

Q

[ Dashboard

{Z) Monitoring

Configuration
Administration

5 Troubleshooting

CleanAir

Welcome aipha

A ©

B &R Q c2

Configuration = > Edit Radios 5 GHz Band x

Configure Detail
W All Access P
General
Number of AP(s): 1
AP Name rcdn6-22a-ap1
AP ~ AP
Name Model  Admin Status

AR- &
rcdn&-zza; AP380 CleanAir Admin Status

ap1 gk
Antenna Parameters

Antenna Type Internal =
V5 GHz Radio Antenna Mode Omni
Number of AP(s): 1 Antennalk =
AP ~ Slot
Name No Antenna B ¥
redn6-22a-
ap1 i Antenna C v
1
Antenna D v
Antenna Gain 10
2.4 GHz Radi
Download Core Dump to bootflash
Dual-Band R
Country
LSC Provisio

RF Channel Assignment

Current Channel 148
Channel width 40 MHz v
Assignment Method Global v

Tx Power Level Assignment

Current Tx Power Level 2

Assignment Method Global v

The Enable CleanAir checkbox should be checked when utilizing Cisco access points with CleanAir technology to detect any

existing interferers.

B luhe Cisco Catalyst 9800-40 Wireless Controller
16.122s

cisco

Dashboard

Monitoring
Configuration

Administration

Troubleshooting

Configuration= » Radio Configurations= > CleanAir
5 GHz Band 2.4 GHz Band

General Trap Configuration

Enable CleanAir
Enable 51
Report Inerferers

Persistent Device
Propagation

Avallable Interference Interference Types
Typas 1o detect

TOD Transmiter
Jammer

Continuous Transmitter
DECT-lika Phone
Video Camera
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WLAN Settings

It is recommended to have a separate SSID for the Cisco Desk Phone 9800 Series.

you can also use an existing SSID that is configured to support voice capable Cisco Wireless LAN endpoints.

The SSID to be used by the Cisco Desk Phone Esrepsso can be configured to only apply to a certain 802.11 radio type (e.g.
802.11a only).

It is recommended to operate the Cisco Desk Phone 9800 Series on the 5 GHz band only due to availability of many channels
and fewer interferers compared to the 2.4 GHz band.

Ensure that the selected SSID is not utilized by any other wireless LANs as that could lead to failures when powering on or
during roaming; especially when a different security type is utilized.

B .l Cisco Catalyst 9800-40 Wireless Controller Welcomeapra | A € [B # 0 @ T Q 3
16.12.2s
Configuration - > JEelyTN] x
General Security Advanced
Dashboard Profile Name™ Voice Radio Policy s0z.1lacaly v
Monitoring > Number of WLANS 54 SSID* voice Broadcast SSID | EnaBLED .
Configuration Sobmjpan  WLAKID: 1
i i © e Status .smmzn .‘
Administration o Du -
Troubleshooting 1

To utilize 802.11r (FT) for fast secure roaming, set Fast Transition to Enabled.

Is recommended to uncheck Over the DS to utilize the Over the Air method instead of the Over the Distribution System
method.

Protected Management Frame should be set to Optional or Required.

Enable WPA2/WPA3 policy with AES(CCMP128) encryption then 802.1x, PSK or SAE for authenticated key management
type depending on whether 802.1x, PSK or SAE is to be utilized.

B .l Cisco Catalyst 9800-40 Wireless Contraller Welcome sz | # ® B &# @ @ T Q =
18123
= Configuration = > Tags & Profiles - » Edit WLAN s
a
General  Securty  Advanced
|55 Dashboard Layer2 Layer3 AL
Number of WLANs selected : 0
Layer 2 Security Mode WPA+WPAZ v Fast Transition Enabled .
Status:  Name « D
. ° 1 MAC Fillering Over the DS
71 Administration >
x Qo D 2 Protected Management Frame Reassociation Timeout 20
& Troubleshooting 1 0 .
PMF Disabied v
'WPA Parameters
WPA Policy
WPA2 Policy
WPA2 Encryption AES(COMP128)
CCMP256
GCMP128
GCMP256
MPSK
Auth Key Mgmt B0Z.1x
PsX
CCKM
FT »802.1x
FT « PSK

B02.1x-5HAZ56
PSK-5HAZSE

0 Cance! | Update & Apply to Device
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u il Cisco Catalyst 9800-40 Wireless Controller # %O & MOCT Q =
161223
Ganeral Security Advanced
-
== Dashboard
b Layer2 Layer3 AAS,
Monitoring Ml Number of WLANS selected : O
5 . ) Layer 2 Security Mode WPA+ WPAZ & Fast Transition Enatled v
Configuration > — A 2
o Voice. 1 MAC Filtering Ower the DS
Administration
oy ©Q Daa 2 Protected Management Frame Reassociation Timeout 20
& Troubleshooting 1 0 .
PMF Disabled
WPA Parameters
WPA Policy
WPA2 Policy
WPAZ Encryption AESICCMP128)
COMP256
GOMP128
GOMP2S6
MPSE
Auth Key Mgt 802.1%

PSK

CCRM

FT +802.1x

FT +PSK
802.1x-5HAZS6

PSK-SHAZSE
PSK Format ASCH

DR Tima [Iree—

&=

802.11r (FT), PSK or SAE can also be enabled to utilize the same SSID for various type of voice clients,

depending on whether 802.1x or PSK/SAE is being utilized.

If using 802.1x, configure the AAA Authentication List that maps to the RADIUS Servers defined in the RADIUS Server
Groups.

B il Cisco Catalyst 9800- 40 Wirelass Controller w v A "E 60O Q +

Conhguration
Administration

%' Troubleshooting

Aironet IE should be Disabled.

Peer to Peer (P2P) Blocking Action should be Disabled.

The WMM Policy should be set to Required only when the Cisco Desk Phone 9800 Series or other WMM-enabled phones
will be using this SSID.

If there are non-WMM clients existing in the WLAN, it is recommended to put those clients on a separate WLAN.

If other non-WMM clients must utilize the same SSID as the Cisco Desk Phone 9800 Series, ensure the WMM policy is set to
Allowed.

The maximum client connections per WLAN, per AP per WLAN, or per AP radio can be configured as necessary.

Off Channel Scanning Defer can be tuned to defer scanning for certain queues as well as the scan defer time.
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It is recommended to enabled defer priority for queues 4-6.

If using best effort applications frequently or not preserving DSCP values for priority applications (e.g. voice and call control)
to the access point, it is recommended to enable the lower priority queues (0-3) along with the higher priority queues (4-6) to
defer off channel scanning as well as potentially increasing the scan defer time.

For deployments with frequent EAP failures, it is recommended to enable priority queue 7 to defer off channel scanning
during EAP exchanges.

Ensure Load Balance and Band Select are disabled.

Use a DTIM Period of 2 with a beacon period of 100 ms.

Keep the default settings for 802.11k and 802.11v.

il Cisco Catalyst 9800-40 Wireless Controller Wekomeaiphs | # W B & W @ T Q »
cige wiza
» weAne IR ——————————
General  Securty  Advanced
=
iz Dashboard Coverage Hoke Detection Universal Admin
) Monitoring » fircner Load Batance
Configuration s Status ~  Name - o ~ 880 P2P Biocking Action Disabled v Band Seiect
1 wice
I s : Mutticast Buffer B ceseaen P Source Guard
i Administration - = e
Media Siroam Muticast- WM Policy Aecured
dirmct

% Troubleshooting

mONS Mode Bridging
Max Gllent Connections

‘Off Channel Scanning Defer

Per WLAN o
Datar o
Por AF Par . Priory “ 2
WLAN
Per AP Radio 200
Per WLAN
3
11v BSS Transition Suppont

Scan Dofor 100
Tire

BSS Transition Assisted Roaming (11k)
i 200
Prediction
Cptimzatian
Optimized Roanming 40 Ty
Dizsssaciation Timer(D to
40 TETT) MNeighbor List
BSS Max Idie Service Dual Band Neighbar
List.
BS55 Max Idie Prosected
DTIM Pericd (in beacon Intervals)
Directed Multicast Service
1lax 5 GHz Band (1-255) 2
2.4 GHz Band (1-255) 2
Oowminik OFDMA
Finfink CFTAA
| 2 Cance 1-" Updsts & Apply to Dovice

Policy Profiles

Policy Profiles are used to define additional settings regarding access, QoS, Mobility, and advanced settings.
Policy Profiles are then mapped to a WLAN Profile via a Policy Tag, which then can be applied to an access point.
Ensure the Status of the policy profile is Enabled.

Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 60



il Cisco Catalyst 9800-40 Wireless Controller Welcomeapha =& W B & @ @ & Q &=
16.12.2s

cisco
Configuration~ > TjiSelsEelloR il -

General Access Policies QOS and AVC Mability Advanced

[ Dashboard

A Configuring in enabled state will result in loss of connectivity for clients associated with this profile.

=) Monitoring Status v Pol
. (] Dat| s -
. Configuration Name* | Voice WLAN Switching Policy
= (] Vo,
{ Administration @ def Descriptian Enter Description Central Switching envsetep [l

1 Status Central Authentication ensstep [l
Passive Client . DISABLED Central DHCP ENABLED .
Encrypted Traffic Analytics . DISABLED Gentral Association ENABLED .

CTS Policy Flax NAT/PAT

Inline Tagging

’ Troubleshooting

SGACL Enforcement

Default SGT 2-65519

Update & Apply to Device

Select the VLAN or VLAN Group to be utilized with the policy profile.

el Gisco Catalyst 9800-40 Wireless Gontroller Welcomeapha | & © B & @ @ & Q C3
161225
Mo ey Edit Policy Profile =
General Access Policies QOS and AVC Moability Advanced
Dashboard
RADIUS Profiling WLAN ACL
<) Monitorin Status ) -
@ g Local Subscriber Policy Name v 1Pva ACL | =
Confi i o i :
, Configuration - WLAN Local Profiling PeACL | -
Administration ¢ Global State of Device Disabled (@) -
9 Classification URL Filters:
+ 1
Troubleshooting HTTP TLV Caching Pre Auth =
DHCP TLV Caching Post Auth | ¥
VLAN
VLAN/VLAN Group VLANO500 v
Multicast VLAN . Enter Multicast VLAN

Update & Apply to Device
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Ensure the QoS SSID Policy is set to Platinum for egress and Platinum-up for ingress.

el Cisco Catalyst 9800-40 Wireless Contraller Welcomeapha | # © B # M@ @ & Q 3
16.122s
SRy Edit Policy Profile x
General Access Policies QOS and AVC Mobility Advanced
[ES) Dashboard
Auto QoS None v Flow Monitor IPv4
Z) Monitoring e )
QoS SSID Policy Egress v
s ] [
Configuration -
@ 4 Egress platinum % ¥ Ingress v
Administration @ ¢ ngress platinum-up x v Flow Monitor IPv6
; 1
Troubleshooting QoS Client Policy Egress | .
Egress - Ingress v
Ingress -
SIP-CAC
Call Snooping

Send Disassociate

Send 486 Busy

| Update & Apply to Device

Configure Session Timeout as desired. It is recommended to enable the session timeout for 86400 seconds to avoid possible
interruptions during audio calls, and also periodically re-validate client credentials to ensure that the client is using valid
credentials.

Configure Client Exclusion Timeout as desired.

IPv4 DHCP Required should be disabled.

»Llllﬂll- Cisco Catalyst 9800-40 Wireless Controller Welcomealpha | # © 2 & M @ 2 Q &
16.12.2s

sco
Configuration - > (S ACIIE 5

General Access Palicies QOS and AVC Mobility Advanced
[& Dashboard

'WLAN Timeout Fabric Profile .
¢7) Monitori
(<) Monitorin Status v
R g Session Timeout (sec) 86400 gmbrena i Not Gonfigured v
) arameter Map
/ 300
] [ e Tmeaies mDNS Service default-mdns-servict v
Policy
dministration %) Idle Threshold (bytes) 0 Clear
1 Client Exclusion Timeout (sec) </ g0 WLAN Flex Policy

’ Troubleshooting

VLAN Central Switching
DHCP

Split MAC ACL v
IPv4 DHCP Required

Air Time Faimess Policies
DHCP Server IP Address

Show more >>> 2.4 GHz Policy v

5 GHz Policy v
AAA Policy

Allow AAA Override
NAG State
Policy Name default-aaa-policy x v

Accounting List v
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RF Profiles

RF Profiles can be created to specify the frequency bands, data rates, RRM settings, and advanced settings that a group of
access points should use.

For the SSID used by the Cisco Desk Phone 9800 Series, it’s recommended to apply to 5 GHz radios only.

RF Profiles are applied to an RF Tag, which then can be applied to an access point.

When creating an RF Profile, the Name and Radio Band must be defined.

Select 5 GHz Band or 2.4 GHz Band for the Radio Band.

Add RF Profile

General 802.11 RRM Advanced

Name* | Enter Name

Radio Band | 5 GHzBana v

Status B osesie

Description Enter Description

| Apply to Device

On the 802.11 tab, configure the data rates as necessary.
It is recommended to enable 12 Mbps as Mandatory and 18 Mbps and higher as Supported; however some environments
may require 6 Mbps to be enabled as a mandatory (basic) rate.

Add RF Profile

General 802.11 RRM Advanced

Operational Rates 802.11n MCS Rates

6 Mbps Disabled Enabled Data Rates

Disabled
e [0,1,234,56,7,89.10,11,12,13,14,15,16,17,18

.18,20,21,22,23,24,25,26,27,28,25,30,31)
12 Mbps Mandatary

18 Mbps Supponed

24 Mops Supparted

36 Mbps Supported

48 Mbps Supported

54 Mbps Suppacted
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On the RRM tab, the Maximum Power Level and Minimum Power Level settings as well as other DCA, TPC, and

Coverage settings can be configured.

Add RF Profile

General 802.11 RRM Advanced

Genaral Coverage TPC DCA
Coverage Hole Detection

Minimum Glient Level (clients}*

Data RSSI Threshold (d8m)*

Voice RSSI Threshold (dBm)*

Exception Level(%)*

D Cancel Apply 1o Device

Add RF Profile

General 802.11 RRM MAdvanced

General  Coverage  TPC  DCA

Transmit Power
Control

Maximum Power Level(dBm)*
Minimum Power Levei(dBm)*

Power Threshold V1(dBm)*

 Cancel Apply to Device

Add RF Profile

General 802.11 RRM Advanced

General Coverage TPC DCA

Dynamic Channel Assignment
Avoid AP Foreign AP Interference
Channel Width
® Best

AMEAEHHEHEEHEEEE

DCA Channels o
36 40 44 48 52 56 60 64 100104 108112116120124

vl [ 2 F = 2
128 132 136 140 144 149 153 157 161 165

High Speed Roam
Mode Enable

Neighbor Timeout*

Client Network Preference

=
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On the Advanced tab, Maximum Clients, Multicast Data Rate, Rx Sop Threshold, and other advanced settings can be
configured.
It is recommended to use the default value (Auto) for Rx Sop Threshold.

Add RF Profile

General Bo2.11 RRM Advanced

High Density Parameters

Max Cllents*

Multicast Data Rate (Mbps)

Rx Sop Threshold (dbm)

Client Distribution

Load Balancing Window*

Load Balancing Denial Count®

ATF Configuration

Status (@ oisasien
Bridge Client Access . DISABLED |
Alrtime Allocation 5

FRA

Client Aware

Flex Profiles

Flex Profiles are used to define the settings the access point should use when in Flexconnect mode.
Flex Profiles are then mapped to a Site Tag, which then can be applied to an access point.
Configure the Native VLAN ID for the access point to use as well as the allowed VLANS.

Ensure ARP Caching is Enabled.

Enable Local Authentication as necessary.

Add Flex Profile

General Local Authentication Policy ACL VLAN

—— Enter Name Fallback Radio Shut
Description Enter Description Flex Resilient

Native VLAN ID 1 ARP Caching

HTTP Praxy Part o Efficient Image Upgrade

HTTP-Proxy IP Address Office Extend AP
CTS Policy Jain Minimum Latency
Inline Tagging

SGACL Enforcement

TS Profile Name default-sxp-profies. v
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Tags

Policy Tag
Policy Tags define the mapping of WLAN Profiles and Policy Profiles.

Policy Tags are then applied to an access point to specify which WLANs / SSIDs are to be enabled, which interface they
should be mapped to and which QoS and other settings to use.
When creating a Policy Tag, click Add, select the WLAN Profile to configure then select the Policy Profile to be used.

~

uilt - Gisco Catalyst 9800-40 Wireless Controller  Welcomeapphs & & B & M @ & Q =
16.122s

sco
Configuration~ > Tags & ProfilfiasusgeSMEL] tol

& Changes may resuit in loss of connectivity for some clients that are associated to APs with this Palicy Tag.

Policy Site RF A

[ Dashboard

Monitoring Name* | defautt-policy-tag |
i i default policy-ta |
Configuration Polky Tag Harms Dascription 1 uit policy-tag
5% Administration geipolyzeg v WLAN-POLICY Maps: 2
1 | 10
Troubleshooting —
WLAN Profile « Policy Profile v
Data Data
1 ! 10 v |items per page 1 -2 of 2 items

Map WLAN and Policy

WLAN Profile* Voice v Policy Profile* | Voice

o] v

RLAN-POLICY Maps: 0

| Update & Apply to Device

Site Tag
Site Tags define which AP Join Profile and Flex Profile should be used.

Site Tags are then applied to an access point to specify which AP Join Profile and Flex Profile parameters should be used.
When creating a Site Tag, click Add, select the AP Join Profile to be used.
When creating a Site Tag to include a Flex Profile, ensure Enable Local Site is not checked, then select the necessary Flex

Profile.

Add Site Tag
Name*
Description

AP Juin Profile default-ap-profile

Flex Profile default-flex-profle  »

Control Plane Name

Enable Local Site

O Cancel ‘| Apply to Device
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RF Tag
RF Tags define which RF Profiles should be used for 2.4 GHz and 5 GHz.

RF Tags are then applied to an access point to specify which RF Profile parameters should be used.
When creating a RF Tag, select the S GHz Band RF Profile and 2.4 GHz Band RF Profile to be used.

Add RF Tag

Name* Enter Name
Dascription Enter Description
5 GHz Band RF Profile Global Config

2.4 GHz Band RF Profile Giobal Config

Once tags are defined, they can then be applied to an access point.

u il Cisco Catalyst 9800-40 Wireless Controller Welcomealpha # T B & 0 @ & Q &
16122
Configuration - > [ Z:latd =
General Interfaces High Availability Inventory ICap Advanced
| Dashboard v
All Access N

Number of AP(s): 1
) Monitoring ek

AP Name* redné-22a-ap1 Primary Software Version 16.12.2.132
i 5 AP v AP
-, Configuration el i Location® rednG-22 Predownloaded Status NrA
Administration > rednG-22a- z._ Base Radio MAC 00a7.42b0.5c80 Fradgunioaded Verslon /R
W &y
Troubleshooting Etharnet MAC 00a7.4267.cola Mext Retry Time MIA
<1
Admin Status [enasLen ] Boot Version 1.1.24
105 Version 16.12.2.132
AP Mode Local v
5 GHz Rac
Operation Status Ragistered Minl [0S Version 0000
24GHZR e saws Disabled IP Config
LED Stat
Dual-Banc . Ml CAPWAP Preferred Mode  IPvd
t;?e ?rlgnmm 8 X DHCP IPv4 Address 10.201.81.125
Country
Cleanair NSLKey Static IP (IPva/IPv6)
LSC Provis 1,0, Time Statistics
" ~policy- Up Time 10 days 18 hrs
Policy defaull-policy-tag  « 16 Miae 54
S8cs
Site default-site-tag -
Controfier Association Latency 2 mins 4 sacs
RF default-ri-tag ¥

O Cancel Update & Apply to Device

If a Site Tag is applied including a configured Flex Profile, then the AP Mode will be changed to Flex automatically.
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B .l Cisco Catalyst 9800- 40 Wireless Controller ~ Welcome spra | & % [B # @ @ & Q C3
16.122s

contaursion- |

General Interfaces High Availability Inventory ICap Advanced
W All Acces
General Version
Number of AP(s): 1
AP Name* redn6-22a-apl Primary Software Version 16.12.2.132
AP v A
Name Y Location* redn6-22 Predownloaded Status N/A
Administration rodn6-22a- i{il Base Radio MAC 00a7.42b0.5¢80 Predownloaded Version N/A
ap1 & g
Troubleshooting Ethemet MAC 00a7.42b7.cbla Next Retry Time NiA
1
Admin Status Boot Version 1.1.24
AP Mode Fiex & 10S Version 16.12.2.132
5 GHz Ra
Operation Status Registered MintI05 Version 0000
24GHz1  popic staws Disabled IP Config
Dual-Bar L CAPWAP Preferred Mode  IPva
i 8
L=D- Brghiness M DHCP IPv4 Address 10.201.81.125
Country
CleanAir NSI Key, Static IP (IPv4/IPv6)
LSC Prov Tags Time Statistics
Policy default-policy-tag | v Up Time 0days O hrs 10
1 mins 1 secs
Site Flex v Controller Association Latency 10 secs
RF default-ritog | v
Update & Apply to Device

Controller Settings

Ensure the Default Mobility Domain is configured correctly.
Enable AP LAG Mode.

B .l Cisco Catalyst 9800-40 Wireless Controller Welomeaiphs | # ® B & M @ T Q
18122
Configuration= » Wireless -~ > Wireless Global

Dashboard Default CTG-VOWLAN3 Assisted Roaming

Mobikity
b, Homan Denial Maximum®* 5

Moniteoring
E;ﬁ;‘?up RCOME: Vo 2 Fioor Blas(dBm)* 15

Configuration
Maximum [ Prediction Minimum®* 3

0} Administration

Lagin
Sessions Per
User*

Management

Via Wireless

Device
Classification

AP LAG
Mode
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Mobility Settings

When multiple Cisco Wireless LAN Controllers are part of the same mobility group, then the IP address and MAC address of
each Cisco Wireless LAN Controller should be added to the Mobility Peer configuration.
Ensure each Cisco Wireless LAN Controller is configured with the same Mobility Group Name.

stfanfae
CiSco

Dashboard Global Configuration

Mobility Group Name*

.} Monitoring

: Conﬁguralion Multicast IPv4 Address

e ey . Multicast IPvE Address
| Administration

Keep Alive interval {sec)*
4 Troubleshooting

Mobiiity Keap Allve Count™

Mobility DSCP Value*

Mobility MAC Address®

alialis

cISco

Cisco Catalyst 9800-40 Wireless Controller
Ty

Configuration = > Wireless =

> Mobility

Desnboard Global Configuration  Peer Confguration
) Monitoring “ Mobility Peer Configuration
Configuration m
07 Administration MAC Address  ~ 1P Address
s 706d. 1530 b508 10,201 81,9
% Troubleshooting 6c31.0e7b.b8eb 10.201.81.10
1 10 &

Cisco Catalyst 9800-40 Wireless Controller
161228

Configuration~ > Wireless~ > Mobility

Peer Configuration

Welcome aiphs | # W B & M @ T Q ®»

CTG-VoWLANI

0.0.0.0

10

3

48

706d.153d b50b

Welcome alphe # TR H MO Q C 2

~  Public IP « GroupName ~ Multicast IPvd Status PMTU
A CTG-VGWLANZ  00.00 nA NIA
10.201.81.10 CTG-Va\WLANT 0.0.0.0 Up 1385

Non-Local Mobility Group Multicast Configuration

Ensure the Mobility MAC Address matches the MAC address of the wireless management interface.

m
cIsco

Cisco Catalyst 9800-40 Wireless Controller
81278

Configuration~ > Interface - > Wireless

[Z Dashboard

) Monitoring Interface Name «  Interface Type
. Vian310 Management

. Configuration

: 1 0 v

7] Administration

% Troubleshooting
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Call Admission Control (CAC)

Unicast Video Redirect and Multicast Direct Enable should be Enabled.

Troubleshooting

Multicast

6 GHz Band

Configuration ~ > Radio Configurations~ > Media Parameters

5 GHz Band

2.4 GHz Band

A 6 GHz Network is operational. Configuring Media Parameters will result in loss of connectivity of clients.

Media Voice
General Call Admission Control (CAC)
Unicast Video Redirect v Admission Control (ACM)

Multicast Direct Admission Control
Media Stream Admission Control (ACM)

?/Ia)xlmum Media Stream RF bandwidth
%)

Maximum Media Bandwidth (%)*
Client Minimum Phy Rate (kbps)

Maximum Retry Percent (%)*

Traffic Stream Metrics

Metrics Collection

5 Stream Size* 84000
Max Streams* 2

85

6000 - Inactivity Timeout w3

80

Media Stream - Multicast Direct Parameters

Multicast Direct Enable v

Max streams per Radio

No Limit v

To utilize multicast, Global Wireless Multicast Mode and IGMP Snooping should be Enabled.

il
Q

[ Dashboard

Monitoring

.. Configuration

Administration

Troubleshooting

Cisco Catalyst 9800-40 Wireless Controller
16.12.2s

Global enaslep [l
Wireless
Multicast Mode

Querier Interval
(milliseconds)

Wireless Broadcast and

Welcome aipha A GRS MmO Q =

Configuration= > Services~ > Multicast

IGMP Sncoping

Wireless B vissBLED
mMDNS Bridging EpE—
Wireless Non- B osasLeD Disabled Enabled
IP Multicast
Status VLANID Name Status VLANID Name

Wireless B oiseBLED
Broadcast (4] 1 default €
AP Capwap Unicast % ] 310 VLAND310 €
Multicast

1] 400 VLAND40D €
MLD Snooping B viseBLED No Vian available 1] 500 VLAND500 €
IGMP B oisasLED
Snooping
Querier
IGMP enaslen [
Snooping
Last Member 1000

Disable All

Wireless Non-IP Multicast

In the Media Stream settings, Multicast Direct Enable should be Enabled.
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B lule Cisco Catalyst 9800-40 Wireless Controller Welcome ajpha  #
cisee. I

Configuration - » Wireless - » Media Stream

Dashboard General Streams

Monitoring 2 Multicast Direct Enable 2 Apply

Configuration Session Message Config

21 Administration

Session Announcement
State

' Troubleshooting

Session Announcement
URL

Session Announcement
mail

Session Announcement
Phone

Session Announcement
MNote

Enable Multicast Direct in the WLAN configuration.

il Cisco Catalyst 9800-40 Wireless Controller ~ Welcome apha | & ® B & ™ @ & Q c3
16.122s
Configuration + > [ZelNR x
General Security Advanced
[':1:_]] Rsnkoan Coverage Hole Detection v Universal Admin
Monitoring Number of WLANs s Ajronet IE v Load Balance
Configuration Stews Nam{  P2P Blocking Action [ Disabled . Band Select
Administrati LY voR | Multicast Buffer DISABLED IP Source Guard
ministration o Gt
Media Stream Multicast- v WMM Policy Required v
Troubleshooting 1 diract
mDNS Mode Bridging v

Max Client Connections

Off Channel Scanning Defer

Per WLAN [
1 Defer 0 1 2
Per AP Per o Priority
WLAN
3 *4 vlg
Per AP Radio 200
Per WLAN
s o
11v BSS Transition Su| rt
pES Scan Defer 100

Time
BSS Transition Assisted Roaming (11k)
Disassociation Imminent(0 | 200
to 3000 TBTT)

Prediction Optimization
Optimized Roaming 40
Disassociation Timer(0 to ) Neighbor List
40 TBTT)
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Advanced Settings

Advanced EAP Settings

To view or configure the EAP parameters, select Configuration > Security > Advanced EAP.

B .l Cisco Catalyst 9800-40 Wireless Controller Welcomeapha # © B & M @ & Q 3
161228
= Confguration~ > Security* > Advanced EAP
EAP-Identity-Request Timeout (sec)* 30
|Z Dashboard
EAP-Identity-Request Max Retries* 2
EAP Max-Login Ignare Identity |l oseseen |
Response —
: EAP-Request Timeout (sec)* 30
{01 Administration
EAP-Request Max Retries* 2
%' Troubleshooting iy et il res
EAPOL-Key Max Retries” 4
EAP-Broadcast Key Interval (sec)* 3600

When using 802.1x, the EAP-Request Timeout on the Cisco Wireless LAN Controller should be set to 30 seconds.

For deployments with frequent EAP failures, the EAP-Request Timeout should be reduced to below 30 seconds.

If using PSK then it is recommended to reduce the EAPOL-Key Timeout to 400 milliseconds from the default of 1000
milliseconds with EAPOL-Key Max Retries set to 4 from the default of 2.

When using 802.1x, the default values for EAPOL-Key Timeout and EAPOL-Key Max Retries should work fine, but it is
still recommended to set those values to 400 and 4 respectively.

The EAPOL-Key Timeout should not exceed 1000 milliseconds (1 second).

Ensure EAP-Broadcast Key Interval is set to a minimum of 3600 seconds (1 hour).

Rx Sop Threshold

It is recommended to use the default value (Auto) for Rx Sop Threshold.

B .l Cisco Catalyst 9800-40 Wireless Controller Welcomeaphs | # ® [B # M @ © Q =

a Configuration - > Wireless- > Adwvanced

[ Dashboard

Load Balancing Band Select Optimized Roaming High Density Preferred Calls

Rx Sop Threshold
Rx Sop Threshold 5 GHz (dbm) auo
Rx Sop Threshold 2.4 GHz (dom) auto
Multicast Data Rate

Multicast Data Rate 5 GHz (Mbps) Auto

Multicast Data Rate 2.4 GHz (Mbps) Auto

Rogue Policies

It is recommended to use the default value (Disable) for Rogue Location Discovery Protocol.
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tliili - Cisco Catalyst 980040 Wireless Controller Welcomeapha # © B & @ © = Q
16.122s

= Configuration - > Security~ > Wireless Protection Policies

Dashboard Rogue Policies RLDP Rogue AP Rules Client Exclusion Policies

Monitoring Rogue Location Discovery Disable
Protocol

L Configuration
Retry Count 1

ministration Schedule RLDP
Troubleshooting Day SariTine e

Monday

Tuesday

Wednesday

Thursday

Friday

Saturday

Sunday

Cisco Mobility Express and Lightweight Access Points

When configuring Cisco Mobility Express and Lightweight Access Points, use the following guidelines:

* Enable 802.11r (FT)

* Disable CCKM

* Set Quality of Service (QoS) to Platinum

* Ensure 802.11k is Disabled

* Ensure 802.11v is Disabled

* Disable P2P (Peer to Peer) Blocking Action
* Set Client Band Select to Disabled

* Set Client Load Balancing to Disabled

* Configure the Data Rates as necessary

* Configure RF Optimization as necessary

+ Set Traffic Type to Voice and Data

* Enable CleanAir if utilizing Cisco access points with CleanAir technology
* Configure Multicast Direct as necessary

Controller Settings

=

Configure one or more of the Mobility Express capable access point’s Operating Mode to include the Controller

functionality.
Configure the AP Name and IP settings as necessary.
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AP1850-1(Active Controller)

o Radio 1 (2.4 GHz)  Radio 2 (5GHz)  802.11u

Operating Mode AP & Controller v @

AP Mac | 58ed 18:08:1b:78
AP Model [IIRSASIESSRANE
IP Configuration  Obtain from DH... ¥
1P Address | 1000 100
Subnet Mask | S8 208 i
10.00.1
e AP1850-1

defautt location

Network Spectrum Interface 550850E30AE58853D07FDDSFASEEFS20

Configure the Cisco Wireless LAN Controller System Name and IP settings as necessary.

AP1850-1(Active Controller)

ler  Radio1(2.4 GHz) Radio 2 (5GHz)  802.11u

System Name ~ WLC1850-1 (2]
1P Configuration  Static 1P
s will be disrupted when IP Confia
1P Address  10.0.0.30
Subnet Mask | 2552552650

Gateway  10.0.0.1

Country  United States (... v

802.11 Network Settings

It is recommended to operate the Cisco Desk Phone 9800 Series only on the 5 GHz band due to the availability of many
channels and fewer interferers compared to the 2.4 GHz band.

To use 5 GHz, ensure the 5.0 GHz Band is Enabled.

It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps and higher as supported (optional) rates.
However, some environments may require 6 Mbps to be enabled as a mandatory (basic) rate.

To use 2.4 GHz, ensure the 2.4 GHz Band is Enabled.

It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps or higher as supported (optional) rates assuming
that there will not be any 802.11b only clients connected to the wireless LAN. However, some environments may require 6
Mbps to be enabled as a mandatory (basic) rate.

I£ 802.11D clients exist, then 11 Mbps should be set as the mandatory (basic) rate and 12 Mbps or higher as supported
(optional).

When using 5 GHz, it’s recommended to limit the number of channels (e.g. 12 channels only) to avoid any potential delay in
access point discovery caused by scanning many channels.

The 5 GHz channel width can be configured as 20 MHz or 40 MHz for using Cisco 802.11n Access Points and as 20 MHz, 40
MHz or 80 MHz for using Cisco 802.11ac Access Points.

It is recommended to utilize the same channel width for all access points.

When using 2.4 GHz, only channels 1, 6, and 11 should be enabled in the DCA list.
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CleanAir detection should be Enabled when utilizing Cisco access points with CleanAir technology to detect any existing

interference.

®R Monitoring

£+ Wireless Settings

A Management

/" Services
-"n Advanced
¥ SNMP
& Logging
all
il RF Profiles
# Controller Tools

Q- Security Settings

CMX

RF Optimization

Advanced RF Parameters
2.4 GHz Band

5.0 GHz Band

Automatic Flexible Radio Assignment
2.4 GHz Optimized Roaming

5 GHz Optimized Roaming

Event Driven RRM

CleanAir detection

5.0 GHz Channel Width

2.4 GHz Data Rates

5.0 GHz Data Rates

Select DCA Channels

40 MHz v

Lower Density

Higher Density

2656 90 1 12 18 24 *

802.11b devices not supported

Lower Density

48

5

Higher Density

6 9 12 18 24 3

Some legacy devices not supported

2.4 GHz [ 2 3 4 5 7

5.0 GHz [
108 112 116 120 124 128 132

At least one Channel Number should be selected

It is recommended to enable RF Optimization to manage the channel and transmit power settings.
Set Traffic Type to Voice and Data.

®R Monitoring

¥ Wireless Settings
- Management

#~ Services

< Advanced
+ SNMP

8 Logging
il

il RF Profiles

# Controller Tools

£+ Security Settings

CMX

Individual access points can be configured to override the global setting to use dynamic channel and transmit power

RF OPTIMIZATION

RF Optimization

Client Density |
ow

Traffic Type

Enabled

mr
e 'c|slcol Cisco Aironet 1850 Series Mobility Express

Typical

Voice and Data

Q A © B =

High

® © ©

assignment for either 5 or 2.4 GHz depending on which frequency band is to be utilized.

Other access points can be enabled for automatic assignment method and account for the access points that are statically

configured.

This may be necessary if there is an intermittent source of interference in the area.
The 5 GHz channel width can be configured as 20 MHz or 40 MHz for using Cisco 802.11n Access Points and as 20 MHz, 40
MHz, or 80 MHz for using Cisco 802.11ac Access Points.

It is recommended to use channel bonding only when using 5 GHz and utilize the same channel width for all access points.
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il
9 ":I, ;co‘ Cisco Aironet 1850 Series Mobility Express Q A ©®

&® Monitoring

£ Wireless Settings
N WLANs ACCESS POINTS ADMINISTRATION

< Access Points

Groups
Q Seareh Global AP Configuration JI ConverttoME Ll ConverttoCAPwaP K

® WLAN Users

D Primary Gontrolier D Primary Gontroller and Praferred Master 2 Preferred Master
Guest WLANs

DHCP Server Refresh

¥ Mesh Sele.. Mana.. Type Location Name 1P Address AP Mac Up Time AP Model

1l
(]
&

Y
@z Upl s me capable  defautt location AP1850.1 10.6.0.100 38:0d:18:08:1b:78 0days, 14h 37 mads AIR-AP18521-A-KS
Management =l

@ O U0 cwwse  gomauntiocation AP1880-2 10.0.0.101 ased:18:cai28:40 0 days, 14 hoTm 448 AIR-AP18521-8-K9

Services

& Advanced

AP1850-1(Active Controller)

General  Controller  Radio 1 (2.4 GHz)  Radio 2 (5GHz)  802.11u

Admin Mode Enabled
2.4 GHz
802.11b/g/n

Channel  Automatic
Channel Width

Transmit Power Automatic

AP1850-1(Active Controller)

General  Controller  Radio 1 (2.4 GHz)  Radio 2 (5GHz)  802.11u

Admin Mode  Enabled
5GHz

Ghannel  Automatic 802.11a/n/ac

Channel Width

Transmit Power Automatic

D &

AP1850-2

General  Radio 1 (2.4 GHz)  Radio 2 (5GHz)  802.11u

Admin Mode Enabled
2.4 GHz
802.11b/g/n

Channel Automatic
Channel Width

Transmit Power Automatic
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AP1850-2
General Radio 1 (2.4 GHz) Radio 2 (5GHz) 802.11u
Admin Mode | Enabled

5GHz
802.11a/n/ac

Channel | Automatic v

Channel Width =

Transmit Power Automatic

WLAN Settings

It is recommended to have a separate SSID for the Cisco Desk Phone 9800 Series.

However, you can also use an existing SSID that is configured to support voice capable Cisco Wireless LAN endpoints.

The SSID to be used by the Cisco Desk Phone 9800 Series can be configured to only apply to a certain 802.11 radio type (e.g.
5 GHz only).

It is recommended to operate the Cisco Desk Phone 9800 Series on the 5 GHz band only due to availability of many channels
and fewer interferers compared to the 2.4 GHz band.

Ensure that the selected SSID is not utilized by any other wireless LANs as that could lead to failures when powering on or
during roaming; especially if a different security type is utilized.

Add new WLAN/RLAN

eeeee ewal vanced  802.11u  Hotspot2.0  Scheduling

WLANID 1
Type  WLAN
Profile Name *  voice

voice.

WLANS with same SSID can be configured, unless layer-2 security settings are different.

Admin State Enabled

Radio Policy 5 GHz only

Broadeast ssip (1)

Local Profiling Q

To utilize 802.11r (FT) for fast secure roaming, set Security Type to either WPA2-Enterprise or Personal depending on
whether 802.1x or PSK/SAE is to be utilized.
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Add new WLAN/RLAN

General  WLAN Security

Guest Network

Captive Network Assistant
MAC Filtering

Security Type
Authentication Server

Radius Profiling

VLAN & Firewall

Traffic Shaping ~ Advanced  802.11u  Hotspot2.0  Scheduling

WPAZEnterprise

External Radius

L]

BYOD

RADIUS Server

Authentication Gaching

Add RADIUS Authentication Server

State Server IP Address

X Enabled 10.0.0.20

Add RADIUS Accounting Server

State Server IP Address

% Enabled 10.0.0.20

Add new WLAN/RLAN

General  WLAN Security ~ VLAN & Firewall  Traffic Shaping ~ Advanced  802.11u  Hotspot2.0  Scheduling

Guest Network
Captive Network Assistant
MAC Filtering

Security Type  Personal

wpnzt wpA3
AutoConfig IPSK )
Passphrase Format  ASCII

Passphrase *

Confirm Passphrase *

) Show Passphrase

-« &

Set 802.11r to Enable in the Advanced tab of the WLAN configuration. Ensure Client Band Select and Client Load
Balancing are disabled.
802.11k, 802.11r, and 802.11v are not supported, therefore should be disabled.

Add new WLAN/RLAN

General ~ WLAN Security ~ VLAN & Firewall  Traffic Shaping ~ Advanced  802.11u  Hotspot2.0

Scheduling

Allow AAA Override
Maximum Allowed Clients Unlimited(Default)
Maximum Allowed Clients Per AP Radio 200
802.11k  Disabled
802.11r  Enabled

802.11v  Disabled

CoKM 7}

Client Band Select

Client Load Balancing

Umbrella Profile  None

Umbrella Mode  Ignore
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RADIUS Authentication Servers and Account Servers can be configured at a per WLAN level to override the global list.

Add new WLAN/RLA|

General  WLAN Security ~ VLAN & Firewall

Guest Network
Captive Network Assistant
MAG Filtering
Security Type  WPA2Enterprise
Authentication Server External Radius

Radius Profiling o

BYOD
RADIUS Server
Authentication Caching

Add RADIUS Authentication Server

State

Traffic Shaping ~ Advamced  802.11u

Server IP Address

Hotspot2.0  Scheduling

% Enabled

Add RADIUS Accounting Server

state

10.0.0.20

Server IP Address

X Enabled

10.0.0.20

alialn 5
(=] cllsclg Gisco Alronet 1850 Series Mobility Express Q A © &
@ Monitori g
£ Wireless Settings ADMIN ACCOUNTS
Y Management
© Access & users N1
P
@ Time
Management User Priority Order Local Admin Accounts  TACACS+ RADIUS  Auth Cached Users
¥ Software Update E—
< Services Authentication Call Station ID Type = AP MAC Address:SSID v
Advanced Authentication MAC Delimiter | Hyphen .
Accounting Call Station ID Type | |P Address .
Accounting MAC Delimiter | Hyphen v
Fallback Mode = Passive v
Usemame GiSco-probe:
Interval | 300 ¢ Seconds
AP Events Accounting
& Mon itoring Add RADIUS Authentication Server
¢ Wireless Settings Action Server Index Network User Management sState Server IP Address Shared Key Port
@ x 1 10.0.0.20 1812
Y Management
© Access
P
O Time
Add RADIUS Accounting Server
¥ Software Update
c X Action Server Index Network User Management state Server IP Address Shared Key Port
#  Services
@ = 1 -

&

Advanced
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Configure the Native VLAN ID and VLAN ID for the WLAN as necessary.

Ensure Peer to Peer Block is disabled

Add new WLAN/RLAN

General

Client IP Management

WLAN Security

Traffic Shaping

VLAN & Firewall

Network(Default)

Peer to Peer Block

Native VLAN ID | 1

Use VLAN Tagging

DHCP Scope |

Yes

VLAN ID *

No DHCP Scope associated with VLAN ID.

Enable Firewall No

VLAN ACL Map

Add New VLAN

VLAN Name

Advanced

80211y Hotspot2.0  Scheduling

VLAN Id

data

3

Ensure Platinum (Voice) is selected for QoS.

‘Add new WLAN/RLAN

General  WLAN Security  VLAN & Firewall

QoS

real-time bandwidth limit should be atleast Avera

Rate limits per client

Average downstream bandwidth limit
Average real-time downstream bandwidth
limit

Average upstream bandwidth limit

Average real-time upstream bandwidth limit

Rate limits per BSSID

Average downstream bandwidth limit
Average real-time downstream bandwidth
limit

Average upstream bandwidth limit

Average real-time upstream bandwidth limit

Fastlane

Application Visibility Control

AVG Profile.

Add Rule

S.. | Application

Traffic Shaping

Advanced  802.11u  Hotspot2.0

-9

Platinum (Voice)

ge bandwidth limit

0 kbps )
Kops @)
kbps @)

Kops

Disabled -

Enabling Fastiane will update QoS valus to platinum.

Enabled -

voica

Action

2

Scheduling

Average Rate Burst Rate

The Maximum Allowed Clients and Maximum Allowed Clients Per AP Radio can be configured as necessary.
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Add new WLAN/RLAN

d 80211y Hotspot2.0

Allow AAA Override

Maximum Allowed Clients  Unimited(Defaul)

Maximum Allowed Clients Per AP Radio| 200
80211k | Disabled
802.41r  Enabled

802.11v Disabled
ccKM >}
Glient Band Select

Client Load Balancing
Umbrella Profile  None

Umbrella Mode | Ignore

umbratt ocp override ()

mDNS

mDNS Profile  None

Passive Client () [>)

Ple st in Services->Media Stream. Passive Glient will not work
whe bled.

Multicast IP| 230,114 2]

mutticast pirect (1) @

AP Groups

AP Groups can be created to specify which WLANS are to be enabled and which interface they should be mapped to as well as
what RF Profile parameters should be used for the access points assigned to the AP Group.

Add new group

eeeee s Intelligent Capture

AP Group name  express-1
AP Group description
NAS-ID
Venue Group  UNSPECIFIED

Venue Type UNSPECIFIED

Add New Venve | ©

On the WLANES tab, select the desired WLANS and interfaces to map to then select Add.

Add new WLAN/RLAN
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Add new group

ss Points  RF Profile  Ports  Intelligent Capture

® Add new WLAN/RLAN

Type

WLAN

On the Access Points tab, select the desired access points then select Apply.
Those access points will then reboot.

Add new group

Ports  Intelligent Capture

AP Name MAC Address

AP1850-1 38ied:18:c8:1b:78

AP1850-2 38:00:18:c2:28:40

On the RF Profile tab, select the desired 2.4GHz or SGHz RF Profile, then select Apply.

Add new group

s Intelligent Capture
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RF Profiles

RF Profiles can be created to specify the frequency bands, data rates, RRM settings, etc. that a group of access points should
use.

For the SSID used by the Cisco Desk Phone 9800 Series , it’s recommended to apply it to 5 GHz radios only.

RF Profiles are applied to an AP group once created.

When creating an RF Profile, the RF Profile Name and Radio Policy must be defined.

Select SGHZ or 2.4GHz for the Radio Policy.

Maximum clients per radio, Multicast data rates, and Rx Sop Threshold can be configured as necessary.

It is recommended to use the default value (Auto) for Rx Sop Threshold.

Add RF Profile

RF profile name | express-1

RF profile description

Maximum clients per radio 200

Rx SOP Threshold  Auto

Multicast datarates  Auto

On the 802.11 tab, configure the data rates as necessary.
Is recommended to enable 12 Mbps as Mandatory and 18 Mbps and higher as Supported. However some environments may
require 6 Mbps to be enabled as a mandatory (basic) rate.

Add RF Profile

nnnnnnnnnnnnnnnnnnnnnnnnnnnnnnnn

On the RRM tab, the Channel Width settings and DCA Channels can be configured.

Add RF Profile

Seloct DCA Channels Select All ] 36 40 44 48 52 56 60 64 100 104 108
2 116 120 124 128 132 136 140 144 149 153
161 165
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Multicast Direct

In the Media Stream settings, enable Global Multicast and Multicast Direct.

®*R Meonitoring
£ Wireless Settings

[, B Management

& Services
[

OT1Ls

U mDNS

& Network Assurance
& wWebhook

& |ntelligent Capture

& Umbrella

< Advanced

alialn
e cisco Cisco Aironet 1850 Series Mobility Express

Media Stream Settings

Global Multicast ()
Multicast Direct () 2]

Session Announcement State

Q A @ B = = &

Session Announcement URL URL
Session Announcement Email Email
Session Announcement Phone Phone
Note
Session Announcement Note
4
Add New Stream

Action Stream Name Start IP Address End IP Address Operation Status
x 10.0.0.40 239.1.1.40 239.1.1.40 Multicast-direct

After Multicast Direct is enabled in the Media Stream settings, there will be an option to enable Multicast Direct in the

Advanced tab of the WLAN configuration.

Add new WLAN/RLAN

General  WLAN Security  VLAN & Firewall

Scheduling

Allow AAA Override

Maximum Allowed Clients

Maximum Allowed Clients Per AP Radio

802.11k

802.11r

802.11v

cckm

Client Band Select

Client Load Balancing

Umbrella Profile

Umbrella Mode

Traffic Shaping ~ Advanced  802.11u  Hotspot2.0

Unlimited(Defau)
200

Disabled
Enabled

Disabled

2

None

Ignore

Umbrella DHCP Override c

mDNS

mDNS Profile

None

Passive Client () ©

Ploase enable Glob:
when Global Multic:

Multicast IP

in Services->Media Stream. Passive Client will not work

led.

239.1.4.1 (%]

Matticast pirect ()
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Cisco Autonomous Access Points

When configuring Cisco Autonomous Access Points, use the following guidelines:

* Enable 802.11r (FT)

* Disable CCKM

* Disable 802.11k

* Disable 802.11v

*  Configure the Data Rates as necessary

*  Configure Quality of Service (QoS)

* Set the WMM Policy to Required

* Disable Aironet Extensions

* Disable Public Secure Packet Forwarding (PSPF)
*  Set IGMP Snooping to Enabled

802.11 Network Settings

It is recommended to operate the Cisco Desk Phone 9800 Series on the 5 GHz band only due to availability of many channels
and fewer interferers compared to the 2.4 GHz band.

To use 5 GHz, ensure the 802.11a/n network status is Enabled.

Save Configuration Ping Logout Refresh

CISCO HOME NETWORK ASSOCIATION WIRELESS SECURITY SERVICES MANAGEMENT SOFTWARE EVENT LOG

NETWORK

Hostname ap-1 ap-1 uptime is 1 day, 4 hours, 51 minutes

Network Interfaces: Summary

¥ NETWORK MAP
Summary

4

Adjacent Nodes

NETWORK
INTERFACE

Summary

IP Address
GigabitEthernetl
Radio0-802.11N 2.4GHz
Radio1-802.11AC 5GHz

System Settings

IP Address ( Static )

10.9.09

IP Subnet Mask

256.255.255.0

Default Gateway

10.9.02

MAC Address

18e7.281b.3f54

Interface Status

GigabitEthernet

Radio0-802. 11N2-45H2

Radio1-802.11AC5EH2

Software Status Enabled {1 Disabied ¥ Enabled 1

Hardware Status upft Down ¥ upft

Interface Resets 5 ] 8

It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps or higher as supported (optional) rates. However,
some environments may require 6 Mbps to be enabled as a mandatory (basic) rate.

When using 5 GHz, it is recommended to enable up to 12 channels only to avoid any potential delay in access point discovery
caused by scanning many channels.

For Cisco Autonomous Access Points, select Dynamic Frequency Selection (DFS) to use auto channel selection.
When DFS is enabled, enable at least one band (bands 1-4).
You can select band 1 only for the access point to use a UNII-1 channel (channel 36, 40, 44, or 48).

Individual access points can be configured to override the global setting to use dynamic channel and transmit power
assignment for either 5 or 2.4 GHz depending on which frequency band is to be utilized.

Other access points can be enabled for Auto RF and workaround the access points that are statically configured.
This may be necessary if there is an intermittent source of interference in the area.

The 5 GHz channel width can be configured as 20 MHz or 40 MHz for using Cisco 802.11n Access Points and as 20 MHz, 40
MHz, or 80 MHz for using Cisco 802.11ac Access Points.

It is recommended to utilize the same channel width for all access points.
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Enable Dot11d for World Mode and configure the proper Country Code.
Ensure Aironet Extensions is disabled.

Set the Beacon Period to 100 ms and DTIM to 2.

Save Configuration Ping Logout Refresh

HOME NETWORK ASSOCIATION WIRELESS SECURITY SERVICES MANAGEMENT SOFTWARE EVENT LOG

NETWORK (g m";‘%ﬁ;‘m e DETAILED STATUS SETTINGS T; CARRIER BUSY TEST 1
+ NETWORK MAP Hostname ap-1 ap-1 uptime is 1 day, 4 hours, 56 minutes
Summary
Adjacent Nodes
Network Interfaces: Radio1-B02.11AC5GHz Settings
- NETWORK
INTERFACE
Summary Enable Radio: © Enable " Disable
1P Address Current Status (Software/Hardware): Enabled {1 up it
GigabitEthernetd
Radio0-802.11N 2.4GHz Role in Radio Network: O Access Point
Access Point (Fallback to Radio Shutdown)
Radio1-802.11AC 5GHz ") Access Point (Fallback lo Repeater)
IRepeater
" Root Bridge
~ Non-Root Bridge
~ Root Bridge with Wireless Clients
" Non-Root Bridge with Wireless Clients
~Workgroup Bridge
~'Universal Workgroup Bridge  Client MAC: (HHHH.HHHH.HHHH)
'Scanner
" SpectrumSpectrum Infnrmalion@
Max-Client: “enable @ disable (1-255)
11r Configuration: ©enable  (disable
Qoverair overds Reassaciation-time: (20-1200 ms)
Data Rates: Best Range Best Throughput Default
6.0Mbisec | Require ' Enable O Disable
9.0Mbfsec  Require ~ Enable O Disable
12.0Mbisec ) Require _Enable _ Disable
18.0Mbfsec " Regquire © Enable _ Disable
24.0Mblsec " Require © Enable " Disable
36.0Mbisec | Require © Enable " Disable
48.0Mbisec  Require © Enable _ Disable
54.0Mblsec " Require © Enable " Disable
a0.1-2Mb/sec [ Require © Enable _ Disable
al.1-2Mb/sec Require © Enable _Disable
a2.1-2Mb/sec [ Require O Enable _Disable
a3.1-2Mb/sec ( Require © Enable _ Disable
ad.1-2Mb/sec [ Require © Enable _ Disable
a5.1-2Mb/sec Require © Enable _Disable
ab.1-2Mb/sec | Require @ Enable " Disable
a7.1-2Mb/sec [~ Require © Enable _ Disable
aB.1-2Mb/sec [ Require © Enable _ Disable
a9.1-4Mb/sec ( Require © Enable _Disable
al.2-2Mb/sec Require @ Enable " Disable
al.2-2Mbisec (_ Require © Enable _ Disable
a2.2-2Mbisec [ Require © Enable _ Disable
a3.2-2Mb/sec | Require © Enable _Disable
a4.2-2Mblsec " Require @ Enable " Disable
ab.2-2Mblsec " Require @ Enable _Disable
aB.2-2Mb/sec [ Require © Enable _ Disable
a7.2-2Mb/sec | Require © Enable _Disable
aB.2-2Mb/sec " Require @ Enable " Disable
a9.2-4Mb/sec " Require " Enable O Disable
al.3-2Mb/sec | Reguire @ Enable " Disable
a1.3-2Mb/sec | Require © Enable _Disable
a2.3-2Mblsec " Require @ Enable " Disable
a3.3-2Mblsec " Require @ Enable _Disable
a4.3-2Mb/sec (" Require © Enable _Disable
a5.3-2Mb/sec Require © Enable _Disable
ab.3-2Mb/sec " Require @ Enable " Disable
a7.3-2Mblsec " Require @ Enable _Disable
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a8.3-2Mb/sec Require © Enable Disable
a8.3-2Mb/sec Require ©Enable Disable

MCSRates: 0|1 |2 |3 (4|5|6 |7 8|9 |10 11(12|13/14 |15 16[17|18[19(20/21|22|23
Enable 1/ 0/ 0|0/0/0/0 000000000000 00000
Disable g
Transmitter Power (dBm): 15712 718 ()8 (13 @ Max Pimm
Client Power (dBm): Olocal 150 129 8 13 Max
DefaultRadic Channel: Channel 36 - 5180 MHz aChanneI 36 5180 MHz

Dynamic Frequency Selection Bands: Band 1 - 5.150 to 5.250 GHz
Band 2 - 5.250 t0 5.350 GHz
Band 3 - 5.470 to 5.725 GHz
Band 4 - 5,725 to 5.825 GHz

Channel Width: Below 40 MHz [ 20 MHz
World Mode .
Multi-Domain Operation: . Legacy © Dotttd
Country Code: o Indoor Qutdoor
Radio Preamble © Short Long
Antenna: a-antenna ab-antenna abec-antenna O abed-antenna
Internal Antenna Configuration: © Enable Disable
Antenna Gain(dBi): 0 (-128 - 128)
Gratuitous Probe Response(GPR): Enable © Disable

Period{Kusec): DISABLED (10-255)

Transmission Speed: neone a
Traffic Stream Metrics: Enable © Disable
Aironet Extensions: © Enable Disable
Ethernet Encapsulation Transform: © RFC1042 802.1H
Reliable Multicast to WGB: © Disable Enable
Public Secure Packet Forwarding: PSPF must be set per VLAN. See VLAN page
Beacon Privacy Guest-Mode: Enable © Disable
Beacon Period: 100 (20-4000 Kusec) Data Beacon Rate (DTIM): 2 (1-100)
Max. Data Retries: 64 (1-128) RTS Max. Retries: B4 (1-128)
Fragmentation Threshold: 2346  (256-2346) RTS Threshold: 2347 (0-2347)
Root Parent Timeout: 0 (0-65535 sec)
Root Parent MAC 1 (optional): {HHHH.HHHH.HHHH)
Root Parent MAC 2 (optional): {HHHH.HHHH.HHHH)
Root Parent MAC 3 (optional): {HHHH.HHHH.HHHH)
Root Parent MAC 4 (optional): {HHHH.HHHH.HHHH)

To use 2.4 GHz, ensure the 802.11b/g/n network status and 802.11g is enabled.

It’s recommended to set 12 Mbps as the mandatory (basic) rate and 18 Mbps or higher as supported (optional) rates assuming
that there will not be any 802.11b only clients that will connect to the wireless LAN. However, some environments may
require 6 Mbps to be enabled as a mandatory (basic) rate.

If 802.11b clients exist, then 11 Mbps should be set as the mandatory (basic) rate and 12 Mbps or higher as supported
(optional).

Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 87



WLAN Settings

It is recommended to have a separate SSID for the Cisco Desk Phone 9800 Series.

However, you can also use an existing SSID that is configured to support voice capable Cisco Wireless LAN endpoints.

The SSID to be used by the Cisco Desk Phone 9800 Series can be configured to only apply to a certain 802.11 radio type (e.g.

802.11a only).
Enable WPA2/WPA3 key management.

Ensure 11r is enabled for fast secure roaming.

HOME NETWORK ASSOCIATION WIRELESS SECURITY SERVICES

Security

Hostname ap-1

Admin Access

e Security: Global SSID Manager

Save Configuration Ping Logout

MANAGEMENT SOFTWARE EVENT LOG

ap-1 uptime is 1 day, 4 hours, 33 minutes

SSID Manager SSID Properties
Dotiliu Manager Current SSID List
Server Manager < NEW > SSID: vaice
AP Authentication dote. VLAN: . Defing VLANE
Intrusion Detection Backup 1:
Local RADIUS Server Backup 2:
Advance Security Backup 3:
Band-Select: — Band Select
Universal Admin Mode: "~ Universal Admin Mode
Interface: | Radio0-802.11N24CHz
Radio1-802.11AC5CHz
Network ID: (0-4096)
Delete
Client Authentication Settings
Methods Accepted:
Open Authentication: with EAP
| Web Authentication "~ Web Pass
| Shared Authentication: < NO ADDITION>
@ Network EAP: < NO ADDITION >
Server Priorities:
EAP Authentication Servers MAC Authentication Servers
© Use Defaults  Define Defaults © Use Defaults Define Defaults
) Customize ~) Customize
Priority 1: | < NONE > Priority 1: | < NONE >
Priority 2: | < NONE > Priority 2: | < NONE >
Priority 3: < NONE > Priority 3: | < NONE >
Client Authenticated Key M
Key Management: Mandatory —1 CCKM Enable WPA  wPavZ dot1r
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WPA Pre-shared Key: © Ascll
11w Configuration: Disable

11w Association-comeback: 1000 (1000-20000)

11w Saquery-retry: 100 (100-500)

Hexadecimal

IDS Client MFP

Enable Client MFP on this SSID: = Optional

AP Authentication

Credentials: < NONE > Define Credentials
Authentication Methods Profile: < NONE > Define Authentication Methods Profiles

Accounting Settings

" Customize

_| Enable Accounting Accounting Server Priorities:

© Use Defaults Define Defaults

Priority 1: | < NONE >

Priority 2: < NONE >

Priority 3: | < NONE »

Rate Limit Parameters

Limit TCP:

~ Input: Rate: Burst-Size: (0-500000)
~| Output: Rate: Burst-Size: {0-500000)
Limit UDP:

~| Input: Rate: Burst-Size: (0-500000)
—| Output: Rate: Burst-Size: {0-500000)

General Settings

| Advertise Extended Capabilites of this SSID

| Advertise this SSID as a Secondary Broadcast SSID

| Enable IP Redirection on this SSID

|P Address:  DISABLED
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IP Filter (optional): = < NONE > Define Filter
Association Limit (optional): (1-255)
EAP Client (optional):
Username: Password:
Multiple BSSID Beacon Settings
Multiple BSSID Beacon
"~ Set SSID as Guest Mode
|Set DataBeacon Rate (DTIM): DISABLED  (1-100)
Apply Cancel
Guest Mode/Infrastructure SSID Settings
Radio0-802.11N24CHz;
Set Beacon Mode: _Single BSSID Set Single Guest Mode SSID: < NONE »
© Multiple BSSID
Set Infrastructure SSID: = < NONE > | Force Infrastructure Devices to associate only to this SSID
Radio1-802.11AC5CHz;
Set Beacon Mode: " Single BSSID Set Single Guest Mode SSID: < NONE >
© Multiple BSSID
Set Infrastructure SSID: < MONE > | Force Infrastructure Devices to associate only to this SSID
Apply Cancel

Segment wireless voice and data into separate VLANS.

Ensure that Public Secure Packet Forwarding (PSPF) is not enabled for the voice VLAN, as this would prevent clients from

communicating directly when associated with the same access point. Enabling PSPF in this scenario would result in audio
communication being disrupted.

i
CIsCO HOME NETWORK ASSOCIATION WIRELESS

Saye Configuration  Ping  Logout Refresh

SECURITY SERVICES MANAGEMENT SOFTWARE EVENT LOG

Services

Hostname ap-1 ap-1 uptime is 1 day, 4 hours, 48 minutes

Telnet/SSH
cop Global VLAN Properties
DNS
Current Native VLAN:  VLAN 10
Filters
HTTP Assigned VLANs
Qos Current VLAN List Create VLAN Define SSIDs
Stream _
< NEW »
SNMP VLAN 2
. s 14004
SNTP VLAN 10 VLAN ID: ( )
VLAN VLAN Name (optional):
ARP Caching Delete ~ Native VLAN
TR _ Enable Public Secure Packet Forwarding
Auto Config

| Radio0-802.11N24GHz
Radio1-802.11AC5GHz

— Management VLAN (If non-native)

Apply Cancel

VLAN Information

View Information for:  VLAN 2

GigabitEthernet Packets Radio0-802.11N2-4GHz Packets Radio1-802.11AC5CHZ Packets
Recelved 65884 65884
Transmitted 5462 5462
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Ensure AES is selected for encryption type.

Configuration g Logout

VENT LOG

Security
Hostname ap-1 ap-1 uptime is 1 day, 4 hours, 32 minutes
Admin Access

Secu = tion Ma
Encryption Manager EivaEnayetonBonsosy

SSID Manager Set Encryption Mode and Keys for VLAN: 3 Define VLANS
Dotliu g

Server Manager L L

AP Authentication  None
Intrusion Detection
Local RADIUS Server ~) WEP Encryption _ Optional
Advance Security Cisco Compliant TKIP Features: | Enable Message Integrity Check (MIC)

| Enable Per Packet Keying (PPK)

© Cipher AES CCMP
Encryption Keys
Transmit Key Encryption Key (Hexadecimal) Key Size
Encryption Key 1: : 128 bit
Encryption Key 2: [ 128 bit
Encryption Key 3: - 128 bit
Encryption Key 4: 128 bit

Global Properties

Broadcast Key Rotation Interval: © Disable Rotation

" Enable Rotation with Interval: DISABLED  (10-10000000 sec)

WPA Group Key Update: " Enable Group Key Update On Membership Termination

| Enable Group Key Update On Member's Capability Change

Configure the RADIUS servers for authentication and accounting.

Cisco

Security f SERVER MANAGER

GLOBAL PROPERTIES |

Hostname ap-1 ap-1 uptime is 1 day, 4 hours, 42 minutes
Admin Access

Encryption Manager Security: Server ager

SSID Manager Backup RADIUS Server
Dotllu Manager .
IP Version: QIPva 1PVE
Server Manager
Backup RADIUS Server Name:
AP Authentication
Intrusion Detection Backup RADIUS Server: (Hostname or IP Address)
Local RADIUS Server Shared Secrat:
Advance Security Apply Delete Cancel
Corporate Servers
Current Server List
RADIUS
IP Version: ©IPva CIPVE
KU Server Name: 10.0.0.20
10808 Server: 100020 (Hostname or IP Address)
Shared Secret:
Delete Authentication Port (optional): 1312 (0-65535)
Accounting Port (optional): 1813 (0-65535)
Apoly Cancel
Default Server Priorities
EAP Authentication MAC Authentication Accounting
Priority 1: | 10.0.0.20 Priority 1: < NONE > Priority 1:  10.0.0.20
Priofity 2: < NONE » Priority 2: < NONE > Priority 2: | < NONE >
Priority 3 < NONE » Priority 3 < NONE > Priority 3: < NONE >
Admin Authentication (RADIUS) Admin Authentication (TACACS+)
Priority 1: | < NONE » Priority 1: < NONE »
Priority 2: | < NONE » Priority 2: < NONE >
Priority 3: | < NONE » Priority 3: < NONE >
Apply Cancel
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Wireless Domain Services (WDS)

Wireless Domain Services should be utilized in the Cisco Autonomous Access Point environment, which is also required for
fast secure roaming.

Select an access point as the primary WDS server and another as the backup WDS server.

Configure the primary WDS server with the highest priority (e.g. 255) and the backup WDS server with a lower priority (e.g
254).

Saye Configuration  Ping Logout Refresh

cisco HOME NETWORK ASSOCIATION WIRELESS SECURITY SERVICES MANAGEMENT SOFTWARE EVENT LOG
Wireless Services £ WDS STATUS e GENERAL SET-UP e SERVER GROUPS )
Hostname ap-1
AP

ap-1 uptime is 1 day, 4 hours, 50 minutes

Wireless Services: WDS/WNM - General Set-Up

WDS - Wireless Domain Services - Global Properties

Use this AP as Wireless Domain Services
‘Wireless Domain Services Priority: 255 (1-255)

| Use Local MAC List for Client Authentication

WNM - Wireless Network Manager - Global Configuration

~ Configure Wirel Network M

Wireless Network Manager Address: DISABLED (IP Address or Hostname)

The Cisco Autonomous Access Points utilizes Inter-Access Point Protocol (IAPP), which is a multicast protocol. Therefore, it
is recommended to a dedicated native VLAN for Cisco Autonomous Access Points.
For the native VLAN, it is recommended to not use VLAN 1 to ensure that IAPP packets are exchanged successfully.
Port security should be disabled on switch ports that Cisco Autonomous Access Points are directly connected to.
MM

Save Configuration Ping Logout Refresh
SECURITY SERVICES MANAGEMENT SOFTWARE EVENT LOG

CISCO HOME NETWORK ASSOCIATION WIRELESS

Services
Hostname ap-1 ap-1 uptime is 1 day, 4 hours, 48 minutes
Telnet/SSH
coP Global VLAN Properties
DNS
Current Native VLAN:  VLAN 10
Filters
HTTP Assigned VLANs
Qos Current VLAN List Create VLAN Define SSIDs
Stream —_—
< NEW >
SNMP VLAN 2
VLAN 3 . 10 1-4094
swte veAN (1o
VLAN VLAN Name (optional):
ARP Caching Delete Native VLAN
e | Enable Public Secure Packet Forwarding
Auto Config

| Radio0-802.11N2-4CHz
Radio1-802.11ACSCHz

| Manag VLAN (if ative)

Apply Cancel

VLAN Information

View Information for:  vLAN 2

GigabitEthernet Packets Radio0-802.11N2-46Hz Packets Radio1-802.11AC5CHz Packets
Received 65884 65884
Transmitted 5462 5462
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Server groups for Wireless Domain Services must be defined.

First, define the server group to be used for infrastructure authentication.
Is recommended to use local RADIUS for infrastructure authentication.
When not using local RADIUS for infrastructure authentication, ensure that all access points with Wireless Domain Services
enabled are configured in the RADIUS server.

Save Configuration  Ping  Logout ~Refresh

cisco HOME NETWORK ASSOCIATION WIRELESS SECURITY SERVICES MANAGEMENT SOFTWARE EVENT LOG
Wireless Services 5 WDS STATUS \: GENERAL SET-UP A SERVER GROUPS b
Hostname ap-1 ap-1 uptime is 1 day, 4 hours, 51 minutes
AP

WDs Wireless Services: WDS - Server Groups

Server Group List

Server Group Name: WDS

< NEW >
Group Server Priorities: Define Servers
Delete Priority 1: | 10.8.0.9
Priofity 2: < NONE >
Priority 31 < NONE >
Use Group For:

© Infrastructure Authentication

_) Client Authentication
Authentication Settings SSID Settings
| EAP Authentication © Apply to all SSIDs
) LEAP Authentication _ Restrict SSIDs (Apply only to listed SSIDs)
| MAC Authentication SSID: DISABLED Add
| Default (Any) Authentication 711 Remave

Then, define the server group to be used for client authentication.

Ensure that all access points with Wireless Domain Services enabled are configured in the RADIUS server.

Save Configuration  Ping  Logout Refresh

cISCOo HOME NETWORK ASSOCIATION WIRELESS SECURITY SERVICES MANAGEMENT SOFTWARE EVENT LOG
Wireless Services & WDS STATUS \: GENERAL SET-UP A SERVER GROUPS b
Hostname ap-1 ap-1 uptime is 2 days, 2 hours, 31 minutes
AP

wDs Wireless Services: WDS - Server Groups

Server Group List

Server Group Name: Clients

< NEW >
WDS
Group Server Priorities: Define Servers
Delete Priority 1:  10.0.0.20
Priority 2: < NONE >
Priority 3: < NONE >
Use Group For:
_ Infrastructure Authentication

© Client Authentication

Authentication Settings S8ID Settings
EAP Authentication © Apply to all SSIDs
LEAP Authentication " Restrict SSIDs (Apply only to listed SSIDs)
| MAC Authentication SSID: DISABLED Add
| Default (Any) Authentication 711 Remove
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To utilize local RADIUS for infrastructure authentication, enable all authentication protocols.
Create a Network Access Server entry for the local access point.
Define the user account used to configure access points for authentication to the Wireless Domain Services enabled

access point.

Configure local RADIUS on each access point participating in Wireless Domain Services.

CIsco

Saye Configuration  Ping Logout Refresh

HOME NETWORK ASSOCIATION WIRELESS SECURITY SERVICES MANAGEMENT SOFTWARE  EVENT LOG

Security

Admin Access
Encryption Manager
SSID Manager
Dotliu Manager
Server Manager

AP Authentication
Intrusion Detection
Local RADIUS Server

Advance Security

[t STATISTICS A

GENERAL SET-UP (&

EAP-FAST SET-UP )

Hostname ap-1

ap-1 uptime is 1 day, 4 hours, 43 minutes

Security: Local RADIUS Server - General Set-Up

Local Radius Server Authentication Settings

Confirm Password:

Enable Authentication Protocols: EAP FAST
LEAP
MAC
Apply Cancel
Network Access Servers (AAA Clients)
Current Network Access Servers
:0':;“"9’ Network Access Server: 10.9.08 (IP Address)
Shared Secret:  seesessesses
Delete
Apply Cancel
Individual Users
Current Users
Tenews> | Username: wids
Password: = sssssesssssssssssssassssasasnns " Text @ NT Hash

Delete Group Name: < NONE >
~| MAC Authentication Only
Apply Cancel
User Groups
Current User Groups
Group Name:
< NEW >
Session Timecut (optional): (1-4294967295 sec)
Delete Failed Authentications before Lockout (optional): (1-4294967295)
Lockout (optional): 1 Infinite
© Interval (1-4284967295 sec)
VLAN ID (optional):
SSID (optional): Add
Delete
Apply Cancel

Once the desired access points have been configured successfully to enable Wireless Domain Services, then all access points
including those serving as WDS servers need to be configured to be able to authenticate to the WDS servers.
Enable Participate in SWAN Infrastructure.
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When using a single WDS server, specify the IP address of the WDS server. Otherwise, enable Auto Discovery.
Enter the Username and Password to authenticate to the WDS server.

Save Configuration Ping Logout Refresh

CISCO HOME NETWORK ASSOCIATION WIRELESS SECURITY SERVICES MANAGEMENT SOFTWARE EVENT LOG

Wireless Services

Hestname ap-1 ap-1 uptime is 1 day, 4 hours, 50 minutes

AP
D Wireless Services: AP
Participate in SWAN Infrastructure: © Enable ) Disable
WDS Discovery: ' Auto Discovery
© Specified Discovery: 10.8.08 {IP Address)
Username: wds
Password: FTTTT T
Confirm Password:
;:ng‘:’;’f‘;’;a_ < NONE > Define Authentication Methods Profiles

Once the access point has been configured to authenticate to the WDS server, you can check WDS Status to view the WDS
server state as well as how many access points are registered to the WDS server.
alvaln

Save Configuration Ping Logout Refresh

ASSOCIATION WIRELESS SECURITY SERVICES MANAGEMENT SOFTWARE  EVENT LOG

Cisco HOME

I

NETWORK

WDS STATUS = GENERAL SET-UP = SERVER GROUPS il

Wireless Services

Hostname ap-1 ap-1 uptime is 1 day, 5 hours, 1 minute

AP
WDS Information
MAC Address IPv4 Address IPvE Address Priority State
1807.281b.3154 10909 255 A owatively StandAlone
WDS Registration
APs: 1 Mobile Nodes: 0
AP Information
Hostname MAC Address IPv4 Address IPvE Address zenir;hbor State
ap-1 18e7.281b.3f54 10.8.0.9 Switch-2.gil | REGISTERED
Mobile Node Information
MAC Address IP Address State SSID VLAN ID BSSID
Wireless Network Manager Information
IP Address Authentication Status

_
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Call Admission Control (CAC)

Disabled.

QoS Policies

Configure the following QoS policy on the Cisco Autonomous Access Point to enable DSCP to CoS (WMM UP) mapping.

This allows packets to be placed into the proper queue as long as those packets are marked correctly when received at the

access point level.

Cisco

Services

Telnet/SSH
Hot standby
coP

DNS

Filters

HTTP

Qos

Stream
SNMP

SNTP

VLAN

ARP Caching
Band Select
Auto Config

HOME NETWORK ASSOCIATION  WIRELESS

Save Configuration  Ping Logout Refresh

SECURITY  SERVICES MANAGEMENT SOFTWARE EVENT LOG

Hostname ap-1

QoS POLICIES ]/E

RADIO0-802.11N24GHZ
ACCESS CATEGORIES

RADIO1-802.11ACSGHZ
ACCESS CATEGORIES

ADVANCED 1

ap-1 uptime is 1 day, 4 hours, 44 minutes

Create/Edit Policies

Create/Edit Policy:

Policy Name:

Voice

Voice

Classifications:

DSCP - COS Centrolled Load (4)
DSCP - COS Video < 100ms Latency (5)
DSCP - COS Veoice < 10ms Latency (8)

Delete Classification

Match Classifications: Apply Class of Service
IP Precedence: Routine (0} Best Effort (0) Add
IP DSCP: ©  BestEffort Best Effort (0) Add
B (0-63)
IP Protocol 119 Best Effort (0) Add
Filter: No Filters defined. Define Filters.
Default Classification for Packets on the VLAN: Best Effort (0) Add
Rate Limiting:
Bits per Sec.: (8000-2000000000)  Burst Rate (Bytes): (1000-512000000)
Conform Action: _ Transmit Exceed Action: Drop Add
Apply Delete Cancel
Apply Policies to Interface/ VLANs
VLAN 2 Radio0-802,11N24GHz Radio1-802.11AC5GHz GigabitEthernet0
Incoming Data Data
Outgoing Data Data
VLAN 3 Radio0-802.11N24CHz Radio1-802.11AC56H2 GigabitEthernet0
Incoming Voice Voice
Outgoing < NONE » < NONE >
... |
VLAN 10 Radio0-802.11N24GHz Radio1-802.11AC5CHz GigabitEthernetd
Incoming < NONE > < NONE >
Outgeing < NONE > < NONE >
Apply Cancel

- s
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To enable QBSS, select Enable and check Dotl1e.

If Dotl1e is checked, then both CCA versions (802.11¢ and Cisco version 2) will be enabled.

Ensure IGMP Snooping is enabled.

Ensure Wi-Fi MultiMedia (WMM) is enabled.

Save Configuration  Ping

Logout ~ Refresh

cisco

Services

Telnet/SSH
Hot standby
CcDP

DNS

Filters
HTTP

Qos
Stream
SNMP

SNTP

VLAN

ARP Caching
Band Select
Auto Config

If you enable the Stream feature either directly or via selecting Optimized Voice for the radio access category in the QoS
configuration section, then use the default settings. These defaults include enabling 5.5, 6, 11, 12 and 24 Mbps as nominal

HOME

NETWORK ~ ASSQOCIATION

WIRELESS SECURITY SERVICES MANAGEMENT SOFTWARE EVENT LOG

[E QoS POLICIES

[,

RADIOO-802.11N24GHZ |2
ACCESS CATEGORIES |~

RADIO1-802.11ACCHZ =
/ACCESS CATEGORIES

Hostname ap-1

ADVANCED

| —

ap-1 uptime is 1 day, 4 hours, 47 minutes

Services: QoS Policies - Advanced

IP Phone

QoS Element for Wireless Phones :

© Enable Dot1e

" Disable
IGMP Snooping
Snooping Helper: @ Enable ' Disable
AVVID Priority Mapping
Map Ethernet Packets with CoS 5to CoS6: () Yes @ No

WIFi MultiMedia (WMM)

Radio0-802.11N216Hz

Radio1-802.11AC5GHz

Enable on Radio Interfaces:

rates for 802.11b/g, 6, 12, and 24 Mbps for 802.11a and 6.5, 13, and 26 Mbps for 802.11n.

If the Stream feature is enabled, ensure that only voice packets are placed into the voice queue. Signaling packets (SIP)
should be placed into a separate queue. This can be achieved by setting up a QoS policy mapping the DSCP to the correct

queue.

cisco

HOME

NETWORK ~ ASSOCIATION

WIRELESS  SECURITY

Save Configuration  Ping

Logout  Refresh

SERVICES MANAGEMENT SOFTWARE EVENT LOG

Services

Telnet/SSH
Hot standby
coP

DNS

Filters

ARP Caching
Band Select
Auto Config

S RADIOOBO21{NZAGHZ |2

Hostname ap-1

RADIO1-802.11ACSGHZ |

ap-1 uptime Is 1 day, 4 hours, 48 minutes

User Priority

CoS 0 (Best Effort)

oS 1 (Background)

CoS 2 (Spare)

CoS 3 (Excellent)

CoS 4 (Controlled Load)

CoS 5 (Video)

oS 6 (Voice)

oS 7 (Network Control)

6.0Mb/sec:

9.0Mb/sec :
12.0Mb/sec :
18.0Mb/sec :
24.0Mb/sec :
36.0Mb/sec :
48.0Mbfsec:

54.0Mb/sec :

Low Latency Packet Rates:

Packet Handling per User Priority:

Packet Handling

Reliable

Reliabie

Reliable

Reliabie

Reliable

Reliable

Reliabie

Reliable
_) Nominal (") Non-Nominal
) Nominal ~ Non-Nominal
) Nominal (" Non-Nominal
_) Nominal (") Non-Nominal
) Nominal ~ Non-Nominal
) Nominal ~ Non-Nominal
" Nominal " Non-Nominal
) Nominal ~ Non-Nominal

Max Retries for Packet Discard
NODISCARD  {0-128)
NODISCARD  (0-128)
NODISCARD  (0-128)
NODISCARD  (0-128)
NODISCARD  (0-128)
NODISCARD  {0-128)
NODISCARD  (0-128)

NODISCARD  {0-128)

© Disable
© Disable
© Disable
© Disable
© Disable
© Disable
© Disable

© Disable

Apply

Cancel
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Power Management

Proxy ARP helps answer any ARP requests on behalf of the device.
To enable Proxy ARP, set Client ARP Caching to Enable.
Also ensure that Forward ARP Requests To Radio Interfaces When Not All Client IP Addresses Are Known is checked.

Save Configuration  Pin Logout  Refresh
vl Ll Bing  Logout R

CISCO HOME NETWORK  ASSOCIATION WIRELESS SECURITY SERVICES MANAGEMENT SOFTWARE EVENT LOG
Services
Hostname ap-1 ap-1 uptime Is 1 day, 4 hours, 50 minutes
Telnet/SSH
Hot standby Services: ARP Caching
CDP . " S
Client ARP Caching: © Enable Disable
DNS
Filters
o Forward ARP Requests To Radio Interfaces When Not All Client IP Addresses Are Known
Qos
Stream
T

Cisco Meraki Access Points

When configuring Cisco Meraki access points, use the following guidelines:
* Enable 802.11r for WPA2/WPA3-Enterprise or Pre-shared key

* Set Splash page to None

* Enable Bridge mode

* Enable VLAN tagging

* Set Band selection to S GHz band only

* Configure the Data Rates as necessary

* Configure Quality of Service (QoS)

Creating the Wireless Network

A wireless network must be created prior to adding any Cisco Meraki access points to provide WLAN service.
Select Create a new network from the drop-down menu.
Select Wireless for Network type then click Create.
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asco Meraki

Meraki MX64

Network-wide

Security & SD-WAN

Organization

Cisco Meraki access points can be claimed either by specifying the serial number or order number.
Once claimed, those Cisco Meraki access points will then be listed in the available inventory.
Cisco Meraki access points can be claimed by selecting Add Devices on either the Create network or Organization >

Q

Create network

Setup network

Networks provide a way to logically group, configure, and monitor devices. This is a useful way to separate
physically distinct sites within an Organization. €&

Network name

Network type Wireless ~ O

Network configuration © Default Meraki configuration
Bind to template No templates to bind to @

Clone from existing network b

Select devices from inventory

You have no unused devices

Add new device o the inventory page to select devices

that are already in

Go to inventory

rks

Create network

Configure > Inventory pages.

Access points can also be claimed by selecting Add APs on the Wireless > Monitor > Access points page, then selecting

Claim.

Claim by serial and/or order number

Enter one or more serial/order numbers (one per row). Where can | find these numbers?

Once claimed, Cisco Meraki access points can be added to the desired wireless network via the Organization > Configure >

Inventory page.
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asco  Meraki

Meraki WLAN

Network-wide

Wireless

Organization

Q

Inventory

View used and unused devices in your organization. You can claim new devices to add the list below.

Add to ... | Unclaim Unused Used Both |Searchinventory
© Existing network g e
Meraki WLAN v ELY) MR53

4/29/2020 2:59 PM

New network

Claimed access points can also be added to a wireless network by selecting Add APs on the Wireless > Monitor > Access

points page.

asco Meraki

Meraki WLAN

Q

Add access points

Add access points from your organization's inventory. When you claim an order by order number, the
devices in the order will be added to your inventory. When you claim a device by its serial number, that
device will be added to your inventory. Once in your inventory, you can add devices to your network(s).

Network-wide Search inventory

Wireless MAC address Serial number

88:15:44:60:18:6c

Organization

SSID Configuration

Q2ZMD-MWQS-J9K7

Maodel + Claimed on

MR53 4/29f2020 2:59 PM

To create an SSID, select the desired network from the drop-down menu then select Wireless > Configure > SSIDs.
It is recommended to have a separate SSID for the Cisco Desk Phone 9800 Series. Data clients and other type of clients should

utilize a different SSID and VLAN.

However, you can also use an existing SSID that is configured to support voice capable Cisco Wireless LAN.

To set the SSID name, select Rename.
To enable the SSID, select Enabled from the drop-down menu.

il

asco Meraki a

= Configuration overview

Meraki WLAN SSIDs Showing 4 of 15 SSIDs. Show all my SSIDs.
meraki-voice
Enabled enabled [
Network-wide Name rename
Access control edit settings
Wireless Encryption 802.1X with Meraki RADIUS
Sign-on method None
Organization Bandwidth limit unlimited
Client IP assignment Local LAN
Clients blocked from using LAN no
Wired clients are part of Wi-Fi network no
VLAN tag @ 3
VPN Disabled
Splash page
Splash page enabled no
Splash theme nfa
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On the Wireless > Configure > Access control page, select WPA2-Enterprise to enable 802.1x authentication.
The Cisco Meraki authentication server or an external RADIUS server can be utilized when selecting WPA2-Enterprise.
The Cisco Meraki authentication server supports PEAP authentication and requires a valid email address.

Other authentication types (e.g. Pre-Shared Key) are available as well.

Ensure 802.11r is enabled

Ensure Splash page is set to None to enable direct access.

mm " r
asco Merak

WLAN

Network-wide

Wireless

Organization

Q, Search Dashboard

Access control

SSID:  meraki-voice

Network access

Association requirements

WPA encryption
mode

80Z2.11r @

80Z.11w O

Splash page

Open (no encryption)
Any user can associate

Pre-shared key (PSK)
Users must enter a passphrase to associate

MAC-based access control (no encryption)
RADIUS server is queried at association time

© Enterprise with | Meraki Cloud Authentication [
User credentials are validated with 802.1X at association time

WPAZ only ded for most [

Enabled [

Disabled (never use) o

© None (direct access)
Users can access the network as soon as they associate

If WPA2-Enterprise is enabled where the Cisco Meraki authentication server will be utilized as the RADIUS server, then a
user account must be created on the Network-wide > Configure > Users page, which the Cisco Desk Phone 9800 Series will
be configured to use for 802.1x authentication.

Note: Cisco Meraki access points do not support EAP-FAST.

Create user
Account type: Meraki 802.1X

Description:
Email (Username):

Password: Generate

Authorized: No |
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On the Wireless > Configure > Access control page, it’s recommended to enable Bridge mode. This configuration allows
the Cisco Desk Phone 9800 Series to obtain DHCP from the local LAN instead of the Cisco Meraki network, unless call
control, other endpoints, etc. are cloud-based.

Once Bridge mode is enabled, the VLAN tagging option will be available.

It is recommended to enable VLAN tagging for the SSID.

If VLAN tagging is utilized, ensure that the Cisco Meraki access point is connected to a switch port configured for trunk mode
allowing that VLAN.

For more information about Cisco Meraki MS Switches, refer to the Cisco Meraki MS Switch VoIP Deployment Guide.
https://meraki.cisco.com/lib/pdf/meraki_whitepaper msvoip.pdf

when utilizing Cisco IOS Switches, use the following switch port configuration for ports that have Cisco Meraki access points
connected to enable 802.1q trunking.

Interface GigabitEthernet X

switchport trunk encapsulation dotlq

switchport mode trunk

mls qos trust dscp

alialn Meraki Addressing and traffic

CIsCo

Client IP assignment NAT mode: Use Meraki DHCP
Clients receive IP addresses in an isolated 10.0.0.0/8 network. Clients cannot communicate with each other, but they may
communicate with devices on the wired LAN if the SSID firewall settings permit.

Meraki WLAN © Bridge mode: Make clients part of the LAN

Meraki devices operate transparently (no NAT or DHCP). Wireless clients will receive DHCP leases from a server on the LAN or
use static IPs. Use this for wireless clients requiring seamless roaming, shared printers, file sharing, and wireless cameras.

Network-wide Layer 3 roaming
Clients receive DHCP leases from the LAN or use static IPs, similar to bridge mode. If the client roams to an AP where their
original IP subnet is not available, then the client's traffic will be forwarded to an anchor AP on their original subnet. This allows

Wireless ) . )
the client to keep the same IP address, even when traversing IP subnet boundaries.

Organization Layer 3 roaming with a concentrator
Clients are tunneled to a specified VLAN at the concentrator. They will keep the same |P address when roaming between APs.

VPN: tunnel data to a concentrator
Meraki devices send traffic over a secure tunnel to an MX concentrator.

VLAN tagging € Use VLAN tagging B
Bridge mode and layer 3

roaming only

VLANID ©

AP tags VLANID Actions
All other APs | 3
Add VLAN

Content filtering € Don't filter content

NAT mode only

Bonjour forwarding @ Enable Bonjour Gateway o

Bridge mode and layer 3

roaming only
There are no Bonjour forwarding rules on this network.
Add a Bonjour forwarding_rule

On the Wireless > Configure > Access control page, you can configure the frequency band for the SSID to be used by the
Cisco Desk Phone 9800 Series as needed.

It is recommended to select 5 GHz band only to operate the Cisco Desk Phone 9800 Series on the 5 GHz band due to
availability of many channels and fewer interferers compared to the 2.4 GHz band.

If the 2.4 GHz band needs to be used due to increased distance, then Dual band operation (2.4 GHz and 5 GHz) should be
selected. Do not utilize the Dual band operation with Band Steering option.

Is recommended to disable data rates below 12 Mbps unless a legacy 2.4 GHz client needs to connect to the Wireless LAN.
Cisco Meraki access points currently utilize a DTIM period of 1 with a beacon period of 100 ms. These settings are non-
configurable.

Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 102



s
Cisco

Meraki

K

Meraki WLAN

Network-wide

Wireless

Organization

Wireless options

Band selection and minimum bitrate settings may be overridden by RF profiles.

Band selection

Minimum bitrate (Mbps)
[i]

Go to RF Profiles

Dual band operation (2.4 GHz and 5 GHz)

© 5 GHz band only
5 GHz has more capacity and less interference than 2.4 GHz, but legacy clients are not capable of using it.

Dual band operation with Band Steering
Band Steering detects clients capable of 5 GHz operation and steers them to that frequency, while leaving 2.4 GHz available
for legacy clients.

Lower Density Highar Density

12 65 6 E 12 ® 22 £ 48 54

802.11b devices not supported

On the Wireless > Configure > SSID availability page, the SSID can be broadcasted by setting Visibility to Advertise this

SSID publicly.

Is recommended to set Per-AP Availability to This SSID is enabled on all APs.
A schedule for SSID availability can be configured as needed. However, it is recommended to set Scheduled Availability to

Disabled.

Hmm
CISCO

Meraki

Meraki WLAN

Network-wide
Wireless

Organization

Radio Settings

On the Wireless > Configure > Radio settings page, access points can be configured in bulk or individually to define the

Q

SSID:
Visibility

Per-AP availability ©

Scheduled availability

SSID availability

meraki-voice B

Advertise this 5SID publicly ||
This SSID is enabled on all APs B

disabled [

automatic or manual channel and transmit power settings.
When using Cisco Meraki access points, it is recommended to select Auto for the channel and transmit power to utilize what is

defined in the RF Profile.

However, individual access points can be configured with static channel and transmit power for either 5 or 2.4 GHz radios.

This configuration may be necessary if there is intermittent interference in the area. While other access points can be enabled

for Auto and work around the access points that are have static channel assignments.

vl

asco Me

NE

Meraki WLAN

Network-wide

Wireless

Organization

Radio settings

BAND

Overview RF profiles

5 - All

Status @ AP name.

MR53

CHANNEL

AP TAG RF PROFILE REGULATORY DOMAIN
- MR53 s All - FCC Edit
Update auto channels Edit settings... =
Target power Transmit power
Channel Ch. Width (MHz) {dBm) 6 (dBm} & RF Profile F
36 (Auto) 20 8-30 8 Basic Indoor Profile
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It is recommended to either modify the standard Basic Indoor Profile or create a new RF Profile with Band selection set to
Per SSID and Client balancing set to Off.

"tves’ Meraki a

RF PROFILES

Edit Basic Indoor Profile
Meraki WLAN

General 24GHz 5GHz

Network-wide

General
Wireless i
.
Organization
The Access Points configured to use this profile will follow the band selection set on the Access Control page for the respective SSID.
date.
Minimum bitrate © Perband
configuration

Set the minimum bitrates for the 2.4 & 5 GHz radios separately below.

Per SSID

The Access Points configured to use this profile will follow the minimum
bitrate selection set on the Access Control page for the respective SSID. Per
SSID minimum bitrate selection will be moved to RF profiles at a later date.

Client balancing On

Client Balancing uses information about the state of the network and wireless client probes to steer the
client to the best available access point during association. Read more about client balancing here.

alvaln

asco Meraki

Q

RF PROFILES

Edit Basic Indoor Profile

NE
Meraki WLAN

General 24GHz 5GHz

Network-wide
General

Wireless i
.

Organization

The Access Points configured to use this profile will follow the band selection set on the Access Control page for the respective SSID.
date.

Minimum bitrate © Perband

i ti . i
conhguration Set the minimum bitrates for the 2.4 & 5 GHz radios separately below.

Per SSID

The Access Points configured to use this profile will follow the minimum
bitrate selection set on the Access Control page for the respective SSID. Per
SSID minimum bitrate selection will be moved to RF profiles at a later date.

Client balancing on

Client Balancing uses information about the state of the network and wireless client probes to steer the
client to the best available access point during association. Read more about client balancing here.

In the RF Profile, the Channel width for 5 GHz radios can be set to use 20 MHz, 40 MHz, or 80 MHz channels.

2.4 GHz radios utilize 20 MHz channel width and cannot be configured for any other channel width.

It is recommended to utilize the same channel width for all access points.

5 GHz channels to be used by AutoChannel can also be configured in the RF Profile.

2.4 GHz channels used by AutoChannel are limited to channels 1, 6, and 11 only.

The Radio transmit power range is also be configured in the RF Profile.

If the Minimum bitrate configuration is set to Per band, then it will override what is defined in the SSID configuration.
It is recommended to disable data rates below 12 Mbps unless a legacy 2.4 GHz client needs to be able to connect to the
Wireless LAN.

Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide 104



N mim General 2.4GHz 5GHz

asco Me

NETWORK 5 GHz radio settings

Meraki WLAN Turn off 5GHz radio See band selection above.

Channel width Auto
s

Network-wide

Wireless Manual 5 GHz channel width

Organization Disable auto channel width by manually selecting a channel width for the APs in this profile.

20 MHz (19 channels)
Recommended for High Density deployments and environments expected to
encounter DFS events. More unique channels available, reducing chance of
interference.

© 40 MHz (10 channels)

For low to medium density deployments.

80 MHz (5 channels)

For low density areas with few or zero neighboring networks. Higher
bandwidth and data rates for modern devices. Increases risk of interference
problems.

Channel assignment method AutoChannel will assign radios to channels with low interference.
Change channels used by AutoChannel...

Radio transmit power range

Transmit shorter distance Transmit farther
{dBm)
O O
4 5 & 7 3 8 W 11 12 1 W 15 1 17 18 18 0 M| 22 33 M/ " ¥ W ;| M
Set RX-SOP...
Minimum bitrate
Lower Density Higher Dansity

5 ] 12 it 24 s 42 B4

Change 5 GHz channels used by AutoChannel

Available channels for AutoChannel

If you deselect a channel, AutoChannel will not assign It to any AP with this profile. Ciick on a channal to toggle lts selection.

UNili-1 N2 UNIl-2-Extended

o EICIEIEICEEIEIED - -

40 MHz

38 46 54 62
0 MHz

DFS channels Deselect DFS channals

Firewall and Traffic Shaping

On the Wireless > Configure > Firewall & traffic shaping page, firewall and traffic shaping rules can be defined.
Ensure a Layer 3 firewall rule is configured to allow local LAN access for wireless clients.

To allow traffic shaping rules to be defined select Shape traffic on this SSID in the drop-down menu for Shape traffic.
Once Shape traffic on this SSID has been applied, then select Create a new rule to define Traffic shaping rules.

By default, Cisco Meraki access points currently tag voice frames marked with DSCP EF (46) as WMM UP 5 instead of
WMM
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UP 6 and call control frames marked with DSCP CS3 (24) as WMM UP 3 instead of WMM UP 4.
‘dseo. Meraki a
N . Firewall & traffic shaping

Meraki WLAN SSID: | meraki-voice o

Block IPs and ports

Network-wide

Layer 2 LAN isolation Disabled [§ (bridge mode only)
Wireless Layer 3 firewall rules € # Policy b, | Destinath Port C Actions
Allow Any Local LAN Anr Wireless clients accessing LAN
Organization B Y 4 g
Allow Any Any Any  Default rule

Add a layer 3 firewall rule

Block applications and content categories

Layer 7 firewall rules There are no rules defined for this SSID.
Add a layer 7 firewall rule

Traffic shaping rules

Per-client bandwidth limit  unlimited

details Enable SpeedBurst
Per-SSID bandwidth limit unlimited

details
Li]
Shape traffic Shape traffic on this SSID 2]
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Configure Cisco Call Control

Cisco Webex Calling

You can add Cisco Desk Phone 9800 Series to Cisco Webex Calling and assigned it to a user for personal usage or as a

workspace for shared usage.

Personal Usage

You can assign Cisco Desk Phone 9800 Series to a user and configure the settings in on Control Hub.

| Cisco 9861

e Online - Phones -+ & WebexAware - Device platform: &4

Overview  History

Details

16

Lines.

64103.40.25
Host IP address

PHONEOS.3-1-1-0004-20240522-
172ed9f1ba
Seftware version

Cisco
Managed By

Tags

+ Add tag

Workspace Usage

You can configure Cisco Desk Phone 9800 Series as a workspace device on Control Hub.

84:5A:3E:C2:18:14
MAC address

10.230.38164
Remote IP address

Latest
Software Channel

Add Device

Assign to an existing workspace or a new workspace?
Select Existing Workspace to activate a device if the previous code has been lost or has expired, or to have multiple devices in a workspace.
If you add multiple devices in a workspace that are not designed to work together, it may create interference issues

Existing Workspace

Search for a Workspace

Which Workspace will the device be assigned to?
Workspaces containing devices that are not Gisco IP Phones will not be shown, since you can only have one of these devices in
workspace.

Connected Peripherals

Cisco 9800 KEM

Hoteling

Allow this device to be used as a Hoteling Host by visiting guests.

) JNOj

Limit the time a guest can use this phone to
24 Hours

Configurations

& All configurations

B configuration templates

New Workspace

Back
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Add Device

Assign to an existing workspace or a new workspace?
Select Existing Workspace to activate a device if the previous code has been lost or has expired, or to have multiple devices in a workspace.
If you add multiple devices in a workspace that are not designed to work together, it may create interference issues.

Existing Workspace New Workspace

Where will this device be located?

What would you like to call the Workspace that this device will be assigned to?

Insert name of device location, e.g. 'Reception' or 'Bo.

Back

Wi-Fi Capability

On Cisco Control Hub, ensure that Wi-Fi is enabled to use a Cisco Desk Phone 9800 Series in wireless environment.

© Configure — O Review — O Summary.

Regional Control Timer Values. e

Phone Language v
SiP i o

User Preferred Offhook Timer o

Software Upgrade Channel =

System Bluetooth Enabled
leeg8021x
Optionsl Network Configuration
Uss Settings
VLAN Settings

Web Access

R AR AR AR A

Wifi Enabled

Defaut @ undo

Gisco 0861 [ V) @ Facory ©
ves

Yes

No
Thousand Eyes

Cisco Unified Communications Manager
Cisco Unified Communications Manager offers different phone, calling, and security features.

Device Enablement

To enable the Cisco Desk Phone 9800 Series device type in the Cisco Unified Communications Manager, the corresponding
device package COP file must be installed via the Cisco Unified Operating System Administration webpage for each Cisco
Unified Communications Manager server.
Each Cisco Unified Communication Manager node may not have to be restarted after the device package COP file has been
installed.
Perform the following actions based on the Cisco Unified Communications Manager version.
12.5(1) and higher

* Restart the Cisco Tomcat service on all Cisco Unified Communications Manager nodes.

* If running the Cisco CallManager service on the publisher node, restart the service on the publisher node

only.
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Note: The Cisco CallManager Service on subscriber nodes do not need to be restarted.

For information on how to install COP file, refer to the Cisco Unified Communication Manager Operation System

Administration Guide at this URL:

https://www.cisco.com/c/en/us/support/unified-communications/unified-communications-manager-

callmanager/productsmaintenance-guides-list.html

When adding the Cisco Desk Phone 9800 Series to the Cisco Unified Communications Manager, it must be provisioned using
the Ethernet MAC address as the Wireless LAN MAC is used for Wi-Fi connectivity only.
The Ethernet MAC address of the Cisco Desk Phone 9800 Series can be found by navigating to Settings > About this device

on the phone.

r Device Information

B Device is trusted

MAC Address*

Description

Device Poal* -- Mot Selected --

Common Device Configuration < None >

Phone Butten Termplate® -- Mot Selected --

Softkey Template < Mone >

Common Phane Profile * Standard Common Phone Profile

Common Settings

|l View Details
|l View Details

|l View Details

Some settings such as Wireless LAN can be configured on an enterprise phone through common phone profile or at individual

phone level.

Wireless LAN is automatically disabled temporarily when Ethernet is connected to the Cisco Desk Phone 9800 Series and will
be automatically re-enabled once Ethernet is disconnected if Wi-Fi is enabled on the phone.

Override common settings can be enabled at either configuration level.
Wi-Fi* Enabled B

QoS Parameters

The DSCP values for SIP communications, phone configuration, and phone-based services are defined in the Cisco Unified

Communications Manager’s Enterprise Parameters.

The default DSCP value for SIP communications and phone configuration is set to CS3.

Phone-based services are configured to be best effort traffic by default.

r Enterprise Parameters Configuration

Parameter Name Parameter Value

Cluster ID * StandAloneCluster

Max Number of Device Level Trace * 12

DSCP for Phone-based Services * default DSCP (000000)

DSCP for Phone Configuration * CS3{precedence 3) DSCP (011000)

DSCP for Cisco CallManager to Device Interface  £53(precedence 3) DSCP {011000)
3

Connection Monitor Duration * 120

Auto Registration Phone Protocal * SCCP
Auto Registration Legacy Mode * False
BLF For Call Lists * Disabled
Advertise G.722 Codec * Enabled
Phone Persenalization * Disabled

*

Services Provisioning Internal

Feature Control Policy < None =

Wi-Fi Hotspot Profile < None =

IMS Inter Operator Id * IMS Inter Operator Identification
URI Lookup Policy * Case Sensitive

Cisco Desk Phone 9800 Series Wireless LAN Deployment Guide

Suggested Value
StandAloneCluster

12
| default DSCP {000000)
d CS3({precedence 3) DSCP {011000)
d CS3(precedence 3) DSCP {011000)

120
d SCCP
|4 False
|4 Disabled
| Enabled
| <] Disabled
& Internal

<)
&

IMS Inter Operator Identification

<] Case Sensitive
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Wireless LAN Profiles

With Cisco Unified Communications Manager 10.0 release and later, you can provision the Cisco Desk Phone 9800 Series
with Wireless LAN Profiles. EAP-TLS support is included.

Create a Wirless LAN Profile

Follow the following steps to provision your phone with a Wireless LAN profile on Cisco Unified Communications Manager.

o Before creating a Wireless LAN Profile and associating it with your phone, the phone should be configured to
utilize a security profile with TFTP encryption enabled. This prevents Wireless LAN Profile data from being

transmitted in clear text to the phone.

Phone Security Profile Configuration

D Save x Delete Copy % Reset Z Apply Config lﬁl} Add New

 Status

@ Status: Ready

— Phone Security Profile Information

Product Type: Cisco 9871
Device Protocol: SIP
Name™ |Cisco 9871 - Standard SIP Secure Profile

Description |Cisco 9871 - Standard SIP Secure Profile

Nonce Validity Time* |600

Device Security Mode [ Encrypted

Transport Type* [TLS

D Enable Digest Authentication
TFTP Encrypted Config
D Enable OAuth Authentication

o Once the security profile has been created, it must be applied to the phone to enable TFTP encryption for the

phone’s configuration files.

o Select the configured security profile from the Device Security Profile drop-down menu.

 Protocol Specific Information

Packet Capture Mode * [ None

Packet Capture Duration ‘0

BLF Presence Group* [Standard Presence group
SIP Dial Rules (< None >

MTP Preferred Originating Codec* | 711law

Device Security Profile*

Cisco 9871 - Standard SIP Secure Profile

Rerouting Calling Search Space < None >

<

SIP Profile®

SUBSCRIBE Calling Search Space [< None >
( standard SIP Profile

View Details

Digest User [< None >

<

|:| Media Termination Point Required
D Unattended Port

O Require DTMF Reception

1. To create a Wireless LAN Profile, navigate to Device > Device Settings > Wireless LAN Profile within the
Cisco Unified Communications Manager’s Administration interface.

2. From the Wireless LAN Profile page, select Add New.
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alml  Cisco Unified CM Administration
cisco For Cisco Unified Communications Solutions

System » Call Routing v Media Resources »  Advanced Features » Device v  Application «  User Management =  Bulk Administration + Help

Find and List Wireless LAN Profiles

EDiAddNew

Wireless LAN Profile

Find Wireless LAN Profile where Name begins with Find Clear Filter dhl | =

Mo active query. Please enter your search criteria using the options above.

Add New

Specify the Name, Description, Wireless Settings (SSID, Frequency Band, User Modifiable), and
Authentication Settings for the profile.
Below are Wireless LAN Profile defaults:

* Frequency Band = Auto

* User Modifiable = Allowed

* Authentication Method = EAP-FAST

alimlin  Cisco Unified CM Administration l
CisCo S, . S

For Cisco Unified C 15

System = Call Routing = Media Resources »  Advanced Features = Device »  Application «

Wireless LAN Profile Configuration
LB Save

r Status

® Status: Ready
r Wireless LAN Profile Information
Name*
Description
User Modifiable® | Allowed
- Wireless Settings
SSID (Network Name)™®
Frequency Band* Auto
~Authentication Settings
Authentication Method®  Eap-FAST
| Provide Shared Credentials
Password Description
r Network A Settings
Metwork Access Profile < None = View Details
Save

o Enter a Name for the Wireless LAN Profile containing up to 50 characters.
e Optionally, enter the Description containing up to 63 characters.

Narme*

Description

e Select Allowed in the User Modifiable drop-down list.
The user has the capability to change any Wireless LAN settings (e.g. Enable/Disable, SSID, Frequency
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Band, Authentication Method, Username and Password, PSK Passphrase, WEP Key) locally on the endpoint.

Note: For Cisco Desk Phone 9800 Series, users are allowed to change the WLAN settings regardless of this
parameter.

D Save x Delete Copy d\} Add New

Status

@ Status: Ready

Wireless LAN Profile Information

Name* l Isc-test ]

Description -- Not Selected -- -:]

User Modifiable* v Allowed

Disallowed - 2000 0@

Wireless Setting  Restricted

SSID (Network Name)* I Isc-test

Frequency Band* [Auto v

o Enter an SSID containing up to 32 ASCII characters.

SSID (Network Name)™

o Select the desired Frequency Band option.
* Auto = Gives preference to 5 GHz channels, but operates on both 5 GHz and 2.4 GHz channels
* 2.4 GHz = Operates on 2.4 GHz channels only
* 5 GHz = Operates on 5 GHz channels only

Frequency Band * Auto

(03]

o Select the desired Authentication Method option.
* [f EAP-FAST, PEAP-MSCHAPvV2, or PEAP-GTC is selected, the option to enter shared credentials
(Username and Password) is available.
* If Provide Shared Credentials is not checked, the Username and Password will need to be configured
locally on the phone by the admin or user.

Authentication Method®  Eap-FAST

B

| Provide Shared Credentials
Password Description

Authentication Method* | peAP-GTC

| Provide Shared Credentials
Password Description

Authentication Method* | pEAP-MSCHAPV2

| Provide Shared Credentials
Password Description

« If Provide Shared Credentials is checked, then the specified Username and Password will be utilized for
all Cisco Desk Phone 9800 Series that utilize this Wireless LAN Profile.

* Up to 64 characters can be entered for the Username and Password.

* Optionally enter the Password Description.
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Authentication Method* | Eap-FAST B

@ Provide Shared Credentials

Username
Password

show password

Password Description

* f EAP-TLS is selected, User Certificate must be configured to specify the type of user certificate to utilize
for EAP-TLS authentication.
* Set User Certificate to MIC (Manufacturing Installed Certificate), LSC (Locally Significant Certicate) or
User Installed.

Authentication Method*  Eap-TLS

User Certificate® MIC

Authentication Method*  Eap-TLS

(o] ol ol <

User Certificate ® User Installed

 If PSK is selected to utilize Pre-Shared Key authentication, a PSK Passphrase must be entered.
The PSK Passphrase must be in one of the following formats:

* 8-63 ASCII character string

* 64 HEX character string

* A Password Description can optionally be entered.
Authentication Method*  psg d

PSK Passphrase™

show passphrase

Password Description

* If None is selected, then no authentication is required, and no encryption will be utilized.
Authentication Method® | none B
Note: Cisco Desk Phone 9800 Series doesn’t support WEP or LSC ECC certificate.
* The Cisco Desk Phone 9800 Series does not support the Network Access Profile option.

e Select Save once the Wireless LAN Profile configuration is complete.

Create a Wirless LAN Profile Group

1. To create a Wireless LAN Profile Group, navigate to Device > Device Settings > Wireless LAN Profile Group
within the Cisco Unified Communications Manager’s Administration interface.
2. From the Wireless LAN Profile Group page, select Add New.
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ahul  Cisco Unified CM Administration
cisco For Cisco Unified Communications Solutions

System » Call Routing v Media Resources ~  Advanced Features v Device v  Application v  User Manag it +  Bulk Admini ion + Help

Find and List Wireless LAN Profile Groups
DR Add New

Wireless LAN Profile Group

Find Wireless LAN Profile Group where = Group Name begins with Find Clear Filter e | =

Mo active query. Please enter your search eriteria using the options above.

Add New

3. Specify the Name, Description, and select the Wireless LAN Profile to add.

Wireless LAN Profile Group Configuration

B Save x Delete Copy ::G: Add New

r Status

@ Update successful

 Wireless LAN Profile Group Infor

Name* |9871 |
Description | |

 Profiles for this Wireless LAN Profile Group

Available Profiles Gorilla-dot1x-hide

Test
for_test
gulian_eap
gulian_open

v A

* %
Selected Profiles BTHuUb5-86GN

"

Note: Only one Wireless LAN Profile should be added to a Wireless LAN Profile Group.
4.  Select Save once the Wireless LAN Profile Group configuration is complete.

Apply a Wireless LAN Profile Group to a Device Pool

Once the Wireless LAN Profile Group has been created, it can be applied to a Device Pool or an individual
phone.

1. To apply a Wireless LAN Profile Group to a device pool, navigate to System > Device Pool in the Cisco Unified
Communications Manager’s Administration interface.

2. If you want to apply the WLAN profile to an existing device pool, do the following actions:
a. Find the device pool and open it.
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b. Inthe Roaming Sensitive Settings section, select your WLAN profile in the Wireless LAN Profile Group list.

r Device Pool Settings
Device Pool Name* [9871 |
Cisco Unified Communications Manager Group * [Defau"; V]
Calling Search Space for Auto-registration [< None > V]
Adjunct CSS [ < None > v
Reverted Call Focus Priority [Default "]
Intercompany Media Services Enrolled Group [< None > V]
MRA Service Domain [< None > "]
r Roaming Sensitive Settings
Date/Time Group* [ntpﬁserver V]
Region* [ Default hd ]
Media Resource Group List [< None > "]
Location [ < None > "]
Network Locale [ < None > "]
SRST Reference* | Disable ¥)
Connection Monitor Duration®** |
Single Button Barge™* [Defau|t V]
Join Across Lines™* [Default "]
Physical Location [ < None > V]
Device Mobility Group [ < None > "]
Wireless LAN Profile Group [9871 V]M

c. Select Save.
d. Select Apply Config.
3. If'you want to apply the WLAN profile to a new device pool, do the following actions:
Select Add New to create a Device.
Specify the name and the required information.
In the Roaming Sensitive Settings section, select your WLAN profile in the Wireless LAN Profile Group list.
Select Save.
Select Apply Config.
Go to Device > Phone, and find your phone that you want to add to the device pool.

R R =

In the Device Information section, select the device pool that you created in the Device Pool drop-down list.

 Device Information

E Device is Active

Device is trusted

MAC Address* |845A3EC211B6 | (SEP845A3EC211B6)
Description IAuto 99899 l

Current On-Premise Onboarding_Method is set to Autoregistration. Activation Code will only apply to onboarding via MRA.

O Require Activation Code for

Onboarding

Allow Activation Code via MRA
Activation Code MRA Service Domain [-- Not Selected -- VI View Details
Device Pool * (9871 V] View Details
Common Device Configuration |< None > VI View Details
Phone Button Template* [DocTest ModelD 118 Lines Button Template VH Find ]
Softkey Template [< None > v
Common Phone Profile® [standard Common Phone Profile v| View Details

o o — Y

h. Select Save.
i.  Select Apply Config.
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Apply a Wireless LAN Profile Group to an Individual Phone

1. Navigate to Device > Phone in the Cisco Unified Communications Manager’s Administration interface.

2. Find your phone and open the Phone Configuration page.

3. In the Device Information section, select your WLAN profile group in the Wireless LAN Profile Group drop-
down list.

4. Select Save.

5. Select Apply Config.
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Configure the Cisco Desk Phone 9800 Series

Automatic Provisioning

This method is currently available only for phones registered to Cisco Unified Communications Manager. For automatic
provisioning of the Wi-Fi Profiles, the Cisco Desk Phone 9800 Series needs to be connected to a network via Ethernet or via
Wi-Fi, which has connectivity to the Cisco Unified Communications Manager.

With connectivity to a Cisco Unified Communications Manager 10.0 or later, Wi-Fi profile configuration data can be
downloaded and applied to the Cisco Desk Phone 9800 Series.

Cisco Unified Communications Manager 11.0 or later is required to download and apply a Wi-Fi profile including EAP-TLS
authentication.

For more information, see the Cisco Unified Communications Manager > Wireless LAN Profiles section.

Certificates can also be automatically installed upon a network connection.

For more information, see the Simplified Certificate Enrollment Protocol (SCEP) section.

Config/Modify Wi-Fi Profile via Phone Web Portal

Ensure that your Cisco Desk Phone 9800 Series has got a valid IP address either by wired or wireless connection.
Note: The phone web portal is available only for phones registered to Webex Calling or Cisco BroadWorks.

1. Enter the IP address of the phone in your web browser address bar.

For example, http://10.64.84.147/

Click Admin Login and then click advanced to access the configurations as an administrator.

Go to Voice > System.

Set Phone-wifi-on to Yes to turn on Wi-Fi on the phone.

Specify the Wi-Fi network name and credentials for the phone to connect to the wireless access point.

DA

The Security Mode can be any of the following depending on the settings on your access point.

o If Auto, EAP-FAST, or PEAP is selected then Wi-Fi User ID and Wi-Fi Password are required.
« If PSKis selected to utilize Pre-Shared Key authentication, then a PSK Password must be entered.

The PSK Password must be 8-63 ASCII character string.

* If WEP is selected to utilize static WEP (Wired Equivalent Privacy) authentication, then a WEP Key must be
entered.

+ If None is selected, then no authentication is required and no encryption will be utilized.

+ If Auto is selected, the phone could dynamically choose EAP-FAST or EAP-PEAP as authentication method
based on communication with target AP.

« If EAP-TLS is selected, currently only MIC certificate is supported for phones registered to Webex Calling/
Webex DI/Broadworks.

Select the desired Frequency Band:

* Auto: Gives preference to 5 GHz channels, but operates on both 5 GHz and 2.4 GHz channels
* 2.4 GHz: Operates on 2.4 GHz channels only
* 5 GHz: Operates on 5 GHz channels only
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http://10.64.84.147/

ol I 1ol I 1, Cisco IP Phone for 3rd Part

cisco DP-9871t

O & 1074.151.106/admin/advanced

Call History | Personal Directory
< | system SIP | Provisioning = Regional = Phone Ext1 Ext2 Ext3 Ext4 Ext5 Ext6 Ext7 Ext8 Ext9 Ext 10 Ext 11 Ext 12 Ext13 Ext 14
LBy MOUS VRIS, (V0| Funaly w1 Seiver.
‘Secondary NTP Server: Use Config TOS:  No -
Siplog Server:
VLAN Settings
VLANID: 1 PCPort VLAN ID: 1
Enable CDP: | Yes - Enable LLDP-MED:  Yes -
DHCP VLAN Option:
'Wi-Fi Settings
Phone-wifi-on:  Yes -
Wi-Fi Profile 1
Network Name: ~ xin-wpa3-23-SAE Security Mode:  PSK
Wi-Fi User ID: WicFi Password;  ssssssesssess
Frequency Band: 5 GHz
. .
6. Click Submit All Changes.
You can go to the Info > Status tab to view the network status.
<« c O R 1074.151.106 &

lll'.|||l Cisco IP Phone for 3r

cisco DP-9871 figu

Info i Call History | Personal Directory

Status Debug Info  Download Status = Network Statistics

System Information
Host Name:
Primary NTP Server:
Bluetooth Enabled: No

‘SEP845A3EC2302B
10.64.58.51

Domain:

Secondary NTP Server:

Bluetooth Connected:  No

crdc.cisco.com

Bluetooth MAC: Connected Device ID:
Active Interface: ~ Wireless Wireless MAC:  84:5A:3E:C2:30:2D
8SID:  xin-wpa3-23-SAE AP MAC: 6C:8B:D3:F0:02:EF
Channel: 64 Frequency: 5320 MHz

Security Mode:  PSK

Notes:

*  The phone reboots when switching from an access point to another..

*  When the phone is connected via Ethernet connection, Wi-Fi is turned off. When the Ethernet cable is
unplugged, the phone connects to the wireless network automatically if properly configured.

* The Wi-Fi settings are synchronized to the settings in the phone Settings menu.

Configure Wi-Fi Settings on the Phone Ul

1. Press Settings n

2. If prompted, enter the password to access the Settings menu.
3. Navigate to Network and service > Network settings.
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4. If Wi-Fi status is Off, turn on Wi-Fi. The phone starts scanning available wireless network.

Network settings CO:\ |'(|-:ec::ntnt:m\{e\lclj-|:l

@ Cable connection is recommended if available

Wi-Fi
Wi-Fi On

TP-LINK_24G

IP stack IPv4 and IPv6
( Scanning networks...
IPv4 settings

Join other network
IPv6 settings

VLAN

9861 9871

5. Ifyou are using a 9861 phone, press Select to open the Connect to Wi-Fi screen. If you are on a 9871 phone, go
to the next step.

6. Select your access point from the available networks and enter your credentials if the network requires
authentication.

The security mode and available frequency bands depends on the settings of the access point.
If the network is 802.1x-enabled, the phone will dynamically select Auto for the EAP type, which is determined
by the RADIUS server configuration. You can select the inner authentication method.

Security mode
Auto
EAP-FAST

EAP-PEAP

EAP-TLS

7. Select Apply.
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Join a Hidden Wireless Network

Press Settings ﬂ

If prompted, enter the password to access the Settings menu.

Navigate to Network and service > Network settings.

If Wi-Fi status is Off, turn on Wi-Fi.

Select Wi-Fi and then select Join other network .

Enter the network name, select the security mode, and enter the credentials.

AN

Join other network Join other network Apply

Network name :] Enter network information

Security mode FER D Network name

Password |

Security mode

Frequency band Auto >
Password

Frequency band

9861 9871
Ensure that you select the proper security mode based on the settings of the access point.

* None: Select this option if the wireless network to connect is an open network. No password is needed.

*  PSK: If your network is secured with Pre-Shared Key or WPA3-SAE, select this option and enter the
password. Pre-Shared Key length is 8~~63 bytes.

*  Auto/EAP-FAST/EAP-PEAP: When you select any of these options, user ID and password are
required.

* EAP-TLS: When you select this option, the user certificate type is required. Currently, only
Manufacturing installed certificate (MIC) is supported.
Note: Certificate Management and root CA install is currently available only with Webex
Calling/DI/Broadwork.

7. Select Apply.

Delete a Connected Network
User can delete the currently connected AP in the Settings menu.

1. In the Network settings screen, select the access point that the phone is connected to.
2. Select Forget or Forget this network depending on your phone model.

BTHub5-86GN TP-LINK_24G

® Connected ® Connected

1 Security mode

Security mode

2 Advanced Wi-Fi details

Forget this network
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Certificate Management

The Cisco Desk Phone 9800 Series can utilize X.509 digital certificates for EAP-TLS or to enable Server Validation.

A User Certificate can be installed either automatically via Simple Certificate Enrollment Protocol (SCEP) or manually via the
phone’s admin webpage interface (https://<phone IP address>:8443).

Only one certificate per certificate type is allowed; 1 User Certificate and 1 Server Certificate (either via SCEP or manual
method).

LSC certificate is installed by CUCM CAPF service.

Once a certificate is installed, Server Validation is automatically enabled if configured for EAP-TLS

Microsoft® Certificate Authority (CA) servers are recommended. Other CA server types may not be completely interoperable
with the Cisco Desk Phone 9800 Series.

Both DER and Base-64 (PEM) encoding are acceptable for the client and server certificates.

Certificates with a key size of 1024, 2048, and 4096 are supported.

Ensure the client and server certificates are signed using either the SHA-1 or SHA-2 algorithm, as the SHA-3 signature
algorithms are not supported.

Ensure Client Authentication is listed in the Enhanced Key Usage section of the user certificate details.

Manual Installation

Ensure that the admin webpage interface is Enabled, the username is admin, and the Admin password is configured by
CUCM.

Web Admin* Enabled ﬂ

Admin Password ssesassssssssstttstsasatasnsn

Open manual install page via https://x.x.x.x:8443

User Sign In

Cisco IP Phone DP-9861 ( SEP845A3EC22785 )

! ion Username

Password
Setup

Certificates Submit

You can utilize either the internal Manufacturing Installed Certificate (MIC), LSC or a custom User Installed certificate as the
User Certificate for EAP-TLS.

Manufacturing Installed Certificate (MIC)

The pre-installed Manufacturing Installed Certificate (MIC) can be used as the User Certificate for EAP-TLS.

The MIC’s CA chain must be exported and added to the RADIUS server’s trust list to use the MIC as the User Certificate for
EAP-TLS.

Click Export to download the root and sub CA certificates from the admin webpage interface.

m Cisco IP Phone DP-9861 ( SEP845A3EC22785 )

Device information Type ‘Common name Issuer name Valid from Valid to
CN=CP-9861-SEP845A3EC22785, O=Cisco, OU=TPM

Signed in as admin, Sign out]

Certificates

Network setup ing i “N=Hi “A, O=Cis 44 :58:
s Manufacturing issued SUDI serialNumber=PID:DP-9861 SN:FVH281623FV CN=High Assurance SUDI CA, O=Cisco 05/07/2024 02:44:00 08/09/2099 20:58:26
Setup
Certficat Manufacturing CA CN=High Assurance SUDI CA, O=Cisco 0=Cisco, CN=Cisco Root CA 2099 08/11/2016 20:28:08 08/09/2099 20:58:27 Export
ertificates
o Manufacturing root CA 0=Cisco, CN=Cisco Root CA 2099 0=Cisco, CN=Cisco Root CA 2099 08/09/2016 20:58:28 08/09/2099 20:58:28 Export
Network statistics
User installed <Not installed> <Not installed> Install

Ethernet information
v Authentication server CA <Not installed> <Not installed> nstall

Network

This root CA should added to Radius server's trust list.

User Installed Certificate

To manually install a user certificate for EAP-TLS, select Install for User Installed on the main Certificates webpage.
Select Browse to point to the user certificate in PKCS #12 format (.p12 or .pfx).

Enter the Extract password, then select Upload.

Ensure the CA chain that issued the user certificate is added to the RADIUS server’s trust list.
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Signed in as admin, Sign out

Certificates
Cisco IP Phone DP-9861 ( SEP845A3EC22785 )
Device information Select file (.p12 or .pfx) to upload: | Browse... | No file selected.
Network setup
Extract password:
Setup
Certificates Upload |

Will need to restart the Cisco Desk Phone 9800 Series after all certificates are installed.

Signed in as admin, Sign out

Certificates
Cisco IP Phone DP-9861 ( SEP845A3EC21655 )
Device information Authentication Server CA certificate has been updated.
Network setup Phone will use the new certificate after reboot. You can restart the phone with:
Setup "System/Restart"
Certificates

LSC Certificate
Enable CAPF service on CUCM.

A o A

Login to Cisco Unified CM Administration.

Enter System -> Service Parameters.

Select your CUCM server.

Select Cisco Certificate Authority Proxy Function.

Select certificate issuer in Certificate Issuer to Endpoint.

If Online CA is selected, you should configure the external CA in Online CA Parameters.

If Cisco Certificate Authority Proxy Function is selected, the build-in CAPF function is used.
Click Save button.

aliml  Cisco Unified CM Administration CPLRCN T N EVEELIIY Cisco Unified CM Administration v
CIS€O  ror Cisco Unified Communications Solutions admin About Logout
System ¥ Call Routing ¥ Media Resources v Advanced Features v Device v ication v  User v Bulk ini ion v Help v
Service Parameter Configuration LCIEVEL R IEH Parameters for All Servers v § Go
D Save {9 Set to Default
 Status

@ Status: Ready

Select Server and Service

Server* [10.77.46.225--CUCM Voice/Video (Active) v)

Service* [ Cisco Certificate Authority Proxy Function (Active) v |

All parameters apply only to the current server except parameters that are in the cluster-wide group(s).

Cisco Certificate Authority Proxy Function (Active) Parameters on server 10.77.46.225--CUCM Voice/Video (Active)

?

Online CA Username ‘

Parameter Name Parameter Value Suggested Value
Certificate Issuer to Endpoint * [Online CA v] Cisco Certificate Authority Proxy Function
Duration Of Certificate Validity (in days) * [1825 ] 1825
Maximum Allowable Time For Key Generation * [30 ] 30
Maximum Allowable Attempts for Key Generation * (3 |3
rOnline CA Parameters
Online CA Hostname [cucMez2.cA.cisco.com |
Online CA Port ‘443 ]
Online CA Template ‘CiscoRAJ ]
Online CA Type * ( Microsoft CA + | Microsoft CA

Online CA Password ‘

Certificate Enrollment Profile Label

Save | | Set to Default
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Service Parameter Configuration

1 sev &P setopsin

’ @ s venty

[ Select Server and

Server® 10.79.57.147--CUCM Voice/Video (Active) v
Service® Cisco Certificate Authority Proxy Function (Active) v

All parameters apply only to the current server except parameters that are in the cluster-wide group(s).

[ Cisco Certificate Authority Proxy Function (Active) Parameters on server 10.79.57.147--CUCM « )

Parameter Name

Parameter Value
Certificate Issuer to Endpoint *

Cisco Certificate Authority Proxy Function
1825

30

3

n OF Certificate Vs

(in days) *
Time For Key Generation *
mpts for Key Generation *

Online CA

Suggested Value

Cisco Certificate Authority Proxy Function
1825

30

3

Online CA Type *
Online CA Username

Online CA Password

Online CA Hostname
Online CA Port

Online CA Template

ccmadministrator
Microsoft CA v Microsoft CA

Certificate Enroliment Profile Label

Active or restart CAPF server

1.

Sk whh

Login Cisco Unified Serviceability.

Enter Tools -> Service Activation.

Select your CUCM server.

Ensure that Cisco Certificate Authority Proxy Function is Activated.
Enter Tools -> Control center Feature Service.

Choose and restart Cisco Certificate Authority Proxy Function.

Install LSC certificate to Cisco Desk Phone 9800 Series

bl e

Login to Cisco Unified CM Administration.
Enter Device -> Phone, then enter the profile page of your device.

Select Install/Upgrade in Certificate Operation, then Save and Apply.
Espresso will install the LSC and reboot.

-Certification Authority Proxy Function (CAPF) Information

Certificate Operation* [ Install/Upgrade v]
Authentication Mode* [By Existing Certificate (precedence to LSC) V]
Authentication String

Generate String
Key Order* [ RSA Only v]
RSA Key Size (Bits)* [2048 v]

EC Key Size (Bits)

Operation Completes By (YYYY:MM:DD:HH)

Certificate Operation Status: Operation Pending
Note: Security Profile Contains Addition CAPF Settings.

Check Phone LSC status via Settings > Network and services > Security settings

Security settings

Security mode Non secure

LSC Installed >

Trust list >

802.1X Authentication >

Select
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Import CAPF CA to ISE.

Export LSC CA cert from CUCM.
If Online CAPF is used, user should ask external CA cert from admin. If build-in CAPF is used, user can download CA cert
from CUCM.

1. Login to Cisco Unified OS Administration

2. Enter Security -> Certificate Management

3. Download the CAPF Identity certificate

Certificate List (1-140f 14)

Find Certificate List where | Certificate v | begins with v |CAPF \'Find || Clear Filter]\: L) H = \
\\ Select item or enter search text VJ
Certificate * Common Name/Common Name_SerialNumber Usage Type 1";?:3 Distribution
CAPF CAPF-50aa97cf Identity Self- RSA  cucm-225
signed

Import LSC certificate to trust list.
Ensure that the CA chain of LSC certificate is added to the RADIUS server’s trust list.

“thali- Identity Services Engine Home » Context Visibility » Operations (ST~ Administration » Work Centers
~System | b Identity » Network » Device Portal pxGrid Services ) Feed Service  » Threat Centric NAC
Deployment  Licensing v Certificates  » Logging ~ » Maintenance ~ Upgrade  » Backup & Restore  » Admin Access b Settings
o
~ Certificate Management Trusted Certificates
System Certificates 7 Edit ofeImport | @ Export = 3¢ Delete JOView
Trusted Cerificates [ Friendly Name + | status Trusted For Serial Number Issued To Issued By
) Cisco Services
s EleriFels [ 802.1x_mingjzho_4096CA B Enabled Endpoints OF3A91F2B363... test.sipura.cisco.com test.sipura.cisco.com
Cerificate Signing Requests Infrastructure
[ ASULIU-SCEP-CA#ASULIU-SCEP-CA#00009 Enabled Infrastructure 62F754B081B9 ... ASULIU-SCEP-CA ASULIU-SCEP-CA
Certificate Periodic Check Setf... [ asuliu-SUBCA#ASULIU-SCEP-CA#00008 @ Enabled Infrastructure 1472 4E9A 0001 ... asuliu-SUBCA ASULIU-SCEP-CA

» Certificate Authority Baltimore CyberTrust Root 2 Enabled Cisco Services 0200 00 B9 Baltimore CyberTrust Ro... Baltimore CyberTrust Ro...
Infrastructure
[ cAPF-50aa97cf Enabled g:s;;’;’“es 6A4F 99 F8 B9 CO ... CAPF-50aad7ch CAPF-50aa97cf

Server Certificate

The root CA certificate that issued the RADIUS server’s certificate must be installed for EAP-TLS or to enable Server
Validation. Service Validation is optional. If user doesn't want it, this step could be dropped.

To manually install a server certificate, select Install for Authentication Server CA on the main Certificates webpage.
Select Browse to point to the server certificate with PEM (Base-64) or DER encoding.

Signed in as admin, Sign out

Certificates
Cisco IP Phone DP-9861 ( SEP845A3EC22785 )
Device information Select file (.cer) to upload: | Browse... | No file selected.
Network setup .
. | Upload
Setup h

Will need to restart the Cisco Desk Phone 9800 Series after all certificates are installed.

Signed in as admin, Sign out

Certificates
Cisco IP Phone DP-9861 ( SEP845A3EC21655 )
Device information Authentication Server CA certificate has been updated.
Network setup Phone will use the new certificate after reboot. You can restart the phone with:
Setup ""System/Restart"
Certificates

Certificate Removal

User Installed Certificates can be removed via the admin webpage interface. To remove a certificate via the admin webpage,
select Delete for the corresponding certificate, then restart the phone once a certificate has been removed.
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Signed in as admin, Sign out

Certificates

Cisco IP Phone DP-9861 ( SEP845A3EC21655 )
Device information Type Common name Issuer name Yalid from Valid to
CN=CP-9861-SEP845A3KC21655, O=Cisco, OU=TPM

Network setup

st Manufacturing issued SUDL, serialNumber=PID:DP-9861 SN:FVH280322J6 CN=High Assurance SUDI CA, O=Cisco 01/29/2024 05:06:35 08/09/2099 20:58:26
Setup
Cotificats Manufacturing CA CN=High Assurance SUDI CA, O=Cisco 0=Cisco, CN=Cisco Root CA 2099 08/11/2016 20:28:08 08/09/2099 20:58:27 Export
ertificates L J
oty Manufacturing root CA 0=Cisco, CN=Cisco Root CA 2099 0=Cisco, CN=Cisco Root CA 2099 08/09/2016 20:58:28 08/09/2099 20:58:28 [Export
Network statistics
Ethernet information User installed <Not installed> <Not installed> [Install |
Access Authentication server CA DC=yan, DC=com, CN=yan-YANY2-CRDC-COM-CA DC=yan, DC=com, CN=yan-YANY2-CRDC-COM-CA  01/27/2021 09:00:25 01/27/2026 09:10:25 L Delete |

LSC certificate could be removed on CUCM phone page, then Save and Apply.
r Certification Authority Proxy Function (CAPF) Information

Certificate Operation* Delete v
Authentication Mode* By Null String v
Authentication String

Generate String

Key Order* RSA Only v
RSA Key Size (Bits)* 2048 v
EC Key Size (Bits) v
Operation Completes By 2024 (|07 [/03 |[|12 |(YYYY:MM:DD:HH)

Certificate Operation Status: None
Note: Security Profile Contains Addition CAPF Settings.

Simple Certificate Enrollment Protocol (SCEP)

SCEP is the standard for automatically provisioning and renewing certificates avoiding manual installation and re-installation
of certificates on clients.

A Cisco IOS Registration Agent (RA) (e.g. Cisco IOS router) can serve as a proxy (e.g. SCEP RA) to the SCEP enabled CA
that is to issue certificates. Topology is like following picture shows.

RADIUS server
stores list of
Cisco IP phone authorized Gisco IP
RA authenticates Firewall protects phones

and authorizes CA, RADIUS and
SCEP requests other devices in
from Cisco IP the corporate
phones network
Cisco IP phone 0% Registration
titp 0 P Authority (RA)
Q Certificate
8‘%5 Authority(CA)

configured to
grant all requests
from the RA

Ensure that the same CA chain is used for issuing certificates to the phones as well as for the RADIUS servers; otherwise
server validation could fail.

For initial certificate enrollment via SCEP, the Cisco Desk Phone 9800 Series needs to be connected to an Ethernet network
which has connectivity to the Cisco Unified Communications Manager.

The Cisco Desk Phone 9800 Series utilizes the following parameters defined in Cisco Unified Communications Manager for
SCEP requests.

The WLAN SCEP Server must be configured to include either the IP address or hostname of the SCEP RA.

The WLAN Root CA Fingerprint (SHA256 or SHA1) must be configured to include the fingerprint of the CA that issuing
the certificates. If the issuing CA in which the SCEP RA is enrolled to is a subordinate CA, then enter its fingerprint but not
the fingerprint of the root CA. The defined fingerprint is used to validate the received certificate.

Removing these parameters will disable SCEP.
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WLAN SCEP Server 10.195.19.65

WLAN Root CA Fingerprint  g151784316429092925C68917018374EBD254447
(SHAZ56 or SHA1)

The Cisco Desk Phone 9800 Series then sends a SCEP enroll request to the SCEP RA including the phone’s Manufacturing
Installed Certificate (MIC) as the Proof of Identity (POI).

The SCEP RA validates the phone’s MIC using the certificate of the subordinate CA that issued the phone’s MIC, then passes
it to the RADIUS server for further device authentication.

The RADIUS server validates the device and sends a response to the SCEP RA.

The SCEP RA then forwards the enroll request to the CA if RADIUS authentication was successful.

The SCEP RA receives the user certificate from the CA and sends it to the phone after it receives a poll request from the
phone.

The Cisco Desk Phone 9800 Series will periodically check the user and server certificate expiration periods.

Certificate renewal will occur every 24 hours until successful when the expiration date is within 50 days.

If the CA certificate used to define the WLAN Root CA Fingerprint (SHA256 or SHA1) has expired, then the phone will send
a SCEP getca request for a new CA certificate, but the admin would need to update the fingerprint in the phone’s configuration
within Cisco Unified Communication Manager to match the new CA certificate prior so it can be successfully validated. The
old CA certificate will then be removed if the new one is successfully received from the CA.

If the user certificate has expired, the phone will send a new SCEP enroll request to update the user certificate. The old user
certificate will then be removed if a new user certificate is successfully received from the CA.

If the WLAN SCEP Server or WLAN Root CA Fingerprint (SHA256 or SHA1) has been modified, then the Cisco Desk
Phone 9800 Series will attempt to update the CA and user certs immediately.

Certificate Authority (CA) Configuration

It’s recommended to use Microsoft® Certificate Authority (CA) servers.
Use the following guidelines to configure the Microsoft CA.
1. Create Certificate Authority and Active Directory Domain Service on Microsoft Windows server.
2. Enable Network Device Enrollment Service.
3. Make Administrator a member of IIS_IUSERS group by going to MemberOf tab of user property screen.
4. Launch Server Manager, then click Add roles.

E.; Server Manager !E E
File  Action View Help

L Al sl 7|

= EE Rales -

= 'E Active Directory Domain Services ;K
: Active Direchory Users and C & . Wiew the health of the roles installed on your server and add or remove roles and Features,
[ Active Directary Sites and Se

i& Metwork Policy and Access Servic

-
[ W5 web 5 115,
E% Fejatu:es erver (113) +| Roles Summary E Roles Summary Help
3 Diagnostics -
Eﬁ-'!. Corfiguration +~! Roles: 3 of 17 installed Tl Add Raoles
i

[ =5 Storage D= Remove Roles

'\')._@', Windows Server Backup 4. Active Directory Domain Services

=7 Disk Management Metwork. Policy and Access Services

1. Web Server (IIS)

5. On the Select Server Role page, select the Active Directory Certificate Services role, then click Next. The
default service selected is the Certification Authority, clear the check box, and then go to

6. Add the Network Device Enrollment Service role service.

7. Inthe Add Roles Wizard, on the Select Role Services page, select the Network Device Enrollment Service
check box, then click Next.
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Add Role Services

= i _
!'#}' Select Role Services

Select the role services to install for Active Directory Cerkificate Services:

User Account Role services: Descriptian:
RA Infarmation Certification Authority (Installed) Certification Autharity (CAY is used ko
T E——— =— issue and manage certificates,

Cryptography [ certification Authority Web Enralment Multiple CAs can be linked ko Form a
Confirmation [ online Responder public key infrastructure,

[¥] metwork Device Enrollment Service
Frogress [ Certificate Enroliment Web Service
Resulks [[] Certificate Enraliment Policy Web Service

More about role services

< Preyious | Mext = I Install |

Cancel I

8. The wizard will detect whether all the required dependencies are installed. If any dependencies are missing, you

will be prompted with a dialog box explaining what is missing and requesting your permission to install the

dependencies. Click Yes to continue the installation.

9. Click User Account under Role Services and then click Select User....

Add Roles Wizard

&
! ;in Specify User Account

Before You Begin Select the user account Metwork Device Enrollment: Service should use when authorizing certificate requests,

The user must be a member of the Domain and must be added ka the local [IS_IUSRS group.
Server Roles

ADC5 % Specify user account {recommended)

Role Services IYD-MSCA\Admln\stratnr Select User...

" lse the application pool identity instead of a user account

Cé fior NDES

R Infarmation

Cryptography
Confirmation
Progress

ResUlts

< Previous | Next » I Install |

Cancel

10. Type in Administrator as the user name, then enter the password.
Windows Security [ X|

Add Role Services
Specify a name and password,

| Llser narne |
| Password |
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11. Enter the Registration Authority information.

= P . - . .
'#}, Specify Registration Authority Information

Role Services A registration autharity wil be set up to manage Network Device Enraliment Service certificate requests. Enter
ey Actount the requested information to enrol For an RA certificate.
jser Account

Required Information
Cryptagraphy

RA Name: [YD-MSCA-W2KS-MSCEP-RA
«Confirmation
Progress Country/Region: US (United States) -

Results
Optional Information

E-mail |
Company: |
Department:
City

StatefProvince: l—

<provious [[ mext> | el | cone |

12. Select Microsoft Strong Cryptographic Provider for Signature Key CSP and Encryption key CSP.

13. Select 2048 for Key character length.

=
! ﬁ}’ Configure Cryptography for Registration Authority

Role Services To canfigure cryptography, you have to select cryptoaraphic service providers and key lengths for the
signature key and the encryption key used ta sign and encrypt communications between the devics and the
User Accounlt Ch,

RA Information

Signature key ks used to avoid repetition of communication between the CA and the RA.

Confirmation Signature key CSP: Key character length:

Progress Microsoft Strong Cryptographic Frovider =] [oss |
Results

Encryption key is used for secure communication between the RA and the network device.

Encryption key €5P: Key character length:
Microsoft Strong Crypographic Provider = |2_04s =]

More about signature and encryption kevs

<previous [ mets | el | Caniel |

14. Select Install.

= £ ) . .
! I{:z Confirm Installation Selections

Role Services X X
To instal the Follawing rolss, role sarvices, or Features, click Install

User Account -

(i) 1 informational message belon

R Information

Cryptography ) This server might need to be restarted after the installation completes.
~! Active Directory Certificate Services
Progress Metwork Device Enrollment Service
Rl Accaunt ; YO-MSCA\Administrator
Ré Information:
Hame : VD-MSCA-W2KE-MSCEP-RA
Country ; us
Email ; <None>
Company <Mone >
Department : <Mone
City : <Mone
State: <Mone
Signature Key C3P © Microsoft Strong Crypkagraphic Provider
Signature Key Length : 2045
Exchange Key C5P Microsoft Strong Crypkagraphic Provider
Exchange Key Length : 2045
Challenge Phrase URL : htkp: /YD-MSCA-Wi2K 8/ certsry mscep_adming

Print, e-mal, or save this information

<provious | e |[Cmetal | caneal |

A confirmation page will be displayed if the installation was successful.
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Add Role Services [x]
= 2§
!! %@ Installation Results

Role Services
The Following roles, role services, or features were installed successFully:
User Account

RA& Information ~) Active Directory Certificate Services a Installation succeeded
Cryptography The following role services were installed:
) Network Device Enrollment Service
Canfirmation
Progress

Print, e-mail, or save the installation report

< Previous | [iext = | Close: I Cancel |

15. Disable SCEP enrollment challenge password requirement via regedit by setting EnforcePassword to 0.
(HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > Cryptography > MSCEP > EnforcePassword)

5:* Registry Editor

File Edit View Favaorites Help

B Cryptography ;I Mame | Tvpe ‘ Data
[#- | AutoEnrallment ab|(Default) REG_S7 (walue nok set)
G- | Calais fie|EnforcePassword  REG_DWORD 0x00000000 (0}
~ | CatalogDB

- || CatDBTempFiles
[ . CertificateTemplateCache
- | Defauls
MSCEP
. CATvpe
. CertsIntYStare

. PasswordyDir
. UseSinglePassword

16. Specify certificate templates for SCEP
SCEP uses the certificate template that is set in the registry for issuing certificates.
(HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > Cryptography > MSCEP)

File Edit ‘“iew Favorites Help
o Defaults ;I Mame ‘ Type | Data
- MSCEP ab|(Default) REG_SZ (value not sat)

= L CAType ab|EncryptionTemplate  REG_SZ IPSECIntermediateCFfline
CertsInMYStore ab|GeneralPurposeT... REG_SZ IPSECIntermediateOffing
EnforcePassword atureTemplate JIelrd IPSECInkermediateCffline

PasswordvDir
UsesinglePassword

Typically the RA will have a longer period (same as that of the CA certificate). The default template used for RA

to be enrolled to the SCP server is IPSECIntermediateOffline as highlighted above. So make sure a correct
template is set to the above registries before enrolling Cisco RA to the SCEP server.

After the Cisco RA is enrolled to the SCEP server, admin needs to change the template in the registry (if the user

certificate period needs to be shorter than that of the root CA).

17. Right click Certificate Templates then select Manage.
File Action View Help
o 3l el NENE 7 s

= T ctive Directory Certificate Servi

5 gy Enterprise PX1 I P-User Encryping File System, Secure Emai,
T yichun-CA (¥0.0) 5 CEP Encryption Certificake Request Agent
il =1
7 Certificate Templates (YD-ME | ) Exchange Enrolment fgent (Offine req... Certificate Request Agent
E g vichun-Ca Sec (Offine request) 1P securky IKE inbermediate

Server Authentication
Server Authentication

Revoked Certificates
Issued Certificates

Pending Requests i Server Certficate template Server Authentication
Failed Requests 3 Directory Email Replcation Directory Service Emai Replication
T i h Controler Authentication Clent Authentication, Server Authenticatio. .
= T active Directory D e
s Actrve Directory Doma Covery Agent Flle Recovery
5 Active Directory Us ey v es Encrypting File System
= B3 yd-msca.ydnet Controler Chient Authentication, Ssrver Authentication
[ fultn o) '
oy roer Server Authenticabion
& »
: OTOUES  gefrech er Clent Authentication, Server Authentication
1 (2] Domain Cor N p;
Foroigigae  EXpOrt L. Encrypting Fie System, Secure Email, Cien.
Managed 5| Help nate Certification Authority <Al>
It trator Microsoft Trust List Sigring, Encrypking Fi. ..
isers
=) fi Active Directory Sites and Se.
S [ Sites
® Suibnets
] Inber-Ske Transports
[ Ry
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18. Right click User template then select Duplicate Template.

19. Select Windows Server 2003 2008 Template.

20. Under the General tab, change template name and validity period.

21. Under the Extensions tab, ensure the following:

Client Authentication is set as one of the application policies

Key Usage has Digital Signature attribute

File  Action  ‘Wiew Help

B Certificate Templates Console

N EIEEN1E

| Minimurn Supported CAs

| ‘v'ers_ic;l

Certificate Templates (YD-MSCA-W2KE | Template Display Mame =
H Cross Certification Authority

E Direckary Email Replication

] Domain Cantroller

E Domain Controller Authentication
E EF5 Recovery Agent

H Enrolment Agent

E Enraliment Agent {Computer)

E Exchange Signakure Only
E Exchange User

& tPsec

5l 1Psec (Offline request)
# Kerberas Authentication
E Key Recovery Agent

E OCSP Response Signing
E OneHourSCEPUser

H ras and 165 Server

] Raat Certification Autharity
E Router (Offline requast)
E SCEP User

] SCeP-User

E server Template

5 smartcard Logan

] Smarteard User

E Trust Lisk Signing

,

E Lser | Duplicate Template
Fweb: Al Tasks >
H web ! -
E weh Properties

FWiFF  Help

]| Exchange Enrollment Agent (OFfline request)

H suberdinate Certification Autharity

E \WiFi Server Cerbificate Eemplate
] workstation Authentication

K — | K1 |

Wwindows Server 2003 Ent..
Windows Server 2003 Ent..

Windows 2000

Wwindows Server 2003 Ent..

Windows 2000
Windows 2000
Windows 2000
Windows 2000
Windows 2000
Windows 2000
Windows 2000
Windows 2000

Windows Server 2003 Ent...
Windows Server 2003 Ent...
Wwindows Server 2008 Ent...
Windows Server 2008 Ent...
windows Server 2003 Ent...

Windows 2000
Windows 2000

Wwindows Server 2008 Ent...
Windows Server 2008 Ent...
Windows Server 2003 Ent...

Windows 2000
Windows 2000
Windows 2000
Windows 2000

Windows 2000
Windows 2000

Windows Server 2003 Ent...
Wwindows Server 2008 Ent...
Windows Server 2008 Ent...
Windows Server 2008 Ent...
Windows Server 2003 Ent...

105.C
1150
4.1
110.C
6.1
4.1
Sl
4.1
6.1
71
g1
71
11n.c
105.C
101.c
100.2
101.c
Sl
4.1
100,z
100,z
100,z
6.1
111

100.2
100.E
100.4
100.€
101.0_|

22. Configure the Validity Period on the General tab as necessary.

SCEP-User Properties E |

Superseded Templates | Estensions I Security I Server
Cryptography | Subject Mame I |zzuance Requirements
General Request Handing

Template dizplay narme:
SCEP-User

Minimum Supported CAs: Windows Server 2008 Enterprise

Template name:
SCEP-User

Walidity period: Renewal period:

I 2 Iyears 'l I 4 Iweeks 'l

¥ Publizh certificate in Active Directany
[~ Do not automatically reenrall if a duplicate certificate sxists in Active
Directony

r Far automatic renewal of smart card certificates, use the existing key
if & new key cannot be created
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23. Configure Subject Name tab as shown below.

Superseded Templates I Extenzions I Security I Server
General | Fequest Handling
Cryptography Subject Mame | |zzuance Requirements

& Supply in the request

ze subject information fram existing certificates for autoenrallment
renewal requests.

" Build from this &ctive Directary information

Select this option to enforce consigtency among subject names and to
zimplify certificate administration.

Subject name format;
I Mone j

I Include e-mail name i subiect name

Include this information in alternate subject name:
™| Exrniail rianme:

| NS rame

I User priricipal name (LEK]

I~ | Semvice principal name (SEN]

24. Configure Extensions tab as shown below.

General I Fiequest Handling I Subject Mame | Server |
lzzuance Requirements I Superseded Templates  Extensions | Security

To modify an extenzion, select it, and then click Edit.

Extensions included in this template:
|_|Applic:ation Folicies
|:| Basic Constraints
|:| Certificate Template Information
lssuance Policies
Key Uzage

Description of Key Uzage:

Signature requirements: ;I
Digital signature

Allovs key exchange only with key encryption
Critical extension.

-]

25. Configure Algorithm Name, Minimum Key Size, and Request Hash as necessary on the Cryptography tab.

SCEP-User Properties il S
Superseded Templates I Extensions I Security I Server
General I Fiequest Handling
Cryptography | Subject Mame I |zzuance Requirements
Algorithm name: RSA j

Minirum key size: 2048

Chooze which cryptographic providers can be used for requests
' Requests can use any provider available on the subject's computer
" Rlequests must uze one of the following providers:

Froviders:

[CMicrozoft Software Key Storage Provider

Request hash: SHAT j

™ Use altemate signature format,
For more information about restrictions and compatibility click here.
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26. Enable the newly created template by right clicking Certificate Templates then selecting New > Certificate

Template to Issue.
Ty Server Manager (YD-MSCA-W2KS)

Certificate Templates

= 5 Roles —,ﬁ_
= “Eﬁ‘ Ackive Directory Certificate Servi I\Lame Intende.d PL"_'DDSE —
B By Enterprise PKI | SCEP-User Encrypting File System, Secure Email, Clien, ..

E CEP Encryption
E Exchange Enrollment Agent (OFfline req...
.-i-| IPSec (Offling request)

L) vichun-Ca (v0.0)
E Certificate Templates (YD-M:
B g vichun-Ca

| Revoked Certificates ] web Serverya
| Issued Certificates E Web Serveryz
| Pending Requests .-i-| "WiFi Server Certificate ternplate

E Directary Email Replication
=
Domain Controller Authentication

| Failed Requests

g "E: Active Directory 7Manage EFS Recovery Agent
= [ Active virec! [ certficate Template ko Issue
= & VC_"'“SCC" - y |Domain Contraller
.T Bule VW Web Server
= om Refresh Computer
— por Expork List. .. User
: I'\:ﬂ?ar: T Subo.n.:linate Certification Autharity
= Users Administrakor
[ @i Active Directory Sites and Se
B[] sites
| Subnets

27. Select SCEP User template.

[l Enable Certificate Templates

Select one Certificate Template to enable on this Certification Sutharity.

Mote; IF a certificate template that was recently created does not appear on this list, pou may need to wait until

information about this template has been replicated to all domain controllers.
All of the certificate templates in the organization may not be available to your Ca.
For more information, see Cedificate Template Concepts.

Certificate Request Agent

Certificate Request Agent

IP security IKE intermediate

Server Authentication

Server Authentication

Server Authentication

Directory Service Email Replication

Client Authentication, Server Authenticatio. ..
File Recovery

Encryvpting File System

Client Authentication, Server Authentication
Server Authentication

Client Authentication, Server Authentication
Encrvpting File System, Secure Email, Clien. ..
<All=

Microsoft Trust List Signing, Encrypting File. ..

Server Authentic ation
Client Authentication, Smart Card Logon

Secure Email, Client Authentication, Smart Card Lagon
Microzoft Trust List Signing

Secure Email, Client Authentication

Server Authentication

Client Authentication

E server Template

E Smartcard Logon
E Srnartcard U ser

E Trust List Signing
E User Signature Only
E “wiFi Phone Certificate template
T warkstation Authentication

1

MName | Intended Purpoze :I
E Fouter (Offline request] Client Authentication
E SCEF Client Authy or = Email, Encrypting F

| »

[ o |

Cancel

28. Associate the newly created template to SCEP via regedit.

Registry Editor

File Edit Yiew Favorites Help
| COM3 =] | Mame | Type | Data
. Command Processor ab|{Defaul) REG_SZ {value nat set)
. Cryptography ab|EncryptionTemplate REG_SZ IPSECInkermediateOffline
. AutoEnrolment ab|GereralPurposeT... REG_SZ IPSECInkermediateOffline
. Calais ab|signatureTemplate  REG_SZ IPSECIntermediateCffline
| CatalogDB
. CatDBTempFiles
| Defaults
| Mscep Walue name:
- L CAType IEncryptionTempIate
. CertsInMYStare
| EnforcePassword elipasE
. Password\Dir [SCEF-USER]

- |, UseSinglePassword
. OID
. Protect

o]

Cancel |

P

29. Go to IIS > Application Pools to restart the SCEP service for the new template to take effect.

RADIUS Configuration

Use the following guidelines to configure the RADIUS server. ISE server plays a role of SCEP device authentication for
enrollment, and it can be used for the PKI integration with Cisco IOS RA for SCEP solution.
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1. Navigate to Administration > Network Device Profiles, add a new profile or levering existing profile Cisco. If
create a new profile, remember to configure Supported Protocols, Authentication/Authorization and
Permission properly.

e |dentity Services Engine Administration / Network Resources

cisco

) Bookmarks Network Devices Network Device Groups Network Device Profiles External RADIUS Servers RADIUS Server Sequences More

8% Dashboard

Network Device Profiles

Context Visibility

Selected 0 Total 9 [

% Operations

+ Add Wy Import ; Gisco Communities Import PRV 4
U Policy
O Neme A Description Vendor Source
& Administration
() AlcatelWired Profile for Alcatel switches Alcatel Cisco Provided
1. Work Centers
O ArubaWireless Profile for Aruba wireless network access devi... Aruba Cisco Provided
D BrocadeWired Profile for Brocade switches Brocade Cisco Provided
5 )
SRR IBISECINE IS aHUEe O  #Gisco Generic profile for Cisco network access devi... Cisco Gisco Provided

Identity Services Engine Administration / Network Resources

J'  Bookmarks Network Devices Network Device Groups Network Device Profiles External RADIUS Servers RADIUS Server Sequences
—_—

. Network Device Profile List > Cisco
8% Dashboard

Network Device Profiles
:! Context Visibility

A Operations
* Name Cisco
U Policy
) Generic profile for Cisco network access devices
Description

& Administration 4

Icon [_]| Change icon... @
mll  Work Centers

Vendor Cisco
Supported Protocols
?) Interactive Features RADIUS
TACACS+

TrustSec

RADIUS Dictionaries ~ Cisee X

2. Navigate to Administration > Network Resources > Network Devices and add a device for Cisco IOS RA like
yan_RA sudi as shown bellow

es Engine Home » Context Visibility » Operations Policy i » Work Centers.

» System » Identity ¥ Network » Device Portal Management  pxGrid Services » Feed Service  » Threat Centric NAC

~ Network Devices ~ Network Device Groups ~ Network Device Profiles ~ External RADIUS Servers  RADIUS Server Sequences ~ NAC Managers ~ External MDM  » Location Services
——

[ [J ping_switch 10.74.133.13... i Cisco 7 All Locations All Device Types
Network Devices [ rimo_switch 10.74.23.50/32 Cisco & All Locations All Device Types 10.74.23.50
[0 shihan-test 10.74.10.220/32 Cisco & All Locations All Device Types
pefult Device [] shugwang-rou... 10.74.133.15... i Cisco & Al Locations Al Device Types
Device Security Settings [ ting_cube_sw2  10.74.53.202/32 Cisco & All Locations All Device Types ting_cube_sw2
[ ting_wic9800 10.74.151.66/26 Cisco & All Locations All Device Types
O tiren_shield_wic  100.100.101.... % Cisco All Locations All Device Types
[0 tru-test-au 10.74.10.219/24 i1 Cisco & All Locations All Device Types
[0 wangh_switch 100.100.30.7... 4 Cisco &/ All Locations All Device Types wangh_switch
[ wenjuaga_swi... 10.74.10.72/32 % Cisco & All Locations All Device Types
[J weny_switch 10.74.19.19/26 i Cisco & All Locations All Device Types
[ wexiao2_switch  10.79.57.18/24 s Cisco All Locations All Device Types wexiao2_switch
[J whale_wWLC 10.74.18.31/32 Cisco All Locations All Device Types
[0 wic-public 100.100.66.1... Cisco All Locations All Device Types
O yan-auto 100.100.116.2... Cisco All Locations All Device Types
[ yan-auto-3502 100.100.116.1... Cisco All Locations All Device Types
[ yan_RA ca2 10.79.57.89/32 Cisco All Locations All Device Types
[0 yan_RA ca3 10.75.185.48/32 Cisco & All Locations All Device Types
[J yan_RA_sudi 10.79.57.93/32 Cisco & All Locations All Device Types scep-for-sudi

3. Navigate to Policy > Authentication, set a Default rule to use Default Network Access and use
All_Uesr_ID_Stores.
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e Identity Services Engine Policy / Policy Sets

Poli Reset Reset Policyset Hitcounts |
P! Bookmarks olicy Sets— Default ese | Reset Policyse itcounts | m

8% Dashboard
Status  Policy Set Name Description Conditions Allowed Protocols / Server Sequence  Hits

! Context Visibility
Q

A operations

] Default Default policy set Default Network Access 2
{ Policy

&, Administration

“vAuthentication Policy(3)

Al Work Centers
(@ status Rule Name Conditions Use Hits  Actions

2 Interactive Features

©  Defaurt ° &

> Options

The authentication options can be set to continue for “If authentication failed” or “If user not found” since
certificate based authentication has already been done in Cisco IOS RA.

If Auth fail
Al REJECT
DROP

CONTINUE

REJECT & A
(] Default 0

4. Navigate to Administration > Identity Management > Identity Source Sequence.

)" Bookmarks Identities Groups External Identity Sources Identity Source Sequences Settings

a Dashboard Identity Source Sequences List > All_User_ID_Stores

| Context Visibility Identity Source Sequence

o] ti i
X Operations v Identity Source Sequence

: * Name
' Policy All_User_ID_Stores

2 Administration Description A built-in Identity Sequence to include all User Identity Stores
mll  Work Centers

i Vv Certificate Based Authentication
?) Interactive Features

Select Certificate Authentication Profile Preloaded_Certificv

Vv Authentication Search List

A set of identity sources that will be accessed in sequence until first authentication succeeds
Available Selected

Internal Endpoints Internal Users

5. Under Policy > Policy Elements > Results > Authentication > Allowed Protocols, edit Default Network
Access as shown below
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Policy Sets  Profiling  Posture  Client Provisioning =~ Policy Elements

Dictionaries  » Conditions ¥ Results

Allowed Protocols Services List > Default Network Access
v Authentication
Allowed Protocols

Allowed Protocols Name | pefault Network Access
» Authorization Description | pefault Allowed Protocol Service
» Profiling Y
A

» Posture v Allowed Protocols

» Client Provisioning Authentication Bypass
Process Host Lookup i

Authentication Protocols

Allow PAP/ASCII
0 Allow cHAP
O Allow Ms-CHAPV1
O Allow Ms-CHAPv2
Allow EAP-MD5

- Allow EAP-TLS

a Allow Authentication of expired certificates to allow certificate renewal in Authorization Policy i
[0 Enable Stateless Session Resume

Session ticket time to live 2 Hours

6. Under Policy > Policy Elements > Results > Authorization > Authorization Profiles, add a profile for SCEP
(e.g. Phone SCEP profile)

Policy Sets ~ Profiling ~ Posture ~ Client Provisioning |~ Policy Elements

Dictionaries  » Conditions ¥ Results

ieethentioation Standard Authorization Profiles
For Policy Export go to Administration > System > Backup & Restore > Policy Export Page

v Authorization

JEdit <pAdd [#yDuplicate = )€ Delete
Authorization Profiles hEd ol

[] Name Profile +  Description
Downloadable ACLs , o .
[J Blackhole_Wireless_Access % Cisco & Default profile used to blacklist wireless devices.
ghrching [ ClI_bbb_voice_vian 4 Cisco & CI_bbb_voice_vian
[ Cisco_IP_Phones Cisco & Default profile used for Cisco Phones.
» Posture
[J Cisco_Temporal_Onboard Cisco & Onboard the device with Cisco temporal agent
» Client Provisioning [ Gisco_WebAuth s Cisco &3 Default Profile used to redirect users to the CW#
[J Eagle PC VLAN 4 Cisco & Access PC VLAN 165 of Eagle Team
[ Eagle Wired Phone VVLAN 4 Cisco & Access VVLAN 604 of Eagle Team
[0 FTpcvian 96 ils Cisco & access vlan 96 for phonenix register
[J NSP_Onboard 4 Cisco & Onboard the device with Native Supplicant Prov
[J Non_Cisco_IP_Phones Cisco Default Profile used for Non Cisco Phones.
Phone_SCEP_profile for scep
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Identity Services Engine

Policy Sets  Profiling

Dictionaries

» Authentication

~ Authorization

Authorization Profiles

Downloadable ACLs

» Profiling

» Posture

» Client Provisioning

» Conditions

Posture

Home » Context Visibility » Operations » Administration

Client Provisioning | ~ Policy Elements

~ Results

o
Authorization Profiles > Phone_SCEP_profile

Authorization Profile

* Name | Phone_SCEP_profile |

Description | for scep

* Access Type [ACCESS_ACCEPT |

Network Device Profile sl Cisco | w | 5

Service Template O
Track Movement Oa

Passive Identity Tracking Od

» Common Tasks

v Advanced Attributes Settings

|Cisco:cisco—av-pair | :|pk‘|:cert-application=all

7. Navigate to Administration > Identity Management > Groups > User Identity Groups and add a user group
for SCEP, like scep-group displayed in below picture.

sthills Identity Services Engine

Home

» Network Resources

» System = v Identity Management
» Identities ~ Groups  External Identity Sources
——
Identity Groups
¢ )
v|E ©.

> B Endpoint Identity Groups
¥ [ User Identity Groups
5% ALL_ACCOUNTS (default)

% Eagle_PCs

Ay
2% I

!

L
%0

% Employee

£ GROUP_ACCOUNTS (default)
“L GuestType_Contractor (default)
% GuestType_Daily (default)

]
2 I

<

]

53 152 )

]

v

% GuestType_SocialLogin (default)

5 152 |

v

% GuestType_Weekly (default)

)

v

L kaipen_wired_pc_group
keshu_wired_pc_group
OWN_ACCOUNTS (default)

59 a9 089 a5
53 053 033 033 )

scep-group

¥

8. Navigate to Policy > Authorization Policy and add a SCEP authorization policy by clicking the down arrow

» Context Visibility » Operations » Policy ¥ Administration » Work Centers

» Device Portal Management  pxGrid Services  » Feed Service  » Threat Centric NAC

Identity Source Sequences  » Settings

User Identity Groups > scep-group

Identity Group

*Name | scep-group|

Description | for SCEP

Save | Reset |

Member Users

Users
SfAdd v 3¢ Delete ~
Status Email Username a First Name
O Enabled © PID:CP-8832 SN:FC...
O Enabled © PID:CP-8821 SN:FC...
O Enabled ¢ PID:CP-8832 SN:FC...
O Enabled © PID:CP-8875 SN:FC...
O Enabled © PID:CP-8875 SN:FC...
O Enabled ¢ PID:DP-9861 SN:FV...

beside Edit of an existing policy and selecting Insert new rule above.
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Identity Services Engine Home » Context Visibility » Operations ~ Policy ¥ Administration » Work Centers

Policy Sets | Profiing ~ Posture  Client Provisioning  » Policy Elements

> Authentication Policy (4)
> Authorization Policy - Local Exceptions
 Authorization Policy - Global Exceptions
¥ Authorization Policy (13)
Results

Status Rule Name Conditions Profiles Security Groups Hits Actions

Search

@ SCEP_Access B  yan_scep +Phone_SCEP_profile. +| | select from list v+ 39 -2

Conditions Studio

Library Editor

S h by N
earch by Name IdentityGroup-Name

OF 0wl

ECLOL = &

Equals v * User Identity Groups:scep-group \

@ AutonomousAP_7_103 @ Set to 'Is not' Duplicate @

9. Navigate to Administration > Identities > Users and create user accounts for Cisco Desk Phone 9800 Series.
The user name has the format of serialNumber (e.g. PID:DP-9861 SN:FCH27472020).

Identity Services Engine Home » Context Visibility v Administration » Work Centers

» System v Identity » Network » Device Portal Management  pxGrid Services  » Feed Service  » Threat Centric NAC

~Identities  Groups  External Identity Sources Identity Source Sequences  » Settings
——

U Network Access Users
Isers

Latest Manual Network Scan Results o
J Edit =Add | [ change Status + @aImport b Export v 3¢ Delete v Li3Duplicate

Status Name a Description First Name Last Name Email Address User Identity Group

L0 EALGUISU L FILLUE SO0 U DI Ul IEUUZH O

O Enabled  © PID:CP-8875 SN:FCH26173BXL

O Enabled © PID:CP-8875 SN:FCH262831MF scep-group
O Enabled © PID:CP-8875 SN:FCH263038NM

O Enabled © PID:CP-8875 SN:FCH263038UY scep-group
O Enabled © PID:CP-8875 SN:FCH263332VH cisco scep-group
O Enabled 0 PID:CP-8875 SN:FCH26452024 scep-group
O Enabled  © PID:CP-8875 SN:FCH264520NS

O Enabled © PID:CP-8875 SN:FCH264520NT cisco scep-group
[J BEnabled ¢ PID:DP-9861 SN:FCH27472020 cisco scep-group
O Enabled © PID:DP-9861 SN:FVH280322J6 cisco scep-group
O Enabled 9 PID:DP-9861 SN:FVH281623FQ cisco scep-group
[ @Enabled o PID:DP-9861 SN:FVH281623FV cisco scep-group
O Enabled @ PID:DP-9861 SN:FVH281623U3 cisco scep-group
O Enabled © PID:DP-9861 SN:FVH281623YE cisco scep-group
[J BEnabled ¢ PID:DP-9871 SN:FCH2738200Y cisco scep-group
O Enabled © PID:DP-9871 SN:FCH2746202B cisco scep-group
O Enabled © PID:DP-9871 SN:FCH27462048 cisco scep-group
O Enabled 9 PID:DP-9871 SN:FVH28080FNY cisco scep-group
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cisco ldentity Services Engine Home » Context Visibility » Operations » Policy ~ Administration » Work Centers

» System v lIdentity Management | » Network Resources  » Device Portal Management ~ pxGrid Services  » Feed Service  » Threat Centric NAC

~ldentites  Groups  External Identity Sources  Identity Source Sequences  » Settings
—

U Network Access Users List > PID:DP-9871 SN:FCH2738200Y
sers

¥ Network Access User
Latest Manual Network Scan Results

* Name | PID:DP-9871 SN:FCH2738200Y

Status |1 Enabled «

Email |

v Passwords

Password Type: Internal Users v

Password Re-Enter Password

* Login Password ‘ -------- | -------- | | Generate Password

|
Enable Password [ | | | | Generate Password

v User Information

First Name | ‘

Last Name | ‘

v Account Options

Description | cisco

Change password on next login O

SCEP RA Configuration

Currently only a Cisco 10OS router running 10S version 15.1(4)M10 or later is supported as the SCEP RA.
Use the following guidelines to configure a Cisco 10S router as a SCEP RA.
* Enable HTTP server on the Cisco 10S router.
ISR_RA¥# configure terminal
ISR_RA(config)# ip http server
ISR_RA(config)# exit
* Configure a RADIUS server for device authentication.
ISR_RA# configure terminal
ISR_RA(config)# radius server MyRadius
ISR_RA(config-radius-server)# address ipv4 10.195.19.63 auth-port 1812 acct-port 1813
ISR_RA(config-radius-server)# key <REMOVED>
ISR_RA(config-radius-server)# exit
ISR _RA(config)# aaa authorization network PhoneList group radius
ISR_RA(config)# exit
* Configure a PKI trustpoint for the MIC’s CA chain to validate the phone’s MIC.
ISR_RA# configure terminal
ISR _RA(config)# crypto pki trustpoint MIC _trustpoint
ISR _RA(ca-trustpoint)# authorization list PhoneList
ISR _RA(ca-trustpoint)# authorization username subjectname commonname
ISR _RA(ca-trustpoint)# exit
ISR _RA(config)# crypto pki trustpoint MIC _trustpoint
ISR _RA(ca-trustpoint)# enrollment terminal
ISR_RA(ca-trustpoint)# revocation-check none
ISR_RA(ca-trustpoint)# exit
ISR_RA(config)# crypto pki authenticate MIC _trustpoint

Enter the base 64 encoded Manufacturing CA certificate. End with a blank line or the word quit on a line by itself.

MIIEZTCCA02gAwIBAgIBAJANBgkqhkiGIWOBAQsFADArMQ4wDAYDVQQOKEwWVDaXNj
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bzEZMBcGAIUEAxMQQ2IzY28gUm9vdCBDQSBNMjAeFwOxMjExMTIxMzUwNThaFw0z
NzExMTIXMzAwMTdaMDYxDjAMBgNVBAoTBUNpc2NvMSQOwIgYDVQQDExtDaXNjbyBN
YWS51ZmFjdHVyaW 5nlENBIFNIQTIwggEiMAOGCSqGSIb3DQEBAQUAA4IBDwWAwggEK
AolBAQDONktCAjIn3kk98hU7wUVp6QIOFriitEce6CpbfYpelLdUeZduAo+SOotzT
LIwWS2BIMhZtacu9vUpfmW9w7nQo9zVT3eyPuhF/6/9TEAVBn75zb5CfV+E6ld+fH
nuPiFyBu+HDDJRA3730p+957IdoWyPvDShHR1HJGFJ3JJKBg0UScL4JCwleu98Xq
/yPlAqBhExa7a2/fgSmZAOZIGIbBfWZY8ZtSeTxKg3eWynV+xElabHqTDMYWf+2
0obs4YBSIINTbYgHyRETP6T8Xr6TtDOh36540OUHcW+ ImeBu/jctiuMKppeSjVirof
Svt+pbkCg0iQAAjsLOqczT3yaNXvAgMBAAGjggGHMIIBgzAOBgNVHQSBAfSEBAMC
AQYwEgYDVROTAQH/BAgwBgEB/WIBADBcBgNVHSAEVTBTMFEGCisGAQQBCRUBEgAw
QzBBBggrBgEFBQOcCARY1aHROcDovL3d3dy5jaXNjby5jb20vc2VidXIpdHkvcGtp
L3BvbGljaWVzL2luZGV4LmhObWwwHQYDVROOBBYEFHrXeZXKuOgruFFUU/aPAD7yn
D5YZMEEGAIUdHwQ6MDgwNgAOoDKGMGhOdHAGLY93d3cuY2lzY28uY29tL3NIY3Vy
aXR5L3BraS9%iemwvY3JjYW0yLmNybDB8BggrBgEFBQOcBAQRwWMG4wPgYIKwYBBQUH
MAKGMmhOdHAG6LY93d3cuY2lzY28uY29tL3NIY3VyaXR5L3BraS9jZXJ0cy9jcmNh
bTIuY2VyMCwGCCsGAQUFBzABhiBodHRwczovL3Rvb2xzLmNpc2 NvLmNvbS9waZkv
b2NzcDAfBgNVHSMEGDAWgBTJAPkfih/CZr210m1IDiluNMMFoDANBgkqhkiG9w0B
AQsFAAOCAQEAc1k2rH6YT4juFxs9q7 ObzfcKbNvOyDsaU7av4IHF Xmn/JxfnBmUy
YxAI2Hx3xRbOKtG 1JGkffQjVAtBboTXynLaQso/jj46 ZOublF8y6Ho3nTAv7Q6VH
kqSCdZClVu91zbHVIFFYQzJxjw1QgB0a41tS4yhdmgi30DNEcb3trQezr(Q3/857/
1SqBGVLEbKHOu8H6z0LhxAgZ08ae10QQQJowkiOlbd+LRLGovtEWLg8yyqiTIGve
7VFL2sRa8Z3rK9tlwKVH2kpFKNAeN3rfKFqrO/weR0cyKpmLMrSBTBZcxQcJCYF4
X6FO0/32KO0qcxJFIOKGVIUjvAvioOgoducw==

Trustpoint 'MIC _trustpoint' is a subordinate CA and holds a non self-signed cert.
Certificate has the following attributes:
Fingerprint MD5: AC14F08F C3780F8F DOEEE6C9 39111280
Fingerprint SHA1: 90B2E06B 7AD5SDAFF CFD43187 2909F381 37471BF8
Trustpoint CA certificate accepted.
ISR_RA(config)# exit
* Configure a PKI trustpoint and PKI server to enroll to the CA server.
ISR_RA# configure terminal
ISR_RA(config)# crypto pki trustpoint MSCA
ISR_RA(ca-trustpoint)# enrollment mode ra
ISR_RA(ca-trustpoint)# enrollment url http://10.81.116.249/certsrv/mscep/mscep.dll
ISR_RA(ca-trustpoint)# serial-number
ISR_RA(ca-trustpoint)# fingerprint 81512B4316429092925C6891701B374EBD254447
ISR_RA(ca-trustpoint)# revocation-check none
ISR_RA(ca-trustpoint)# rsakeypair MSCA Key 2048
ISR_RA(ca-trustpoint)# exit
ISR_RA(config)# crypto pki server MSCA
ISR_RA(cs-server)# grant auto trustpointMIC _trustpoint
ISR_RA(cs-server)# hash shal
ISR_RA(cs-server)# mode ra transparent
ISR_RA(cs-server)# no shutdown
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Troubleshooting

Problem Report Tool

A problem report can be created via the Problem Report Tool in the phone Settings menu. Navigate to Settings > Issues and
diagnostics > Report problem, enter the information, and press Submit to generate an issue report.

Report
Date of problem (mm/dd)

Time of problem
(hh:mm + AM/PM)

Problem description
Last PRT file name

Last uploaded time

Submit

Problem submitted

problem

Failed to place a call  »

Select

The PRT file is available at http://10.79.63.52/FS/

prt-20240621-192126-845A3EC22785.tar.gz

The date and time and problem description can be defined.

The Customer support upload URL option in either Cisco Unified Communications Manager or Broadwork can be configured

per phone to obtain the logs automatically or manually download the logs from the phone’s webpage.

si]ver]n, CscorPP

Cisco

Info Call History | Personal Directory

Status Debug Info  Download Status = Network Statistics

Console Logs
Debug Message 1:
Debug Message 3:
Debug Message 5:

Debug Message 7:

ThousandEyes Logs
Agent Message 1:

Problem Reports
Report Problem:

Mini Prt File:

messages

|Generate PRT]
miniprt-20240621-042152-

028 tar.g;
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Debug Message 2:
Debug Message 4:
Debug Message 6:
Debug Message 8:

Agent Message 2:

Prt File:

rt-20240621-042152-845A3EC23028 ar.gz
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Device information
Network setup
Network statistics
Ethernet information
Access
Network
Device logs
Console logs
Core dumps

Status messages

Streaming statistics

Stream 1

Wi-Fi statistics

Navigate to Settings > Issues and diagnostics > Diagnostics > Device status > Wireless statistics.

Console logs

Cisco IP Phone DP-9861 ( SEP845A3EC22785 )

Report problem

Current logs in /var/log:
messages

Archived logs in /cisco/logsave/lastimage:
lastimage_20240620_102309.tar.gz

Archived logs in /cisco/logsave/main:

in_20240621_183453.tar.gz
20240621_180000.tar.gz
20240621_173522.tar.gz

Problem Report Tool Logs:

Pprt-20240621-192126-845A3EC22785 tar.gz

Wireless statistics

tx bytes

rx bytes

tx packets

rx packets

tx packets dropped

rx packets dropped

View Streaming Statistics

18259897

22422877

00060529

00068946

00000000

00000000
Back

The Cisco Desk Phone 9800 Series provides call statistic information, where codec type, jitter and packet count info, etc. is

displayed.

Visit your phone’s IP address in a web browser and view the streaming statistics.

« c O & 100.100.122.153

lllllllll ClscoIPho C

cisco

—

Info Call History | Personal Directory

Status Debug Info | Download Status | Network Statistics

Hoteling State:

Line 1 Call 1 Status

Call State:

Tone:

Decoder:

Remote Hold:
Mapped RTP Port:
Peer Phone:
Packets Sent:
Bytes Sent:
Decode Latency:
Round Trip Delay:
Loss Rate:
Discard Rate:
Gap Duration:

MOS-LQ:

Disabled

Called Party Ringing

None Encoder:
PCMU Type:
No Callback:
19626 >> 0 Peer Name:
+17139326004 Duration:
335 Packets Received:
53600 Bytes Received:
20 ms Jitter:
0oms Packets Lost:
0.00 Packet Discarded:
0.32 Burst Duration:
0ms R Factor:
4.26 MOSs-CQ:
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Extended Function Status:

Call Appearance:

None

Line 1 Call 1
PCMU
Outbound

+17139326004
308

52804
44 ms

0oms
87
4.26
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<« © O R 10.79.63.51/CGI/Java/Serviceability?adapter=device statistics streaming.0

Device information
Network setup
Network statistics
Ethernet information
Access
Network
Device logs
Console logs
Core dumps
Status messages

Debug display

Streaming statistics

Stream 1
Stream 2
Stream 3
Stream 4

Stream 5

Wi-Fi Signal Indicator

Remote address
Local address
Start time
Stream status
Host name
Sender packets
Sender octets
Sender codec
Sender reports sent
Sender report time sent
Receiver lost packets
Avg jitter

Receiver codec

Receiver reports sent
Receiver report time sent
Receiver packets

Revr octets

Cumulative conceal ratio
Interval conceal ratio
Max conceal ratio

Conceal seconds

Streaming statistics

Cisco IP Phone DP-9861 ( SEP845A3EC229D4 )

173.36.143.200/51302

10.79.63.51/22570
9:31:25am

Active
SEP845A3EC229D4
237269

12263901

OPUS

835

10:50:31am

583

8

OPUS

0

00:00:00

236709

40713776

0.0013

0.0000

0.0594

473

On the Home screen of your phone, Wi-Fi signal is displayed on top-right corner when connected with AP.

1661

Line

Do not disturb
Off - All lines

Privacy
Off - All shared lines

Redial

Call Calendar

= () 7:32 PM

Hunt group e»
All lines - Out

Meet me ‘+

View the Information About the Connected Access Point

Navigate to Settings > Network connection > Wi-Fi, select the connected AP, and choose Advanced Wi-Fi details.

BTHub5-86GN

® Connected

1 Security mode

2 Advanced Wi-Fi details

AP name
MAC address

Frequency

Current channel

Last RSSI

Beacon interval

Advanced Wi-Fi details

00:20:c7:64:ad:86

2.462Ghz

11

-58

Note: When user encounters Wi-Fi problem, please check the connected AP status, AP parameters, phone side signal strength

and phone Wi-Fi statistics. If the configurations are correct and the desired AP is healthy, toggle Wi-Fi off and on via the
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phone menu could help to recover Wi-Fi connection. If this doesn’t work, plug-in the wired cable and generate PRT in the
phone menu.

Capture a Screenshot of the Phone Display

For phones that are registered to Webex Calling or BroadWorks, get the IP address of your phone and vist
http://<phone IP_address>/admin/screendump.bmp in a web browser. For exmaple,
http://192.168.16.43/admin/screendump.bmp. When prompted, enter the password for the admin.

For phones that are registered to Cisco Unified Communications Manager, get the IP address of your phoen and
http://<phone IP_address>/CGl/Screenshot. For example, http192.168.32.124/CGl/Screenshot .When prompted, enter the
username and password for the account that your phone is associated with in Cisco Unified Communications Manager.

Capture Packets

For phones that are registered to Webex Calling or BroadWorks, you can capture the packets by visiting
http://<phone IP_address>/admin in a web browser.

1. Navigate to Info > Debug Info and clicke Start Packet Capture.

Voice | Call History | Personal Directory
Status | (Debug Info ] Download Status | Network Staistics

Console Logs

Debug Message 1:  messages Debug Message 2:

Debug Message 3: Debug Message 4:

Debug Message 5: Debug Message 6:

Debug Message 7: Debug Message 8:
Problem Reports

Report Problem: Generate PRT PrtFile 1:  prt-20190324-141057-002F5C6121C2 tar.gz
Prt File 2: Packet Capture:
Capture File:

2. Click Submit in the prompt.

Packet Capture X

Filter:

{ Cancel } [ Submit]

3. When the process completes, click Stop Packet Capture to stop capturing.
wto[eico | cat ity | Persoet ovecrs 1

Status | Debug Info | Download Status | Network Statistics

Console Logs

Debug Message 1:  messages Debug Message 2:

Debug Message 3: Debug Message 4:

Debug Message 5: Debug Message 6:

Debug Message 7: Debug Message 8:
Problem Reports

Report Problem:  Generate PRT PrtFile 1:  prt:20180324-141057-002F5C6121C2 ar02
PrtFile 2: Packet Capture:
Capture File:

The captured file is available for downloading.

Info Voice Call History | Personal Directory

Status | Debug Info | Download Status | Network Statistics

Console Logs
Debug Message 1: messages Debug Message 2
Debug Message 3: Debug Message 4:
Debug Message 5: Debug Message 6:
Debug Message 7: Debug Message 8:
Problem Reports
Report Problem:  Generate PRT PrtFile 1: prt-20190324-141057-002F5C6121C2.tar.gz
Prt File 2: Packet Capture: _Start Packet Capture

Capture File{ pkt-20190403-011835-002F5C6121C2.pcap
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http://192.168.16.43/admin/screendump.bmp

Additional Documentation

Cisco Desk Phone 9800 Series Datasheet: https://www.cisco.com/c/en/us/products/collateral/collaboration-endpoints/ip-
phones/desk-phone-9800-series-ds.html

Cisco Desk Phone 9800 Series User and Administrator Documentation: https://cisco.com/go/dp9800help

Other Documentation for Reference

http://www.cisco.com/c/en/us/td/docs/wireless/access point/12-4-25d-JA/Configuration/guide/cg_12 4 25d JA.html

http://www.cisco.com/c/en/us/support/docs/security-vpn/public-key-infrastructure-pki/116167-technote-scep-00.html

http://www.cisco.com/c/en/us/td/docs/routers/connectedgrid/cgr1000/1_0/software/configuration/guide/certificates/CertsGuide
_cgr1000.html#wp1000815

http://www.cisco.com/c/en/us/support/docs/security/identity-services-engine-software/1 16068-configure-product-
00.html#anc14

https://technet.microsoft.com/en-us/library/cc731183.aspx

https://technet.microsoft.com/en-us/library/cc772192.aspx

https://technet.microsoft.com/en-us/library/hh831498.aspx

https://technet.microsoft.com/en-us/library/cc772393%28v=ws.10%29.aspx#BKMK BS2

http://social.technet.microsoft.com/wiki/contents/articles/9063.network-device-enrollment-service-ndes-in-active-directory-
certificate-services-ad-cs.aspx

http://www.cisco.com/c/en/us/td/docs/ios-xml/ios/sec_conn_pki/configuration/xe-3s/sec-pki-xe-3s-book/sec-cfg-auth-rev-
cert. html#GUID-4A2D2A66-F6FB-4FD1-AD40-B7D73531468E

http://www.cisco.com/c/en/us/td/docs/ios/12_2/security/configuration/guide/fsecur_c/scfrad.html#wp1001000
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https://www.cisco.com/c/en/us/products/collateral/collaboration-endpoints/ip-phones/desk-phone-9800-series-ds.html
https://www.cisco.com/c/en/us/products/collateral/collaboration-endpoints/ip-phones/desk-phone-9800-series-ds.html
https://cisco.com/go/dp9800help
http://www.cisco.com/c/en/us/td/docs/wireless/access_point/12-4-25d-JA/Configuration/guide/cg_12_4_25d_JA.html
http://www.cisco.com/c/en/us/td/docs/routers/connectedgrid/cgr1000/1_0/software/configuration/guide/certificates/CertsGuide_cgr1000.html
http://www.cisco.com/c/en/us/td/docs/routers/connectedgrid/cgr1000/1_0/software/configuration/guide/certificates/CertsGuide_cgr1000.html
http://www.cisco.com/c/en/us/td/docs/routers/connectedgrid/cgr1000/1_0/software/configuration/guide/certificates/CertsGuide_cgr1000.html
http://www.cisco.com/c/en/us/td/docs/routers/connectedgrid/cgr1000/1_0/software/configuration/guide/certificates/CertsGuide_cgr1000.html
http://www.cisco.com/c/en/us/td/docs/routers/connectedgrid/cgr1000/1_0/software/configuration/guide/certificates/CertsGuide_cgr1000.html
http://www.cisco.com/c/en/us/support/docs/security/identity-services-engine-software/116068-configure-product-00.html
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